


Dear Reader,  

Technological literacy are the intellectual processes, abilities and
dispositions needed for counselors to understand the link among technology,
themselves, their clients, and a diverse society so that they may extend human
abilities to satisfy human needs and wants for themselves and others (Tyler &
Sabella, 2003). The SchoolCounselor.com Newsletter began in mid-2000 as an
electronic resource designed to advance counselors' level of technological
literacy, application, and integration. Here, you will find practical solutions and
answers to technology related problems, especially as they apply to your job as
counselor. 

This e-book is a compilation of the last 26 issues as they were published
on the SchoolCounselor.com website with only a couple of changes. For one, 48
of the 478 links on the pages were no longer active and either updated or
removed. So, even though some issues of the newsletter are several years old,
this should provide you with websites that have stood the test of time. Second,
I’ve made sure that all links on these pages are active so that you may
conveniently click on any resource (usually blue and underlined) and go right to
that webpage – no need to type website addresses. Otherwise, the integrity of
these issues has been preserved. 

For each newsletter issue, I’ve tried to include only relevant, affordable
(usually free or almost free), and user-friendly resources. Many readers have
provided me with positive feedback over the years, in many cases telling me how
they indeed have become more effective and efficient in their jobs as a result of
putting into practice what they have learned from these pages. Look out for
future issues on SchoolCounselor.com. If you would like to share a tip or trick, or
if you would like to ask a question, e-mail Russ Sabella at
newsletter@schoolcounselor.com.

Sincerely, 

Russell A. Sabella, Ph.D.
Sabella@SchoolCounselor.com 

http://www.counseling.org/Source/Orders/index.cfm?ETask=1&Task=1&SEARCH_TYPE=FIND&FindIn=0&FindSpec=72810
http://www.counseling.org/Source/Orders/index.cfm?ETask=1&Task=1&SEARCH_TYPE=FIND&FindIn=0&FindSpec=72810
http://www.SchoolCounselor.com
mailto:newsletter@schoolcounselor.com
mailto:Sabella@SchoolCounselor.com
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SchoolCounselor.com - August 15, 2000 – #20

Quote of the Month 

DeForest has said in many newspaper and over his
signature that it would be possible to transmit the human
voice across the Atlantic before many years. Based on
these absurd and deliberately misleading statements, the
misguided public ... has been persuaded to purchase
stock in his company.  -- U. S. District Attorney
prosecuting inventor Lee Deforest for fraud, 1913
 

Frequently Asked Questions (FAQ) and
Answers

Q: There is a file on my computer which I'm having trouble finding. I know I put the word
"minutes" in it and to go through every file on my computer would take forever. Is there
another way? 

A: Yes, there is. If you work with a Windows operating system, click on the Start button in the
lower left corner. Then choose Find, and Files or Folders.  Simply put a key word in the Named
field and choose the right drive for the Look in field, then click on Find Now. You will get a list
of files with your key word in it. You may also want to use wildcards in whatever you type in
the Named field. For instance, use the asterisk (*) as a wild card. If you are looking for a file
that starts with the letter s, put in s*.* Another tip is to click on the Date tab to locate files
created within a range of dates.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I am building a web site and learning how to include special programs called CGI and Java.
I've also heard that many of these may be available for free, is this true? 

A: Yes, it is. You can find many various scripts on the net which you can simply copy and paste
or download. Try these web sites for instance;  
http://www.dynamicdrive.com 
http://java.sun.com/applets/resources.html 
http://www.webcoder.com/scriptorium/index.html 
http://www.cgi-resources.com 
http://javaboutique.internet.com/articles/ITJ/qanda/ 
 
~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q:  I have call waiting. When I'm online and receive a call, my connection to the internet is lost.
Sometimes I'm in the middle of writing an e-mail and have to start all over. What can I do? 

A: Well, two things come to mind. First, you can set your modem connection to temporarily
disable your call waiting feature when you connect to your service provider. You will need to

http://www.dynamicdrive.com
http://java.sun.com/applets/resources.html
http://www.webcoder.com/scriptorium/index.html
http://www.cgi-resources.com
http://javaboutique.internet.com/articles/ITJ/qanda/
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find the program on your computer that connects you. Then, before the dial-in number, enter
the appropriate Disable Call Waiting code for you area and two commas. Check your phone
book or contact your telephone company to get the Disable Call Waiting code for your area.
Depending on where you live, it will be one of the following three codes: *70, 70# or 1170. So,
in my area of the country, if I were dialing in using the number 555-1212, the new entry would
look like this: *70,,555-1212. The *70 part disables my call waiting, the two commas tells the
modem to pause for a couple of seconds, and then dial the appropriate number. Your call
waiting feature will be enabled again after you hang up. You might like to ask your telephone
company about is if they might provide Internet call waiting. This technology flashes a message
on your screen whenever a call comes in while you are on-line. You then have the choice of
taking the call or staying online.  Second, even if your connection is accidentally "dropped," you
shouldn't have to re-write your e-mail. You can save your e-mail as a draft and return to it
later. Ask someone that knows to show you how to use this feature within the e-mail software
you are using.
 

Worthy Websites

Psychoeducational Webring: A wonderful list of sites to help with psychoeducational (large
group guidance) endeavors. http://www.webring.org/cgi-bin/webring?ring=psychoed;list 

Adolescence: Change and Continuity. All about adolescents.
http://www.personal.psu.edu/faculty/n/x/nxd10/adolesce.htm#top 

Counselor related online reading.
http://www.awesomelibrary.org/Office/Counselor/Counselor.html 

Bob Bowman's guide to FREE educational technology. http://www.user.shentel.net/rbowman/ 

Center for Effective Collaboration and Practice. This site contains valuable information such as
"Safeguarding Our Children: An Action Guide" and "School Safety and Violence Prevention."
http://cecp.air.org/

Cybercounseling: The authors of the site say that, "Our vision from the start of this endeavor to
develop “Cybercounseling and Cyberlearning: Strategies and Resources for the Millennium” has
been to create two distinct products: one a hard copy publication to include the most
up-to-date writings about current practices in cybercounseling and cybereducation; the other a
more dynamic and fluid publication with a home on the World Wide Web. The second product
grew from our certain knowledge that we would be faced with a constant flow of new
knowledge on a daily basis, and that fitting all that is happening in the cyberworld into one
hard copy publication was as likely as controlling the explosion of knowledge on the World Wide
Web." http://cybercounsel.uncg.edu/ 
 
Education World's Counseling Center. http://www.education-world.com/counseling/ 

http://www.webring.org/cgi-bin/webring?ring=psychoed;list
http://www.personal.psu.edu/faculty/n/x/nxd10/adolesce.htm#top
http://www.awesomelibrary.org/Office/Counselor/Counselor.html
http://www.user.shentel.net/rbowman/
http://cecp.air.org/
http://www.ojjdp.ncjrs.org/grants/current.html
http://cybercounsel.uncg.edu/
http://www.education-world.com/counseling/
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NMSA Research Summary #17: What Types of Block Schedules Benefit Middle School Students?
http://www.nmsa.org/ 
 
Free worksheets. http://www.schoolexpress.com/ 
 
The Career Interests Game. This is a game designed to help you match your interests and skills
with similar careers. It can help you begin thinking about how your personality will fit in with
specific work environments and careers. Come play along and see what happens!
http://web.missouri.edu/~cppcwww/holland.shtml 
 
Teach with movies ... Learning Guides to each recommended film describe the benefits of the
movie, possible problems, and helpful background. Discussion questions, bridges to reading,
projects and links to the internet are also provided. http://www.teachwithmovies.org/ 
 
Studies in Moral Development and Education. http://www.uic.edu/~lnucci/MoralEd/index.html 
 

Slick Software 

FinePrint Web: Printing web pages can produce a lot of wasted paper. FinePrint Web, a FREE
printer driver, will put a stop to that. Print multiple pages per sheet, and more.
http://www.zdnet.com/downloads/lpad/fineprintweb.html 
 
TaskZip v1.4: Easily schedule regular backups of your important files. You'll definitely want to
get and use this before you wished you had it.
http://www.zdnet.com/downloads/stories/info/0,,0014UG,.html 
 
Professor Franklin Photo Effects: Sensational photo effects will quickly transform any
publication, home project or web site from Plain - Jane to WOW! And when you're done, drag
and drop your masterpiece into any Windows document... just don't tell anyone how easy it
was! (Any computer store or online such as at
http://www.us.buy.com/retail/product.asp?sku=20301619&loc=105 
 
FileMaker Pro 5 is the quickest, easiest way to get an
organization organized. Easily create, share and manage.
http://www.filemaker.com/products/fm_home.html 

Just for Fun 

Send a personalized e-greeting at http://www.imira.com. That's
right, you can upload a photo from your computer to create and
send a personal card. Try it! 
 

http://ericae.net/pare/Home.htm
http://www.cmha.sudbury.on.ca/Diversity.html
http://www.media-awareness.ca/eng/med/class/teamedia/medvio1.htm
http://www.nmsa.org/
http://www.schoolexpress.com/
http://web.missouri.edu/~cppcwww/holland.shtml
http://www.teachwithmovies.org/
http://www.uic.edu/~lnucci/MoralEd/index.html
http://www.ex.ac.uk/cimh/software.htm
http://www.zdnet.com/downloads/lpad/fineprintweb.html
http://www.zdnet.com/downloads/stories/info/0,,0014UG,.html
http://www.connectedcounseling.com/funny%20face.html
http://www.us.buy.com/retail/product.asp?sku=20301619&loc=105
http://www.filemaker.com/products/fm_home.html
http://www.imira.com
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Search a day in history to find out what happened at http://www.on-this-day.com 
 
Design and order a set of free business cards (shipping and handling charges of about $6
apply) at http://www.vistaprint.com 
 
For the Peanuts gang fanatics ... http://www.peanutscollectorclub.com/wwwfun.html 

http://www.on-this-day.com
http://www.vistaprint.com
http://pages.carnaby.com/home/just4fun/biorhythms/biofacts.html
http://www.peanutscollectorclub.com/wwwfun.html
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The CyberTipline
handles leads from
individuals reporting
the sexual exploitation
of children including
Child Pornography or
Online Enticement of
Children for Sexual
Acts. 

SchoolCounselor.com - #21 October 21, 2004

SchoolCounselor.com uses e-Campaign to publish newsletters.
This software enables you to easily design rich HTML emails and
newsletters, and deliver personalized HTML emails to your target
audience (e.g., parents, community members, other stake holders)
using mailing lists. Among the key features are mail merging,
WYSIWYG HTML composing, built-in SMTP server, bounce and
unsubscribe processing, fast e-mail delivery, and ease-of-use.
http://www.lmhsoft.com/ 

____________________________________________

If it's green, it's biology, If it stinks, it's chemistry, If it has numbers
it's math, If it doesn't work, it's technology. --Unknown 

One machine can do the work of fifty ordinary men.  No machine can do the work of one
extraordinary man.  Elbert Hubbard, The Roycroft Dictionary and Book of Epigrams, 1923.

When computers (people) are networked, their power multiplies geometrically. Not only can
people share all that information inside their machines, but they can reach out and instantly tap
the power of other machines (people), essentially making the entire network their computer.
Scott McNeely.
____________________________________________

eCD: Everything Parents Need to Know About the Road to College http://tinyurl.com/bm8kl 

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q. I installed Windows XP Service Pack 2, but now one of my programs is giving me problems.
What do you suggest? 

A. Some programs aren't compatible with SP2. Microsoft has a list of programs with known
issues and ways to get solve them at
http://support.microsoft.com/default.aspx?scid=kb;en-us;884130 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

https://web.cybertip.org/cyberTipII.html
http://www.lmhsoft.com/
http://tinyurl.com/5ttd6
http://tinyurl.com/bm8kl
http://support.microsoft.com/default.aspx?scid=kb;en-us;884130
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Q: Diane writes, “Hi Russ, I would be interested in knowing more about various programs for
keeping notes on students; also the wisdom of doing so. I know there are lots of things
available, but I need something reasonably priced and that I could "lock."

A: Good question Diane. I appreciate your interest in using high-tech tools to maintain and use
data in a confidential manner. 

One way to take notes is to use your personal information manager. For example, with
Microsoft Outlook Calendar, you can log your appointments and use the Notes section to take
your notes. You can check the Privacy box in the lower right corner so that it doesn’t show up
on a network. And, you can add another layer of security by encrypting the notes (click on File,
Properties, then the Security Tab). This is, by today’s standards, an awkward and not-so-high-
tech way of doing it I have to admit. I mention it though because many counselors are already
using Outlook so no further purchase of software would be necessary.

A better way of doing it is to purchase software which is specifically designed for this purpose.
For instance, one popular system is the School Counselor Accountability and Task Analysis
Program (SCAATAP; http://www.scaatap.com/). SCAATAP provides school counselors a quick
and easy way to record activities and create daily, weekly, monthly, quarterly, and annual
reports. The data generated by these reports will provide the “process” accountability that
administrators and policy-makers desire. The reports will help answer the question “What do
school counselors do?” You can visit the SCAATAP site and download a trial version to “kick the
tires” a bit before you decide to purchase. 

Another piece of software named Hallways is available at http://www.ihatepaperwork.com. You
can take a tour of this beginning at
http://www.ihatepaperwork.com/Hallways/tour/students.htm 

The nice thing about both of these tools is that they align with the ASCA National Model and
Standards (http://www.schoolcounselor.org/content.asp?contentid=134) and can help you
throughout various aspects of your comprehensive school counseling program.

Another tool worth mentioning and that some school counselors are using is treatment planning
software. For instance, TheraScribe® 4.0 simplifies and streamlines clinical record-keeping and
eliminates hours of time-consuming paperwork. TheraScribe® even gives you the flexibility to
customize your treatment plans-simply "point and click" to add behavioral definitions, treatment
goals and objectives, and therapeutic interventions. 
http://www.wiley.com/legacy/products/subject/psychology/therascribe/. I believe that this type
of software can work for counseling and development goals in all the domains: academic,
personal/social, and career. 

TIPS AND TRICKS

http://www.scaatap.com/
http://www.ihatepaperwork.com/Hallways/tour/students.htm
http://www.schoolcounselor.org/content.asp?contentid=134
http://www.wiley.com/legacy/products/subject/psychology/therascribe/
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In this issue, we focus on Microsoft Word™ 2000.

-- Here's a way you can use your keyboard to quickly change the case of text. First select the
text you want to change and press SHIFT+F3. Each time you press the SHIFT + F3 key, the
text case switches between Title Case, UPPERCASE, and lowercase. Try it!

-- When you create a table in Microsoft Word™, you typically use the first row of a table as
headings. If you have a table that spans multiple pages, you lose the headings after the first
page, so it's difficult to tell what each column topic is. Here's how to keep those headings
visible: 

1. Select the first row or rows of your table. 
2. On the Table menu, click Heading Rows Repeat. 
3. Now Word automatically repeats the table headings at the top of subsequent pages.

-- To select a vertical block of text such as a column of numbers, press and hold down ALT, and
then drag your mouse over the text. Then, you can delete it or copy it into another file. 

-- Tell the Office Assistant to go away. 

1. Click on the Office Assistant, then click on Options. 
2. Clear the Use Office Assistant check box. 

You can also customize the behavior of the Office Assistant by checking or clearing the
checkboxes on the Options tab. If you want to learn how to customize the Office Assistant, but
it's not currently visible, choose Show the Office Assistant from the Help menu.
____________________________________________

WORTHY WEBSITES

Anti-Phishing Work Group. Phishing attacks use 'spoofed' e-mails and fraudulent websites
designed to fool recipients into divulging personal financial data such as credit card numbers,
account usernames and passwords, social security numbers, etc. By hijacking the trusted
brands of well-known banks, online retailers and credit card companies, phishers are able to
convince up to 5% of recipients to respond to them. The Anti-Phishing Working Group (APWG)
is an industry association focused on eliminating the identity theft and fraud that result from
the growing problem of phishing and e-mail spoofing. http://www.antiphishing.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Getting Rid of "Spam" ...and Other E-mail Pests by Randy Cassingham. The basics of spam,
how they got your address in the first place, and what to do now. http://www.spamprimer.com 

http://www.antiphishing.org/
http://www.spamprimer.com
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows XP Tips & Tricks. http://www.tunexp.com/tips 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

A basic tutorial of Microsoft Excel™. FREE.
http://www.usd.edu/trio/tut/excel 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free FrontPage Solutions for versions 98 and 2000
http://www.accessfp.net/freefrontpagestuff.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Create a professional image with free, easy Microsoft® Word templates.
http://www.hp.com/sbso/productivity/office/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Office Clip Art and Media ... a huge assortment of clip art and media (sounds, clip art,
photos, and animation). Use the broad subject area or search by key word. Once you find the
media you want, simply copy and paste the clip wherever you want it, or drag it into your
Microsoft document. Or, click the thumbnail of the clip and drag it to the place in your
document where you want it. If you think you may want to use the clip again, you can
download it and add it to Microsoft Clip Gallery or Microsoft Clip Organizer. Tons and tons of
clip art on a wide variety of topics make this a winner.
http://office.microsoft.com/clipart/default.aspx?lc=en-us 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

10 Commandments for Kids Online (also in Spanish).
http://www.komando.com/kimskidscontract.html 

____________________________________________

SLICK SOFTWARE

Useful Excel spreadsheets and add-ins. FREE. 
http://www.j-walk.com/ss/excel/files/general.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.tunexp.com/tips
http://www.usd.edu/trio/tut/excel
http://www.accessfp.net/freefrontpagestuff.htm
http://www.hp.com/sbso/productivity/office/
http://office.microsoft.com/clipart/default.aspx?lc=en-us
http://www.komando.com/kimskidscontract.html
http://www.waseo.de/en/Products/Freeware1/DateTimeSoftware/CalPaint1/calpaint1.html
http://www.j-walk.com/ss/excel/files/general.htm
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OpenOffice.org is both an open-source product and a project. The product is a multiplatform
office productivity suite. It includes desktop applications such as a word processor, a
spreadsheet program, a presentation manager, and a drawing program, with a user interface
and feature set similar to those of other office suites. OpenOffice.org also works transparently
with a variety of file formats, including those of Microsoft Office. http://www.openoffice.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tons of freeware from Lockergnome. http://www.snapfiles.com/freeware/freeware.html 

____________________________________________

Promotion

Using Technology to Improve Counseling Practice: A Primer for the 21st Century J. Michael
Tyler and Russell A. Sabella. This handbook addresses the implications of the growing
relationship between the counseling profession and the use of computers in counseling
administration and practice. Using the 12 Technological Competencies for Counselors
established by the ACES Technology Interest Network as their foundation, the authors provide
an overview of current technology as it relates to practice and training and offer
easy-to-understand, jargon-free applications of technology.  Drs. Tyler and Sabella provide a
bridge for counselors to advance their technological skills to a level where they can reap all of
the benefits that technology has to offer, while overcoming the challenges that computers can
create. They include tips on how to save time and increase efficiency, automate record keeping,
learn computerized statistical packages and testing and diagnostic programs, master recording
technologies, and search for reliable information on the Internet. Ethical and legal issues are
explored in detail, as are electronic counseling services. Relevant resources, Web sites, and
software designed to enhance the counseling process are also included in this cutting-edge
manual. 2004 275 pages. ISBN 1-55620-227-X. Call 800-422-2648 or purchase online at
http://tinyurl.com/5gux6. Also, see http://www.21stcenturycounselor.com/ for more
information. 

____________________________________________

JUST FOR FUN

If this doesn't make your day nothing will!
http://www.qnet.com/%7Epontius/smile/smilelmp_1%5B1%5D.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Inspirational Flash Movies. http://www.inspiringthots.net/ 

http://www.openoffice.org/
http://www.snapfiles.com/freeware/freeware.html
http://tinyurl.com/6gvch
http://tinyurl.com/5gux6
http://www.21stcenturycounselor.com/
http://www.qnet.com/%7Epontius/smile/smilelmp_1%5B1%5D.htm
http://www.inspiringthots.net/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

A whole new kind of Mini-Test! Entertaining yet revealing, the Just-For-Fun Tests give you a
quick glimpse into your psyche, sense of right and wrong, and personal quirks. 
http://www.queendom.com/tests/minitests/ 

____________________________________________

http://www.queendom.com/tests/minitests/
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World Wide Web Boot Camp for
School Counselors - CD by Russell
A. Sabella, Ph.D. 

With over 36 videos and lots of tips,
tricks, links, this CD gives you
step-by-step instructions for effectively
and efficiently navigating the Web.
Because all the files are on the CD, you
won’t need to connect to the Internet
for all the essential information (only
linked web sites require an Internet
connection). What you see and hear on
the videos is what you do. This
straightforward approach makes
learning how to use the Web as easy
and convenient as watching television.
This tool will help students,
practitioners, and professors alike
spend less time searching and more
time finding relevant counseling
resources available on the Web. 

The content on the CD is equivalent to
a full-day workshop in the computer
lab. Visit
http://www.schoolcounselor.com/cd to
view the table of contents, sample
videos, and ordering information.

SchoolCounselor.com - #22: October 31, 2004

The saddest aspect of life right now is that science
gathers knowledge faster than society gathers
wisdom.  ~Isaac Asimov, Isaac Asimov's Book of
Science and Nature Quotations, 1988

Some people worry that artificial intelligence will
make us feel inferior, but then, anybody in his
right mind should have an inferiority complex
every time he looks at a flower.  ~Alan C. Kay

_________________________________________

- From SchoolCounselor.com, you can now conduct
research using HighBeam™ Research, LLC which
runs an online research engine for individuals,
filling the gap between free search engines and
high-end research services. By delivering
sophisticated research tools with convenient access
to the free Web, paid online services and our
proprietary databases, HighBeam can empower
counselors to efficiently locate, organize and
deliver answers.
http://www.schoolcounselor.com/resources/index.
htm 
________________________________________

FREQUENTLY ASKED QUESTIONS

Q: V.W. asks, “How do I keep my computer safe
from bugs, worms, viruses, hostile takeovers ...
and more ..?”

A: With all the current and new threats to our computer coming out every day, this is not an
easy job. The good news is that there are various programs out there to help. First, understand
the various types of threats: unauthorized access, malicious code (viruses, worms, and the
like), and spyware (aka adware). Following are descriptions and solutions (much of this
adapted from my SchoolCounselor.com book):

UNAUTHORIZED ACCESS: A firewall is used to prevent unauthorized Internet users from
accessing your computer or private networks connected to the Internet, especially intranets. All
files and messages entering or leaving the network or computer pass through the firewall,

http://www.schoolcounselor.com/cd
http://www.schoolcounselor.com/resources/index.htm
http://www.schoolcounselor.com/resources/index.htm
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SchoolCounselor.com: A
Friendly and Practical Guide to
the World Wide Web (2nd
edition) by Russell A. Sabella,
Ph.D. The Internet gives counselors
a vast amount of resources and a
powerful medium for connecting
with others. Following a
counselor-friendly introduction to
computers and the World Wide
Web, readers are introduced to over
1,200 web sites and given a
practical guide to gaining access,
navigating, searching for relevant
materials, and creating websites.
Related issues of interest to both
novice and experienced users are
discussed.
http://tinyurl.com/5ttd6 

which examines the content and blocks those that do
not meet the specified security criteria. In all
likelihood, your school probably already has more
than one type of firewall for the school network. You
may need one, however, if you access the Internet
using a different system such as from home. If you
use a dial-up service and you are not online for
extended periods of time, you are probably safe
without one because dial-up services typically provide
you with a random type of access which is difficult to
trace to you. If you are accessing the Internet using a
broadband or high speed connection, it is critical that
you have a firewall installed on your computer. The
reason for this is that broadband connections are
“always on” even when your computer is not. It is
much easier for hackers to find a security breach and
gain access to your computer after you do turn on
your computer. You must keep your firewall program
updated! The best way to do this is to open the
“Scheduler” in either of the programs and set it to
automatically update itself every time you boot up.

Two common firewall programs include:

Norton Personal Firewall: http://www.symantec.com/sabu/nis/npf/ 
ZoneAlarm (free): http://tinyurl.com/5m3jf 

The firewall programs are also are a part of a larger (for a fee) suite which comes with more
comprehensive protection and includes virus protection, pop-up blocking, and more. Windows
XP SP2 comes with a built in Firewall although the reviews that I have read indicate an
insufficient level of reliability and recommend a more robust solution such as those mentioned
above. Mac OS X has a built-in firewall similar to the one included with Windows XP. If you
want something better, check out products from Intego (http://www.intego.com;) and
Symantec (http://www.symantec.com;). Macintoshes have not been targeted as Windows
machines have, so the situation there is much less threatening. 

VIRUSES: A virus is a program or piece of code that is loaded onto your computer without your
knowledge and runs against your wishes. All computer viruses are created by people and most
can replicate themselves. A simple virus that can make a copy of itself over and over again is
relatively easy to produce. Even such a simple virus is dangerous because it will quickly use all
available memory and bring your system to a halt. An even more dangerous type of virus is one
capable of transmitting itself across networks and bypassing security systems (see
http://www.Webopedia.com). To protect yourself from viruses on the Internet, don’t download

http://tinyurl.com/5ttd6
http://www.symantec.com/sabu/nis/npf/
http://tinyurl.com/5m3jf
http://www.intego.com
http://www.symantec.com
http://www.Webopedia.com
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files from sources that may not be safe. Viruses are usually hidden in programs and activated
when the programs run. They also can be attached to certain other types of executable files,
such as special-action Web files and video files. Generally, when you’re about to download a
type of file that could contain a virus, your browser will display a warning and ask whether you
want to open the file or save it to disk. If you’re confident that the file comes from a
trustworthy source, you may want to save it. If you’re not sure, you may want to cancel your
download. However, rather than practicing “download abstinence”, you might continue and
have a protected transaction by using an antivirus program. Immediately after downloading a
file to your computer and before doing anything with it, have the file scanned for viruses by
your antivirus program. There is still a chance that the file might contain a new and
undocumented virus which will not be detected by antivirus software, although this chance is
very small. If you don’t have antivirus software loaded on your computer, you should get it
right away. You might check out the following as starters:

Norton Antivirus: http://www.symantec.com 
McAfee antivirus: http://www.mcafee.com 

Don’t forget to keep these anti-virus programs updated! It is estimated that 80 new viruses are
generated every day. The best way to do this is to open the “Scheduler” in either of the
programs and set it to automatically update itself every time you boot up. 

SPYWARE/ADWARE: These are general terms for programs that surreptitiously monitors your
actions. While they are sometimes sinister, like a remote control program used by a hacker,
software companies have been known to use spyware to gather data about customers. The
practice is generally frowned upon (see http://blackice.iss.net). On the Internet, "spyware is
programming that is put in someone's computer to secretly gather information about the user
and relay it to advertisers or other interested parties." As such, spyware is cause for public
concern about privacy on the Internet (see
http://reach.ucf.edu/~coursdev/cdrom/html/help/glossary.html).

Two free programs that come highly recommended and are free include:

Ad-Aware SE Personal Edition: http://tinyurl.com/yu6cm 
Spybot Search & Destroy: http://www.safer-networking.org/en/index.html 

Again, keep them updated and run them often. Unlike the antivirus and firewall software, these
two free anti-spyware programs do not come with a scheduler and so you must remember to
run them every few days. 

OTHER TIPS FOR KEEPING YOUR COMPUTER SAFE AND SECURE

1. WINDOWS UPDATE: Another way to keep your computer strong and healthy is to conduct
periodic updates of your installed software, especially for your Windows Operating System

http://www.symantec.com
http://www.mcafee.com
http://blackice.iss.net
http://tinyurl.com/yu6cm
http://www.safer-networking.org/en/index.html
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(e.g., XP; http://windowsupdate.microsoft.com/) and the Microsoft Office Suite
(http://officeupdate.microsoft.com). After you run Windows Update for the first time, it will give
you the option of installing an automatic updater which can alert you to new updates. For Mac
users - "System Preferences - Software Update" to download and install patches for OSX.

2. Don't open suspicious files, especially e-mail attachments. One of the primary methods that
people use to disseminate malicious code is via e-mail attachment. An e-mail may actually come
from someone you know and may use alluring messages (e.g., "Here is the document you
wanted, don't show anyone else!") to get you to open an attached file which may cause you a
range of computer performance problems. Some files may be designed to look like a website
address because it ends in "com" such as your.file.yahoo.com.  Such files may actually be a
program that will run when opened.  Instead, respond and ask the sender if, indeed, the file
came from him or her and of what the file consists (see
http://www.21stcenturycounselor.com).

____________________________________________

TIPS AND TRICKS

In this issue, we focus again on Microsoft Word™

Shrinking a document to fit: If you've created a document and one or two lines spill over unto a
new page, you can use the "Shrink to Fit" feature to fit everything on the page. Choose File,
Print Preview and click on the Shrink to Fit button. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Turn off the automatic URLs in Microsoft Word™.

Choose AutoCorrect (or AutoCorrect Options) from the Tools menu. 
Click on the AutoFormat As You Type tab. 
Under Replace As You Type, clear the Internet and network paths with hyperlink check box. 

If you didn't turn off AutoCorrect before you started typing and now you have a document full
of hyperlinks that you don't want, you can turn them off, either one at a time, or all at once. To
turn a link off, right-click on the link, select Hyperlink from the pop-up menu, and then select
Remove Hyperlink. To remove all links from the document, choose Select All from the Edit
menu or press [Ctrl]+[A], and then press [Ctrl]+[6] to remove all hyperlinks. 

Answer provided by:
From http://www.willamette.edu/wits/resources/docs/software/msoffice/word-faq.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://windowsupdate.microsoft.com/
http://officeupdate.microsoft.com
http://www.21stcenturycounselor.com
http://www.willamette.edu/wits/resources/docs/software/msoffice/word-faq.htm
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Tell the Office Assistant to go away.

Click on the Office Assistant, then click on
Options. 
Clear the Use Office Assistant check box. 
You can also customize the behavior of the Office
Assistant by checking or clearing the checkboxes
on the Options tab. If you want to learn how to
customize the Office Assistant, but it's not
currently visible, choose Show the Office
Assistant from the Help menu.

Answer provided by:
(From http://www.willamette.edu/wits/resources/docs/software/msoffice/word-faq.htm)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Formatting and Printing Labels in Word (and other Tutorials).
http://www.mistupid.com/tutorials/word/ 

These tutorials are actually online demonstrations that take you through the procedure step-by-
step.

____________________________________________

WORTHY WEBSITES

4 Ways to Protect Kids Online (by Kim Komando - 10/11/2004)
http://www.komando.com/kolumns_show.asp?showID=7806 
The Internet is an incredibly useful tool for children and young adults. But it's also full of
objectionable content that’s merely a few keystrokes away. Here are four ways to help make
your child's online experience a safer one.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

ToolBelt
http://www.ncrel.org/toolbelt 
This site includes information-gathering tools ranging from checklists to surveys. Some tools are
designed for printing and circulating in paper form, while others are computer-based surveys or
Web sites. These tools are designed to help educators collect data about their classroom,
school, district, professional practice, or community. The information from these tools can be
used to assess status and growth, plan for improvement, and make decisions based on facts
rather than impressions or intuitions.

http://www.willamette.edu/wits/resources/docs/software/msoffice/word-faq.htm
http://www.mistupid.com/tutorials/word/
http://www.komando.com/kolumns_show.asp?showID=7806
http://www.ncrel.org/toolbelt


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 16 of 167

~~~~~~~~~~~~~~~~~~~~~~~~~~~

An Interviewer's Handbook
http://www.ssta.sk.ca/research/human_resources/148.htm 
An Interviewer's Handbook by Judith Gibney. This
handbook for interviewers was prepared for the lay person
who becomes involved in teacher selection at the school
level.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

BJ's Homework Helper
http://school.discovery.com/homeworkhelp/bjpinchbeck/ 
B.J. Pinchbeck's Homework Helper is produced by B.J., 17
years old, and his Dad.  Quite extensive!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Play It Cyber Safe
http://www.playitcybersafe.com 
The goal of this Web site is to empower children, parents and teachers to prevent cyber crime
through knowledge of the law, their rights and how to avoid misuse of the Internet.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Multicultural Education
http://curry.edschool.virginia.edu/go/multicultural/teachers.html
A multicultural lesson toolbox!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

K12Handhelds
http://www.k12handhelds.com/ 
Handheld solutions for educators.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

votations
http://www.votations.com/ 
FREE professional web and e-mail based polls, surveys and targeted newsletter tools and
hosting solutions.
~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.ssta.sk.ca/research/human_resources/148.htm
http://school.discovery.com/homeworkhelp/bjpinchbeck/
http://www.playitcybersafe.com
http://curry.edschool.virginia.edu/go/multicultural/teachers.html
http://www.k12handhelds.com/
http://www.votations.com/
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ProTeacher! Classroom management ideas for elementary school teachers in grades
http://www.proteacher.com 
Lots of links and resources.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FlamingText
http://www.flamingtext.com 
See your name in flames and more!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

ePALS Classroom Exchange
http://www.epals.com 
ePALS has thousands of classroom profiles bringing people in hundreds of countries together as
cross-cultural learning partners and friends.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Being Assertive Workbook by Dr. Chris Williams (PDF file)
http://tinyurl.com/6stlm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.proteacher.com
http://www.flamingtext.com
http://www.epals.com
http://tinyurl.com/6stlm
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SchoolCounselor.com: #23 November 15, 2004

The thing with high-tech is that you always end up using scissors.  -- David Hockney (as quoted
in Observer's Sayings of the week - 10 Jul 1994).

The first rule of any technology used in a business is that automation applied to an efficient
operation will magnify the efficiency. The second is that automation applied to an inefficient
operation will magnify the inefficiency. 
Bill Gates

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: I periodically receive pictures in e-mail that gets sent to me. Instead of saving the e-mail
message itself, is there any way that I can individually download the images to my hard drive?

A: Answer provided by lockergnome.com (see http://tinyurl.com/6ur6l)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I have a computer folder filled with photos, over 300, and I want to make a Microsoft
PowerPoint Slideshow. Is there an easy way to do this?

A: Indeed, there is, glad you asked. There is a feature in PowerPoint called Create Photo Album
that will automate this process to save you loads of time! This feature started as an add-in to
PowerPoint 2000 and was added as a standard feature in later versions starting with
PowerPoint 2002. Here is how it works:

POWERPOINT 2000

1. Download the file from the Microsoft Office web site at
http://office.microsoft.com/Downloads/2000/album.aspx 
2. Double-click the album.exe program file on your hard disk to start the setup program.
4. Follow the instructions on the screen to complete the installation.

To create a photo album using pictures on your local machine or a network drive

1. In PowerPoint 2000, click New on the File menu.
2. On the General tab, click PhotoAlbum, and then click OK.
3. The Photo Album dialog box appears.
4. Click File/Disk, and then locate the folder that contains the pictures you want.
5. Select the pictures you want, and then click Insert.

http://tinyurl.com/6ur6l
http://office.microsoft.com/Downloads/2000/album.aspx
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6. Choose the other options you want for your photo album. (For Help on an option, click the
question mark button in the dialog box and then click the option.)
7. Click Create to create the photo album.
8. The photo album is created and you return to PowerPoint.

Once your photo album is created, you can modify the album any way you like in PowerPoint,
but you can't go back to make changes using the Photo Album Wizard.

PowerPoint 2002

From the Insert menu, point to Picture, and then click New Photo Album. Then follow the same
directions for PowerPoint 2000.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: For extra security, I want to password protect a Microsoft Word™ document on my
computer, how do I do this?

A: First of all, when choosing a password of any kind, consider this security hint from the
experts: Use strong passwords that combine upper- and lowercase letters, numbers, and
symbols. Weak passwords don't mix these elements. Strong password: K898^Lkjf)9. Weak
password: RussellS27. Use a strong password that you can remember so that you don't have to
write it down.

You should also know that this document is still susceptible to being opened by someone who
knows how to “crack” a Microsoft Word™ document password. The good news is that the
procedure requires a piece of software, access to your computer, and the desire to access your
document. If this risk is still too high for you, you ought to consider saving the file to a floppy
or flash drive and lock it in your file cabinet. 

Finally, check out http://lastbit.com/word-article.asp for a great tutorial on the subject. 

To create a password for a Word document:

1. On the Standard toolbar, click the Open button. The Open dialog box appears. Open a
document.  
2. On the Tools menu, click Options. The Options dialog box appears.  
3. Click the Security tab to display security options.  
4. In the Password to modify box, type in your password. (NOTE: As you type the password,
asterisks appear instead of the characters you type to keep your password confidential.)
5. Click OK to close the Options dialog box. (The Confirm Password dialog box appears.)

http://lastbit.com/word-article.asp
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6. In the Reenter password to modify box, type
the same password as in step 4. 
7. Click OK to set the password.
8. On the Standard toolbar, click the Save button
to save the document.  
9. Click the Close Window button in the
document window.  

To open the protected document with read-only
and then full privileges, follow these steps: 

1. On the Standard toolbar, click the Open
button.  The Open dialog box appears.  
2. Open the file you created in the earlier
procedure.  
3. The Password dialog box appears.  This
document is now protected by the password that
you set.  
4. In the Password box, type tgc1, and then click OK. A message appears, indicating that you
typed an incorrect password. In the message box, click OK.  
5. In the Password dialog box, click Read Only.  The document opens as a read-only document.
(Read-Only) appears in the title bar.  
6. Click the Close Window button in the document window. The read-only document closes.  
7. On the Standard toolbar, click the Open button. The Open dialog box appears.  
8. Reopen the file. The Password dialog box appears.  
9. Type your password, and then click OK. After you type the correct password, the document
opens.  

To DELETE the password:

1. On the Tools menu, click Options. The Options dialog box appears.  
2. Click the Security tab, select the contents in the Password to modify box, press DELETE, and
then click OK. The password protection is removed.  
3. On the Standard toolbar, click the Save button to save the document.  
4. Click the Close Window button in the document window. The document closes. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: Is there any way to search a web page that is lengthy. For instance, if I want to quickly find
the confidentiality segment of the ASCA ethics document, how can I get right to it?

A: Once you have located the site and the particular page that contains the information you
need (in this case http://www.schoolcounselor.org/content.asp?contentid=173): 

http://www.schoolcounselor.org/content.asp?contentid=173
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In Internet Explorer, click on [Edit] and then [Find (on this page)] or press CTRL-F on the
keyboard as a shortcut. Then simply put in your keywords and press Enter or [Find Next].
Notice that you can check or uncheck certain options such as to search up the page or down
the page. You can also restrict your search to whole words only and find an exact match which
takes into consideration capitalization.

If you have the Google.com toolbar loaded (http://toolbar.google.com), you can put the word
in the search space and click on the highlighter icon and the words will be highlighted, normally
in yellow. Each search term found on the page will be highlighted in a different color. Click the
highlight button to toggle highlighting on and off. Note that it's not necessary to do a search on
terms to have them highlighted. Simply enter terms in the search box (do not hit the Enter key)
and click the "Highlight" button. 
____________________________________________

TIPS AND TRICKS

Google.com: Finding PowerPoint files.
Quickly locate PowerPoint files on the web for viewing or downloading. In Google.com, type in
your keywords and then add the following at the end: filetype:ppt. So, if you were searching
for PowerPoints on the web related to career decision making, the search term would look like
this (notice the word filetype:ppt has no spaces):

career decision making filetype:ppt

To download a PowerPoint file, place your curser over the link, right click, and choose Save
Target as.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

PowerPoint: Easily Changing from Caps to Lower Case (or Vice Versa)
If you have text that is in the wrong case, select the text, and then click Shift+F3 until it
changes to the case style that you like. Clicking Shift+F3 toggles the text case between ALL
CAPS, lower case, and Initial Capital styles. You'll be surprised how often you use this once you
get the hang of it!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

PowerPoint: Nudging Objects
You can use the arrow keys to move objects very small distances. This is a big win for those
laptop users who no longer have mice. Select the object, then use your arrow keys. Each press
of the key will move the object on "grid unit" (1/12th of an inch, don't ask why); if you hold
down the ALT key while nudging, or if you have the grid turned off, you can move the objects
one pixel at a time.

http://toolbar.google.com
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Explorer: Get to the Address Bar Quick
To get to the Address bar quickly, press F6. Not only does this move the cursor there, it also
highlights the current address so you can just start typing the new address without hitting the
delete button.
____________________________________________

WORTHY WEBSITES AND SOFTWARE

Refdesk. 
http://www.refdesk.com/ 
Refdesk has three goals: (1) fast access, (2) intuitive and easy navigation and (3)
comprehensive content, rationally indexed. The prevailing philosophy here is: simplicity.
"Simplicity is the natural result of profound thought." And, very difficult to achieve.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Create your own event calendar using this java script. 
http://javascript.internet.com/calendars/event-calendar.html 
Just add in your special dates make a few selections and your done. The calendar can be
printed or saved as an html document. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

LiveManuals. 
http://www.livemanuals.com/ 
It has a database of product manuals that you can search through, as well as product
simulations and interactive elements that take the idea of a regular manual one-step further.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free avast! 4 Home Edition
http://www.avast.com/eng/avast_4_home.html 
avast! 4 Home Edition is a full-featured antivirus package designed exclusively for home users,
non-commercial users. Both conditions should be met! Our company offers Home Edition free
of charge, since in our opinion, it is possible to avoid global virus spreading by efficient
prevention; however, many user are not able or do not want to pay for antivirus software. This
page will show you the most important features of this program.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.refdesk.com/
http://javascript.internet.com/calendars/event-calendar.html
http://www.livemanuals.com/
http://www.avast.com/eng/avast_4_home.html
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Brainy Betty
http://www.brainybetty.com 
“Brainy Betty” says, I started Brainybetty a few of years ago because I was trying to find
graphic resources and  free PowerPoint templates on the web and I couldn't find any I liked. So
I decided to make them myself and share them. Now, I've expanded the site to include
teacher's resources and other templates, scrap booking layouts, templates and stencils,
dingbats, icons, flash files, and much much more.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mozilla Firefox
http://www.mozilla.org/products/firefox 
New Web browsers are released all the time, but Mozilla's Firefox is one that is worth taking a
closer look at. Firefox's features include a built in pop-up blocker, a tab-browsing mode that
allows users to open several pages in a single window, and integrated Google searching. This
latest edition of Firefox includes enhanced security, a redesigned toolbar, and improved
compatibility with Internet Explorer. This version of Firefox is compatible with operating
systems running Windows 95 and higher (cited from The Scout Report -- November 12, 2004 --
HTML Version; http://scout.wisc.edu/report/sr/)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Cheat Sheet
http://www.google.com/help/cheatsheet.html 
A quick reference guide to the most popular special operators for Google, including Boolean and
adjacency operators, definitions, mathematical calculators, date search, site "info," and more.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

NICENET INTERNET CLASSROOM ASSISTANT 
http://www.nicenet.org/ica/ica_info.cfm 
Free web-based learning environment for classrooms, distance learning programs and
collaborative academic projects 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

CWShredder 
http://www.intermute.com/spysubtract/cwshredder_download.html 
Even if your PC has Ad-aware and Spybot Search & Destroy, you still  can't stop some versions
of an insidious and virus-like pest called  CoolWebSearch. Fortunately, a Dutch student who
goes simply by the  name Merijn wrote a tiny (128KB) free tool called CWShredder that 
specializes in removing dozens of CWS variants. 

http://www.brainybetty.com
http://www.mozilla.org/products/firefox
http://scout.wisc.edu/report/sr/
http://www.google.com/help/cheatsheet.html
http://www.nicenet.org/ica/ica_info.cfm
http://www.intermute.com/spysubtract/cwshredder_download.html
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tips to Avoid Spam from Florida Gulf Coast University
http://admin.fgcu.edu/compservices/spam/spamtips.htm 

http://admin.fgcu.edu/compservices/spam/spamtips.htm
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SUBSCRIPTION

Click here to subscribe or
unsubscribe from this
newsletter. To change
your e-mail address,
please subscribe your
new address and
unsubscribe your old one.

SchoolCounselor.com: #24 - November 30, 2005

Be nice to nerds. Chances are you'll end up working for one.
- anonymous

I'm a great believer that any tool that enhances communication
has profound effects in terms of how people can learn from
each other, and how they can achieve the kind of freedoms
that they're interested in.    Bill Gates 
 
____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: Is there a government agency in charge of stopping spam and taking complaints? 

A: The Federal Trade Commission has jurisdiction to combat spammers. The FTC receives
forwarded spam and stores it in a huge database. When you forward your spam, be sure to
include the full e-mail header. Once you're ready, send the spam and headers to
spam@uce.gov. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: What is phishing?

A: The following answer is written by Kim Komando Show Electronic Newsletter -- November 6,
2004 see (http://www.komando.com), Copyright, 2004 WestStar TalkRadio Network. Reprinted
with permission. No further republication or redistribution is permitted without the written
consent of WestStar TalkRadio Network. Visit Kim Komando and sign up for her free e-mail
newsletters at: http://www.komando.com. 

This new danger is a phishing attack. Phishing is computer slang for attacks in which criminals
pretend to be a bank or other institution. They try to trick you into giving up your password
and user name.

Most people have learned not to fall for this. But this new attack could fool the most careful
people. Here's how it works:

The criminals send you an e-mail (spam). When you open the e-mail, a small program called a
script runs. Note that you only need to open the e-mail; there is no attachment.

The scripting program goes to your HOSTS file, located deep in your computer. The actual path
in Windows XP is: C:\Windows\System32\Drivers\Etc\HOSTS

http://www.schoolcounselor.com/NEWSLETTER/
mailto:spam@uce.gov
http://www.komando.com
http://www.komando.com
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It enters your bank's Web address--for instance,
www.YourBank.com--in the HOSTS file. It also
enters an Internet Protocol (IP) number for the
criminals' address.

The next time you need to surf to your bank,
you attempt to go to www.YourBank.com. When
you enter that address, or any other address,
the browser first goes to the HOSTS file to find
the IP number. If it isn't there (it normally would
not be), it goes to a special computer on the
Internet to find the IP number.

However, the criminals have put your bank's
address in the HOSTS file, along with their IP
number. So you are automatically sent to that
IP number, which is the criminals' computer. It
looks like the bank's Web site, so you enter your
user name and password. That gives the criminals the information they need to enter your
account and steal your money.

How can you protect yourself? Some anti-virus programs guard against this kind of thing;
others do not. To be safe, you must disable your computer's scripting ability. To do that:

--In Windows XP, click Start>>My Computer. Click Tools>>Folder Options. Select the File
Types tab. Click File Types, then scroll to and click VBScript Script File. Click Advanced. In the
Actions box, click Open. Click Remove.

If you need to restore scripting, click New. Put Open in the Action box. In the next box, click
Browse. Find wscript.exe in C:\Windows\System32. Double-click it.

--In Windows ME and 2000, the procedure is similar. If you need to restore scripting in
Windows ME, the wscript.exe file is in C:\Windows.

--In Windows 98, you must disable Windows Scripting Host. Click Start>>
Settings>>Control Panel. Double-click Add/Remove Programs. Select the
Windows Setup tab. Double-click Accessories. Click the box next to Windows Scripting Host to
deselect it. Click OK>>Apply>>OK.

This attack is not yet a threat in the United States. But it is only a matter of time. Do not fail to
protect yourself. And forward this newsletter to your family and friends.

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Q: Using Microsoft Outlook, how do I set up a re-occuring reminder for myself (e.g., to back up
my computer once per month). 

A: To set up recurring tasks:

1. Open your Outlook Calendar. 
2. Click the Actions menu and click New Recurring Appointment. 
3. Under the Appointment time section shown in the figure, select a Start time. 
4. Configure the End time to be the same as the start time. 
5. Set the duration to 0 minutes. 
6. Under the Recurrence pattern section, select the desired options. 
7. Click OK. 
8. Type in a name for the reminder. 
9. Click Save and Close. 

____________________________________________

TIPS AND TRICKS

Microsoft Outlook Calendar
When multiple people need to attend a meeting, not all the individuals need to enter the event
into their respective calendars. One person can do this and then email the event to the others.
This can be done in three different ways:

1. After entering the meeting or event, click on Invite Attendees. Input their email addresses or
use a distribution list. When recipients receive their invitation, they can either automatically
schedule the event or click a button to add it to his/her calendar (depending on how their
program is customized).

2. Click on the colored strip next to the event in Calendar View and press Control-F. An email
with an attachment of the event will be ready for sending. When the recipient recieves the
email, he or she only needs to click on the attachment which brings up the calendar event and
click on Save and Close.

3. If you are using a Handheld device, consider having one person write in the calendar event
and “beam” it to the others in the room. Just for fun, start a beaming daisy chain. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Explorer Home Page
The homepage is the first web page that your browser loads when you start the program, a lot
of people set their homepage to the page where they get their emails, or a page they use very
regularly. You can easily change your home page setting, here are two ways.
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1.  First click on TOOLS on the main menu at the top of the screen, then click on INTERNET
OPTIONS. Type in the address of the homepage oyu would like to set, or if it is the one you are
currently visiting just click Use Current. Then simply click on the OK button. 

2. An easier way to do this is to simply drag the small icon located immediately to the left of
the website address over to the icon of the house toward the top. Then just click Yes when
prompted about permission to change your home page. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Explorer Favorites Page
To quicly add your current page/document to your favorites use CTRL-D.

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Audacity
http://audacity.sourceforge.net/ 
Audacity is a free audio editor. You can record sounds, play sounds, import and export WAV,
AIFF, Ogg Vorbis, and MP3 files, and more. Use it to edit your sounds using Cut, Copy and
Paste (with unlimited Undo), mix tracks together, or apply effects to your recordings. It also
has a built-in amplitude envelope editor, a customizable spectrogram mode and a frequency
analysis window for audio analysis applications. Built-in effects include Echo, Change Tempo,
and Noise Removal, and it also supports VST and LADSPA plug-in effects. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Peer Reviewed Journals on the Internet
http://llanes.panam.edu/journal/ejournals.html 
Compiled by Tirupalavanam G Ganesh Arizona State University College of Education, Dean's
Office Tempe AZ 86287-0211 ganesh.tg@asu.edu 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Extra FrontPage
http://www.extrafrontpage.com/index.html 
FrontPage Add ins / Add ons  are small programs that simplifies adding functionality to your
WebPages without being an expert. This site has free and cheap add-ins. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://audacity.sourceforge.net/
http://llanes.panam.edu/journal/ejournals.html
mailto:ganesh.tg@asu.edu
http://www.extrafrontpage.com/index.html
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Fagan Finder’s
http://www.faganfinder.com/ 
From the site: “Fagan Finder is a website designed as a tool, to help people find things, and it
is meant to be a gateway to the Internet, a quality home page. Compare this to several
websites. Like a search engine, we have searching capability, but we have many different
searches. Like an exclusive directory, we include searching to or links only to high quality
websites. Like a guide, we try to help you in your search experience.”

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Resources for Improving Writing Skills
http://www.gsu.edu/~accerl/RE.html 

____________________________________________

JUST FOR FUN

If this doesn't make your day nothing will! 
http://www.qnet.com/%7Epontius/smile/smilelmp_1%5B1%5D.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.faganfinder.com/
http://www.gsu.edu/~accerl/RE.html
http://www.qnet.com/%7Epontius/smile/smilelmp_1%5B1%5D.htm
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Using Technology to Improve Counseling

Practice: A Primer for the 21st Century

by J. Michael Tyler and Russell A. Sabella. 

This handbook addresses the implications of

the growing relationship between the

counseling profession and the use of

computers in counseling administration and

practice. Using the 12 Technological

Competencies for Counselors established by

the ACES Technology Interest Network as

their foundation, the authors provide an

overview of current technology as it relates to

practice and training and offer easy-to-

understand, jargon-free applications of

technology. Drs. Tyler and Sabella provide a

bridge for counselors to advance their

technological skills to a level where they can

reap all of the benefits that technology has to

offer, while overcoming the challenges that

computers can create. They include tips on

how to save time and increase efficiency,

automate record keeping, learn computerized

statistical packages and testing and diagnostic

programs, master recording technologies, and

search for reliable information on the

Internet. Ethical and legal issues are explored

in detail, as are electronic counseling services.

Relevant resources, Web sites, and software

designed to enhance the counseling process

are also included in this cutting-edge manual.

2004 275 pages. ISBN 1-55620-227-X. Call

800-422-2648 or purchase online at

http://tinyurl.com/5gux6. Also, see

http://www.21stcenturycounselor.com  for

more information. 

SchoolCounselor.com: #25 - December 6, 2004

The following transcript of an alleged
conversation between a computer user and a
technical help person was circulated over the
Internet a while ago:

Q - "Computer helpdesk; may I help you?"
A - "Yes, well, I'm having trouble with my word
processing program."
Q - "What sort of trouble?"
A - "Well, I was just typing along, and all of a
sudden the words went away."
Q - "Went away?"
A - "They disappeared."
Q - "Hmm." So what does your screen look like
now?"
A - "Nothing."
Q - "Nothing?"
A - "It's blank; it won't accept anything when I
type."
Q - "Are you still inside the program or did you
get out?"
A - "How do I tell?"
Q - "Can you see the C:\ prompt on the screen?"
A - "What's a C:\ prompt?"
Q -"Never mind." Can you move the cursor
around on the screen?"
A - "There isn't any cursor, I told you, it won't
accept anything I type."
Q - "Does your monitor have a power indicator?"
A - "What's a monitor?"
Q - "It's the thing with the screen on it that looks
like a TV." Does it have a little light that tells 
you when it's on?"
A - "I don't know."
Q - "Well, then look on the back of the monitor
and find where the power chord goes into it."
Can you see that?"
A - "Yes, I think so."
Q - "Great." Follow the cord to the plug, and tell me if it's plugged into the wall."
A - "Yes, it is."

http://tinyurl.com/5gux6
http://www.21stcenturycounselor.com
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Q - "When you were behind the monitor, did you notice that there were two cables plugged
into the back of it, not just one?"
A - "No."
Q - "Well, there are — I need you to look back there again and find the other cable."
A - " Okay, here it is."
Q - "Follow it for me, and tell me if it's plugged securely into the back of your computer."
A - "I can't reach."
Q- "Uh huh." Well, can you see if it is?"
A- "No."
Q - "Even if you, maybe, put your knee on something and lean way over?"
A - "Oh, it's not because I don't have the right angle — it's because it's dark."
Q - "Dark?"
A - "Yes - the office light is off, and the only light I have is coming in form the window."
Q - "Well, turn on the office light then."
A - "I can't."
Q - "No?" Why not?"
A - "Because there's a power outage."
Q - "A power..." A power outage?" Aha, Okay, we've got it licked now. Do you still have the
boxes and manuals and packing stuff your computer came in?"
A - "Well, yes, I keep them in the closet."
Q - "Good." Go get them, and unplug your system and pack it up just like it was when you got
it." Then take it back to the store you bought it from."
A - "Really?" Is it that bad?"
Q - "Yes, I'm afraid it is."
A - "Well, all right then, I suppose. "What do I tell them?"
Q - "Tell them you're not ready to own a computer yet."

____________________________________________

FREQUENTLY ASKED QUESTIONS

Microsoft Excel™ is a great tool for counselors when conducting data-driven
decision making or accountability. Here are a few FAQ’s in this area:

Q: How do I calculate a percent change in Microsoft Excel™?

A: Great question! First you need to know the formula for percent change which is (post-pre)
divided by pre-data. So for instance, if student Judy was absent 7 days in quarter 2 and she
was absent 12 days in quarter 1, the percent change is (7-12)/7 = -.714 which translates into a
minus 71% difference. Thus, Judy was present 71% more often in the second quarter than in
the first. 
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In Excel, formulas must begin with either the plus or equal sign (+ or +) so you would input
=(7-12)/7. There are two ways to change the result to percentage format. Either you can just
simple multiply the equation by 100 so it looks like this ((7-12)/7)*100) or you can right click
on the cell, choose Format Cells, Number tab, Percentage. To apply the formatting to multiple
cells, first highlight or block the cells and then do this. To apply to an entire column or row, left
click on the gray part of the column or cell (columns have letters in them and rows have
numbers in them) and then do this procedure. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: How do I manually wrap text in a cell?

Place the cursor after the sentence or words in a cell and press Alt+ Enter. OR, if you don’t like
keyboard shortcuts, highlight the cells you want to wrap, right click on them, choose Format
Cells, Alignment, and check on or off the Wrap Text option.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: How do I add texture to Excel objects like pie slices and chart bars.

A: In Excel 97: 

1. Right-click on the object. 
2. Click Format Data Series. 
3. Click the Patterns tab. 
4. Click the Fill Effects button. 
5. Click the Texture tab. 
6. Make a selection and click OK. 
7. Click OK again to save your settings. 

Also notice that, instead of the Patterns tab, you can choose other fill effects such as gradient
or even add your own photo!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I know that Excel can help me to basic statistical analysis on my data, how do I do this?

A: First, you have to install the little known add-in that comes with Microsoft Excel although is
not automatically installed. Click on Tools, Add-Ins, check Analysis Toolpak, and Okay. You may
need to put your original Microsoft CD in to complete the installation. Once installed, you will
have a new option under the Data menu called Analyze. Check out
http://www-micro.msb.le.ac.uk/1010/toolpak.html for more details. 

http://www-micro.msb.le.ac.uk/1010/toolpak.html
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____________________________________________

TIPS AND TRICKS

Checked the Microsoft clipart gallery lately?
Visit http://tinyurl.com/4gof9 and download one or more of over 140,000 clipart, sounds,
photos, and animations right into your clipart gallery manager (comes with Microsoft Office).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

From PC World Magazine, “Spam-Proof Your In-Box. 
Yes, you can turn the tide against junk e-mail. Our ratings of nine antispam tools reveal a
surprising Best Buy. ”
http://tinyurl.com/59zj3 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Quickly creating a chart in Microsoft Excel 97.
You can quickly create a chart in Microsoft Excel 97 by only a single keystroke. Once you have
the data for your chart ready, select the data, and simply press F11.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

In Microsoft Excel, to quickly select an entire row or column, use the keyboard
shortcuts:

Ctrl + Spacebar  (Select entire column)  
Shift + Spacebar  (Select entire row)  

____________________________________________

WORTHY WEB SITES AND SOFTWARE

AVG Antivirus software (FREE)
AVG Free Edition is the well-known anti-virus protection tool. AVG Free is available
free-of-charge to home users for the life of the product! Rapid virus database updates are
available for the lifetime of the product, thereby providing the high-level of detection capability
that millions of users around the world trust to protect their computers. AVG Free is easy-to-use
and will not slow your system down (low system resource requirements). 
http://free.grisoft.com/freeweb.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/4gof9
http://tinyurl.com/59zj3
http://free.grisoft.com/freeweb.php
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Edupage.
Edupage is a free e-mail service that summarizes
developments in information technology. It is
sent three times a week to subscribers. Where
other EDUCAUSE publications focus primarily on
information technology in higher education,
Edupage offers synopses of a more general
nature, which are extracted from the mainstream
media.
http://www.educause.edu/Edupage/639

~~~~~~~~~~~~~~~~~~~~~~~~~~~

emailSTRIPPER
emailStripper is a free program for cleaning the
">" and other formatting characters out of your emails. It will restore "forwarded" or "replied"
emails back to their original state so they're easier to read.
http://www.papercut.biz/emailStripper.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

OpenOffice.org from OpenOffice.org (Free)
OpenOffice.org is a free suite of office products. It includes word processing, spreadsheet,
presentation and drawing programs. You can open and save in a variety of popular formats --
Microsoft Office, PDF, HTML and others. The programs have the same look and feel as
Microsoft Office, so there's no big learning curve. It's a 63.9 MB file. Dial-up users can expect a
2½-hour download. Broadband users will have to wait about 20 minutes.
http://www.openoffice.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Skype from Skyper Limited (Free)
Skype turns your computer into a virtual telephone through Voice over Internet Protocol
technology. Make free calls to other Skype users anywhere in the world. It allows you to
conference-call up to five people at a time. Set your status to: online, away, not available, do
not disturb, invisible or offline. Skype doubles as an instant messenger.
http://www.skype.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.educause.edu/
http://www.papercut.biz/emailStripper.htm
http://www.openoffice.org/
http://www.skype.com/
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Dr. Russell Sabella is
available for workshops,
presentations, keynotes,
and other speaking
engagements. Workshops
and presentations may last
from several hours to the
span of a course or
institute. Click here to
learn more. 

MiniMinder from Vellosoft (Free)
Remind yourself of important dates with MiniMinder. This small
program reminds you of special events and dates. You can
create weekly, monthly, yearly and one-time-only events.
Schedule reminders. 
http://www.vellosoft.com/miniminder/index.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

QuickZip
Sometimes when you download a free program it comes in a
compressed format such as zip. To open them, you need a
utility like QuickZip. QuickZip helps you shrink very large files
or extract previously zipped files. It can extract 20 different types of archive files. The
documentation is written in broken English but it's good enough to get you going.
http://www.quickzip.org/quickzip/downloads.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

National Center for Missing and Exploited Children
NCMEC was established in 1984 as a private, nonprofit 501©)(3) organization to provide
services nationwide for families and professionals in the prevention of abducted, endangered,
and sexually exploited children. Pursuant to its mission and its congressional mandates.
http://www.missingkids.com 
____________________________________________

JUST FOR FUN

Oreo.com
Games, puzzles, and prizes!
http://www.nabiscoworld.com/oreo/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Trading Spaces
Apply to be on the show.
http://tlc.discovery.com/fansites/tradingspaces/geton/geton.html

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.vellosoft.com/miniminder/index.html
http://www.quickzip.org/quickzip/downloads.php
http://www.missingkids.com
http://www.nabiscoworld.com/oreo/
http://tlc.discovery.com/fansites/tradingspaces/geton/geton.html
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Google.com Catalogs
Get ready for the holiday season by doing some catalog shopping online! Google Catalog
Search applies Google's sophisticated search technology to thousands of scanned mail-order
catalogs, from industrial adhesives to designer clothing and gourmet food. 
http://catalogs.google.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Digital Blasphemy
Very cool computer wallpaper, many of which are free.
http://www.digitalblasphemy.com/ 
____________________________________________

http://catalogs.google.com/
http://www.digitalblasphemy.com/
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SchoolCounselor.com: #26 - December 14, 2004

"A scientific truth does not triumph by convincing its opponents
and making them see the light, but rather because its opponents
eventually die and a new generation grows up that is familiar
with it."  Maxwell Planck

hAS aNYONE sEEN MY cAPSLOCK kEY ?" 

On the negative side, I've been getting charged for a ton of stuff
I didn't order lately. On the positive side, I did win that 'Who's
Got the Best Password' contest on AOL last week.
 - Spike Donner

FREQUENTLY ASKED QUESTIONS 

Q: I can do it in Microsoft Excel, but in Microsoft Word, how do I shade alternate rows in a
table?

A:   Great question ... Here you go:

1. Create your table as you normally would.
2. Place the insertion point somewhere within the table.
3. Choose the Table AutoFormat option from the Table menu. Word displays the Table
AutoFormat dialog box.
4. In the list of available styles, choose one that uses shading on the table rows. Also notice
that you can selectively apply the current style to the header or footer row/column.
5. Click Apply. The format is applied to the table.
6. Close the Table AutoFormat dialog box.

The neat thing about this method is that the shading will adjust even if you add new rows to
the table.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: In Microsoft Excel, how do I set up multipage printouts that repeat the same column
headings on each page. 

A: This is adapted from Take Command: Make Office Work Your Way
 http://www.pcworld.com/howto/article/0,aid,117819,pg,3,00.asp

http://www.pcworld.com/howto/article/0,aid,117819,pg,3,00.asp
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1. Make certain that at least one row in your spreadsheet contains the headings you want to
see on the printout. 

2. Click File, Page Setup, Sheet, and click the Collapse Dialog icon on the right side of the box
marked 'Rows to repeat at top'. Back in your spreadsheet, you'll see that your pointer has
become a right-pointing arrow. 

3. Click and drag that arrow over the rows containing the text that you want to appear as
headings on the printout. 

4. After you make your selection, click the Expand Dialog icon located on the right of the
collapsed dialog box. 

5. Click Print Preview to make sure that your headings look right. If everything appears to be in
order (remember to check page 2), click Print. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: In Microsoft Excel, I can’t insert the current date like I can with Microsoft Word so how do I
do it?

A: Yea, I know, this is a bit weird and frustrating. Normally, you can just click on the Insert
menu and choose Date which is absent from Microsoft Excel™. In Excel, you can do it one of
two ways:

-- use the keyboard shortcut CTRL-; (i.e., hold the CTRL key and press the semi-colon key).
-- insert the formula =today()

~~~~~~~~~~~~~~~~~~~~~~~~~~~

TIPS AND TRICKS

Windows XP Service Pack 2 FAQ from Kim Komando
http://www.komando.com/tips_wxpsp2.asp

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Searching Within a Website Page

(adapted from SchoolCounselor.com: A Friendly and Practical Approach to the World Wide Web,
2  edition). nd

http://www.komando.com/tips_wxpsp2.asp
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Once you have located the web site and the particular page that contains the information you
need, you may find that the page is very long. Instead of reading a long document, you may
want to conduct a page level search using certain keywords. Before  I tell you how to do that,
let's review lest you might get confused. There are three levels of searching: the entire web,
with a website, and within only a particular page within a website. To search a page in Internet
Explorer, click on [Edit] and then [Find (on this page)] or use the keyboard shortcut CTRL-F.
Then simply put in your keywords and press Enter or [Find Next]. Notice that you can check or
uncheck certain options such as to search up the page or down the page. You can also restrict
your search to whole words only and find an exact match which takes into consideration
capitalization.

One example for how this might come in handy is quickly locating the confidentiality part of our
school counseling ethical standards. Once you have located the page
(http://www.schoolcounselor.org/content.asp?contentid=173), do a page search for the word
confidentiality. In fact, you don’t have to finish typing the whole word, just put in confid and it
will still work. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Printing Multiple Pages On One Sheet. 
(Also adapted from SchoolCounselor.com: A Friendly and Practical Approach to the World Wide
Web, 2  edition). nd

To save paper, you may want to print two regular pages onto one 8 ½ x 11 inch sheet (or legal
size for that matter) in the landscape orientation (i.e., on its side). This can be done inside the
printing menu for most printers of today. For example, for me, I press CTRL-P, then Properties,
then Features, then Multiple Pages per Sheets. It may be slightly different for you. This feature
may not be available for older printers. Incidently, some software programs (e.g.,
http://www.fineprint.com) allow you to print actual booklets from your websites. I like using
this feature for my PowerPoint™ handouts. Instead of the standard 3 slides per page with note-
taking lines which is sometimes difficult to read, I usually put 4 full slides per page with frames
which people tell me they like better. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

In Microsoft Word, how can I use the AutoRecover feature to restore a document?
http://kb.indiana.edu/data/ahnd.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

WORTHY WEB SITES AND SOFTWARE

http://www.schoolcounselor.org/content.asp?contentid=173
http://kb.indiana.edu/data/ahnd.html
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Texthelp Systems Inc.
Texthelp systems have a variety of assistive technology software for
people with learning or literacy difficulties. These products are widely
used in the home, in education, government, and business.
http://www.texthelp.com

Similar sites include:

http://www.ataccess.org/ 
http://www.assistivetech.net/
http://www.gusinc.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Stickies 5.0a (free)
Stickies is a PC utility that attempts to cut down on the number of
Post-It® notes that ends up being stuck to one’s monitor. It is a
computerized version of those notes. 
http://www.zhornsoftware.co.uk/stickies/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Thunderbird (free)
From the developers of Mozilla Firefox, Thunderbird makes emailing safer, faster, and easier
than ever before with the industry's best implementations of features such as intelligent spam
filters, built-in RSS reader, quick search, and much more.
http://www.mozilla.org/products/thunderbird/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free History Eraser
How does Free History Eraser help you? The most important is that Free History Eraser protects
YOUR PRIVACY. This cleanup tool dynamically configures itself for Windows 95, 98, NT, ME,
2000, XP. It cleans evidence from multiple user profiles. For intuitive use Free History Eraser
has a Graphical User Interface. The easy access to the functionality simplifies the program use. 
It completely erases Internet History, corresponding index.dat file and URL Autocomplete that
will prevent other people to find out where have you been by typing.
http://smartprotector.com/eraser/free-history-eraser.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Copernic Desktop Search (Free)

http://www.texthelp.com
http://www.ataccess.org/
http://www.assistivetech.net/
http://www.gusinc.com/
http://www.zhornsoftware.co.uk/stickies/
http://www.mozilla.org/products/thunderbird/
http://smartprotector.com/eraser/free-history-eraser.htm
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Copernic Desktop Search allows you to instantly find files, emails, images, multimedia and
more, that is located on your PC (not the Internet). It creates an initial index of your hard drive
and provides an attractive and easy to use search interface that returns results instantly, as
soon as you type in your keyword. It provides image thumbnails for picture matches, integrated
preview with keyword highlighting and more. Copernic Desktop Search can also (optionally)
index your web surfing history, as well as Contacts and Favorites.
http://www.copernic.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

CounselingSurveys.org
This not-for-profit web site was created in order to promote quantitative survey research in the
Counseling profession. Graduate students and professional counselors may use this site to
create surveys for electronic distribution. There are no fees. 
http://www.counselingsurveys.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Singing Fish Search (Audio and Video)
Singingfish.com is the place for consumers to find, explore, and experience the universe of free
media. Unlike traditional search engines, Singingfish only indexes multimedia formats, including
Windows Media, Real, QuickTime, and mp3s. Millions of people use the Singingfish service daily
to search through categories spanning music, news, movies, sports, TV and radio, and finance.
http://search.singingfish.com/ 

JUST FOR FUN

School and Education Cartoons
http://www.offthemark.com/school/school.htm

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Virtual Knee Surgery
Take on the role of the Surgeon throughout a total knee replacement surgery.
http://www.edheads.org/activities/knee/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Rubberstamped Money
Maybe more fascinating than fun although worthy of the list.
http://www.cruelty.com/money/ 

http://www.copernic.com/
http://www.counselingsurveys.org/
http://search.singingfish.com/
http://www.offthemark.com/school/school.htm
http://www.edheads.org/activities/knee/
http://www.cruelty.com/money/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

HP Activity center
Fuel your creative side with hundreds of FREE print projects offered by HP.
http://tinyurl.com/3rtlu 

http://tinyurl.com/3rtlu
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SchoolCounselor.com #27 - December 21, 2004

"Computers in the future may weigh no more than 1.5 tons." (Popular Mechanics, 1949)

FREQUENTLY ASKED QUESTIONS

Q: How do I find video files on the Net?

A: In my workshops, counselors notice that I sometimes insert videos in my PowerPoints,
mostly to emphasize a point by using a bit of humor. The Internet is replete with short (and
long videos) that are free and available for you to use. The trick is locating them. Two search
engines set up specifically to locate vide include:

- Altavista Video Search (http://www.altavista.com/video/default); and
- Yahoo Video Search (http://video.search.yahoo.com/)

They are quite similar although I noticed that Yahoo also gives you links to categories of videos
such as lectures and fighter pilots. Similar to how Google images (http://images.google.com)
helps us locate graphics, these video search engines present a still of the video in thumbnail
format. When you click on a thumbnail, they will usually take you to the website where either
the video begins to play or where there is a link to the video. In this case, Yahoo seems to be a
bit friendlier by providing a “Play the Video” link which goes right to the video file (while
showing you the original web page on the bottom half of a split screen). 

To download the video, you have to find the link for the video, right-click over the link, choose
Save Target As, and then Save. So how do you know if the link you are looking at is a link to a
movie? Two ways. First, a thoughtful website designer will tell you (e.g., “Click here to
download this video.”) Second, when you move your cursor over a link while browsing in
Internet Explorer, you can see the address for the link by looking at the bottom left corner of
your screen. Movie files end in extensions such as wmv, mov, mpg, mpeg, and avi. 

To play the movie, you have to have installed on your computer the appropriate player. I find
that the Windows Media Player can handle just about anything (except QuickTime movies that
end in mov, no surprise there). You can get the Apple QuickTime player at
http://www.apple.com/quicktime/download/.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: In Microsoft® Excel™, how do I quickly move to the last (or first) cell in a range:

A: Using keyboard shortcuts:

• Vertically from top to bottom, press Ctrl+Down Arrow.

http://www.altavista.com/video/default
http://video.search.yahoo.com/
http://images.google.com
http://www.microsoft.com/downloads/search.aspx?displaylang=en&categoryid=4
http://windowsmedia.com/download
http://www.apple.com/quicktime/download
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• Vertically from bottom to top, press Ctrl+Up
Arrow.
• Horizontally from left to right, press Ctrl+Right
Arrow.
• Horizontally from right to left, press Ctrl+Left
Arrow.

Also ...

Pressing the END key followed by the HOME key,
takes you to the bottom right hand corner of the
used area on a sheet. Or, do this by simply
pressing CTRL-END.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: Tammy, a school counselor from Stratford, WI
asks, “I would love to have my own personal
counselor web page, maybe linked off of our
school's home page.  I think it would be a nice
resource for parents, students, staff, and other
counselors.  This would be a great PR piece as well.  I know a project like this can take many
hours of work, what suggestions do you have for getting started? 

A: (Excerpted from the SchoolCounselor.com book, Chapter 5, Counselor as Content Provider):
Great websites, like great pieces of literature, are easy to follow and enjoyable to partake. Both
present ideas and stories that seem simple yet stimulate our resourcefulness and imagination.
For school counselors, a website can eloquently tell a story which informs and engages our
many audiences. Today’s websites are also online tools and systems which can help us to
collaborate, communicate, analyze data, and even deliver interventions. A website can help you
to reach farther in less time by bringing your clients and their care givers to you. The technical
side of a site has all but become a non-issue due to the powerful and user-friendly software
now available to webauthors. Indeed, the hard part is getting the ideas right -- making sure
that the words and pictures on your Website represent the best of what your counseling
program offers. In addition to providing information, creating a counseling website may also
help you to provide students and others with important tools. For instance, one online GPA
Calculator provided by the University of Maryland (http://www.sis.umd.edu/gpacalc/java.html)
allows a student to calculate a list of possibilities for reaching their desired GPA given their
current GPA and number of credits.  Another site (http://cyberguidance.net) allows secondary
students to request a copy of various scholarships by completing an online form. This same site
which was created by Mr. Bob Turba, counselor at Stanton College Preparatory School located
in Duval County, Jacksonville, Florida, has many other tools and ideas for infusing technology
into your school counseling program. I consider it a model site for all school counselors.

http://www.sis.umd.edu/gpacalc/java.html
http://cyberguidance.net


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 45 of 167

To set up your website ....

1. Find yourself a webhost: You can certainly house your site as a subdirectory or subweb of
your schools website. In this case, all you have to do is talk to the school’s website
administrator about setting up (and to review your schools policies regarding the site).
Sometimes, you may want to use a webhost other than your school such as a private web
hosting company. These days, you can take care of securing webhost services and register a
domain name all in one place because most web hosting companies offer domain name
registration services as well (and provide an email system to boot; e.g., I use
http://www.webstrikesolutions.com).  Some companies will actually provide educators with free
web hosting services and also make it easy to publish content. For instance, check out
SchoolNotes (http://www.schoolnotes.com) and GeoCities (http://geocities.yahoo.com/). 

2. Decide on web authoring software: The most popular web authoring products come with site
creation and management tools that allow you to create pages, draw tables, add rich graphics,
and include support for an interactive database. Additionally, leading web authoring programs
allow you to view your site’s navigational structure, directories of information, hyperlinks,
hyperlink status, or all of your files at once. Some also include automatic hyperlink maintenance
which allows you the freedom to make changes without worrying about broken links. With most
programs, too, you can start your page from scratch or begin with one or more of many
professionally designed, customizable templates (e.g., see http://www.steves-templates.com or
http://www.freelayouts.com). Others templates are reasonably priced, about $5-$25 dollars
such as those found at OutFront (http://www.outfront.net). As if it couldn’t get easier, virtually
all webauthoring packages also include thousands of high-quality clip-art images, photographs,
web-art graphics, fonts, animated GIF files, color schemes, and many other design elements to
create publications that reflect your individual needs and personality. I use Microsoft®
FrontPage although others like another leading package called Macromedia® Dreamweaver. A
less known although good editor is The CoffeeCup® HTML Editor
(http://www.coffeecup.com/html-editor/). For Macintosh, try Adobe® GoLive.

As I mentioned, I recommend Microsoft® FrontPage as it is much more user-friendly than the
others. Also, the program is highly supported with tons of free templates, online tutorials (e.g.,
http://www.actden.com/fp2000/java/), and free add-ins (e.g.,
http://www.extrafrontpage.com/). However, the program is a bit quirky and takes some getting
used to. You can get a free instructional book by visiting http://tinyurl.com/4pmqk 

3. Create, develop, have fun, and publish! ... although remember ... Even the best of
webmasters have an advisory group to assist in making important decisions concerning their
site. For those whom are just getting started, it is highly advisable to delegate webauthoring
responsibilities among an established team or committee. Members of your web development
team can write content and assemble photos for the various sections of the site. Luckily, many
schools have computer courses and labs where, as part of their assignment, students can help
design various parts of your site. You might also include talented parents and nearby college

http://www.schoolnotes.com
http://geocities.yahoo.com/
http://www.steves-templates.com
http://www.freelayouts.com
http://www.outfront.net
http://www.coffeecup.com/html-editor/
http://www.actden.com/fp2000/java
http://www.extrafrontpage.com/
http://tinyurl.com/4pmqk
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students who would like to provide a community service. In this instance, you might take the
role of editor: the person who guides others into developing appropriate and fitting material,
makes any needed changes, and integrates the material with the total body of information in a
way that is logical and easy to follow.

NOTES: For details about the Website Development Boot Camp for school counselors, visit
http://tinyurl.com/6fa9p. Also, check out the ASCA Resource Center
(http://www.schoolcounselor.org) for links to school counselors’ websites to get ideas.

TIPS AND TRICKS

Integrate multimedia files into a presentation in Microsoft® PowerPoint
http://www.microsoft.com/Education/MultimediaSlideShow.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft® Excel
Change a plain chart into a fancy pictograph in Excel.
http://www.microsoft.com/Education/CreatePictograph.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

EZANALYZE for Microsoft® Excel
This is a computer program designed to enhance the capabilities of Microsoft® Excel by adding
"point and click" functionality for analyzing data and creating graphs. When you install
EZAnalyze, a new menu is added to Excel. EZAnalyze is an "add in" for Excel, and will not work
unless you have Excel on your computer. Excel is a powerful application for analyzing data - but
also quite difficult to use if you are not familiar with writing formulas. EZAnalyze never requires
you to type in a formula, nor does it require you to know anything about "the math" involved
with the analyses. This permits you to focus your energy on interpreting your results. In my
view, this program is a must-have for every school counselor.
http://ezanalyze.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft® Word
Control the page setup of a Word document so that two pages print on a single sheet of paper.
This is a cool way to print a book of poems, a collection of short stories, a travel guide, and
more. 
http://www.microsoft.com/Education/TipTwoUp.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/6fa9p
http://www.schoolcounselor.org
http://www.microsoft.com/Education/MultimediaSlideShow.aspx
http://www.microsoft.com/Education/CreatePictograph.aspx
http://ezanalyze.com/
http://www.microsoft.com/Education/TipTwoUp.aspx
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Microsoft® Word 2002
Add special effects to text-such as text animation, a
drop cap, or even vertical WordArt-to jazz up a
document. Some special effects will only show up
when you view the document on the screen, while
others will enhance a document when it is printed. 
http://www.microsoft.com/Education/TipSpecialEffect.
aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

In Microsoft® Outlook you can find all related
messages to one that you sent or received relating to
a “conversation.” To do this right click on any
message in your message list and chose Find All >
Related messages. 

WORTHY WEB SITES AND SOFTWARE

ReadPlease (FREE)
Reads any text you see on your screen - all purpose text-to-speech software. 
http://www.readplease.com/english/downloads/#rp2003 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Version 56 of Scholarly Electronic Publishing Bibliography Available 
It's the Scholarly Electronic Publishing Bibliography and it now contains information on over
2,275 articles, books, and other sources related to scholarly electronic publishing efforts online.
The HTML version's at http://info.lib.uh.edu/sepb/sepb.html  and the PDF version's at 
http://info.lib.uh.edu/sepb/sepb.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Distortit (FREE)
A simple image morphing tool, that allows you to create funny variations of pictures by applying
magnification effects to selected areas. You can select the level of magnification and simply
click your mouse to apply the effect. With some imagination and suitable images, you can
create some funny effects and save the new image as BMP or JPG file.
http://tinyurl.com/6toob 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.microsoft.com/Education/TipSpecialEffect.aspx
http://www.microsoft.com/Education/TipSpecialEffect.aspx
http://www.microsoft.com/Education/TipSpecialEffect.aspx
http://www.readplease.com/english/downloads/#rp2003
http://info.lib.uh.edu/sepb/sepb.html
http://info.lib.uh.edu/sepb/sepb.pdf
http://tinyurl.com/6toob
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The Journal of Virtual Environments
http://www.brandeis.edu/pubs/jove/index.html 

Also, see References Related to the Internet & Psychology 
http://construct.haifa.ac.il/~azy/refindx.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Become a Bounce Back Kid (Book)
http://www.angriesout.com/bounceback/bbkid3.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Sample of the book: F1 Get the Most out of Excel!
The Ultimate Excel Tip Help Guide (Free PDF)
http://www.exceltip.com/download/F1eBookSample.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

MSN Family
http://www.family.msn.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Tip Sheet (PDF)
http://www.bu.edu/celop/mll/tutorials/pdf_public/Google_tips.pdf 

JUST FOR FUN

Crazy Pinball (SWF)
In Internet Explorer, press F11 to open up your window before you start playing this one. 
http://www.theplaystation.org/home/arcade/crazyball/pinball003.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Just for Fun Tests
A whole new kind of Mini-Test! Entertaining yet revealing, the Just-For-Fun Tests give you a
quick glimpse into your psyche, sense of right and wrong, and personal quirks. 
http://www.queendom.com/tests/minitests/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.brandeis.edu/pubs/jove/index.html
http://construct.haifa.ac.il/~azy/refindx.htm
http://www.angriesout.com/bounceback/bbkid3.swf
http://www.exceltip.com/download/F1eBookSample.pdf
http://www.family.msn.com/
http://www.bu.edu/celop/mll/tutorials/pdf_public/Google_tips.pdf 
http://www.queendom.com/tests/minitests/
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Play Tic-Tac-Toe with Abdallah (SWF)
http://64.226.102.49/tictacto.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Can you operate a helicopter? (SWF)
http://www.hurtwood.demon.co.uk/Fun/copter.swf 

http://64.226.102.49/tictacto.swf
http://www.hurtwood.demon.co.uk/Fun/copter.swf
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SchoolCounselor.com #28 - January 1, 2005

HAPPY NEW YEAR!!  HAPPY NEW YEAR!!  HAPPY NEW YEAR!!  HAPPY NEW
YEAR!!  HAPPY NEW YEAR!!  HAPPY NEW YEAR!!  HAPPY NEW YEAR!! 
HAPPY NEW YEAR!!  HAPPY NEW YEAR!!  HAPPY NEW YEAR!! 
HAPPY NEW YEAR!!  HAPPY NEW YEAR!!  HAPPY NEW
YEAR!!

Do you have a counseling technology related question? Or
maybe you have discovered a technological shortcut, tip, or trick that
has helped you to be more effective and efficient in your work. Send
your questions and tips for possible inclusion in future publications of this newsletter via email
at newsletter@schoolcounselor.com 
____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: When I open up a new browser window in Internet Explorer, I would like it to automatically
maximize on opening (instead of getting a postage-sized window that I can’t see). Is there an
easy way to do this?

A: I feel your pain ... Clicking the maximize button works but the next time you open IE, you’re
back to where you started. Here is what I’ve discovered: The default behavior for Internet
Explorer is to open at the same size it was at the last time it was closed. While the default does
apply in many cases it's not always consistent. So ... Open a single Internet Explorer window to
the smaller size.  Drag the corners of the window until it completely fills the screen. Do not use
the maximize button to enlarge the window. Then exit by clicking on the File menu and then
Exit or Close (not the"X" in the upper right corner to close the window). Internet Explorer
should now open in a full window. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: You have recommended the Internet Filter called CyberSitter (http://www.cybersitter.com)
for Windows although I have a Macintosh. Any recommendations?

A: I never recommend anything that I don’t try myself. I don’t use Macintosh so I don’t have
any recommendations although here are a couple that others seem to find very useful:

- ContentBarrier by Intego (http://www.intego.com/);
- Kids GoGoGo by MAKI Enterprise Inc.
(http://www.makienterprise.com/kggg/kidsgogogo.html).

mailto:newsletter@schoolcounselor.com
http://www.cybersitter.com
http://www.intego.com/
http://www.makienterprise.com/kggg/kidsgogogo.html


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 51 of 167

Also, BumperCar is a Mac OS X Web browser for kids. It offers content control and
customization features, making it the most powerful Web browser for concerned educators and
parents on the Macintosh. http://www.freeverse.com/bumpercar/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: How do I quickly print sheets of return address labels in Microsoft Word?

A: Good question, I find that it is cheaper to buy blank address labels and print these myself as
compared to buying commercial labels or even an ink stamp (I find good deals on blank labels
at ebay.com by using keywords such as Avery label). 

1. Go to the Tools Menu and click on Envelopes and Labels. (In Word 2003, select Letters and
Mailings from the Tools menu, then choose Envelopes and Labels; Make sure the Labels tab is
selected so you see the Label Menu).

2. Make sure you have selected the correct label type (e.g., Avery 5160). If you need to change
the type of labels on which you are printing, click on the Options button and use the Labels
Options dialog box to select the right type of label). 

3. In the Envelopes and Labels dialog box, make sure the Use Return Address check box is
selected. Your return address should appear in the Address area of the dialog box. If not, then
type it in. 

4. Insert your label sheet in the printer and print. 

Note: If your return address does not appear in step 4, then you may not have set it up in
Word. You can set up your return address by following these steps:

1. Click on the Tools menu and choose Options.
2. Click on the User Information tab. 
3. In the Mailing List area of the dialog box, make sure your name and correct mailing address
appears and click on OK.

TIPS AND TRICKS

Closing Multiple Windows in Internet Explorer.
If you go to web sites that open up multiple windows, 
Pressing the Ctrl-W keys seems to work (as does Alt-F4)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.freeverse.com/bumpercar/
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Automatically Empty Temporary Internet Files in Internet Explorer
To have the Internet Explorer automatically delete files in the Temporary Internet Files folder
(which makes it more difficult for others to see where you have been; also see
http://windows.about.com/library/blietracks1.htm; for the Macintosh, visit
http://www.allume.com/mac/iclean/):

1. Click on Tools / Internet Options 
2. Click on the Advanced tab 
3. Scroll down to the Security section 
4. Check Empty Temporary Internet Files folder when browser is closed 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Moving Backward or Forward with the Wheel Mouse
You can rapidly go Backward or Forward in your IE Browser by holding down the Shift key
while moving the mouse wheel. This saves moving your mouse up and clicking on the Back or
Forward buttons. Most folks already know the keyboard shortcuts by holding down the Alt key
and hitting the left and right cursor keys to effect the same thing. Also, did you know that
pressing the Home key will take you to the beginning of a web page. The End key will take you
to the bottom!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Outlook 2000 Add-in: Holiday Updates
The holidays list, included with the Microsoft Outlook 2000 calendar, will expire at the end of
2002. This add-in updates the calendar with holidays spanning 2003 to 2007.
http://tinyurl.com/3yrv 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Adobe Reader SpeedUp (free)
A simple application that was created to help make the loading time of Adobe's Acrobat/Reader
software bearable for everyday use. AR SpeedUp only needs to be used once (a process taking
only a few seconds) and then your 'Reader will be transformed forever. I want to warn you,
however, that when you use this, you will not be able to use PDF forms (the kind that you fill in
and print). 
http://www.majorgeeks.com/download4139.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/3yrv
http://www.majorgeeks.com/download4139.html
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Opening Multiple Windows in Outlook
If you want to have multiple windows open in Outlook (e.g., Inbox and Calendar), right-click on
the new item and select Open in New Window. This makes it a lot easier to cut and paste
between Outlook applications.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Changing the Number of Days Displayed in Outlook Calendar
When in Outlook's Calendar program with Day View, to change the number of days shown. For
example press Alt along with the number of days you want to see (e.g., Alt-4 will give you a
view spanning 4 days; Alt-M gives you a month).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Moving Files and Settings to a New PC (you might try the following based on good reviews
published in various places on the Net):
http://tinyurl.com/5emv8 
http://tinyurl.com/6lk7r 

Some higher end software for completing this task:

- Move Me (http://www.spearit.com; $39.95)
- IntelliMover (http://www.detto.com/intellimover; $49.95)
- Desktop DNA Professional (http://ca.miramar.com; $39)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

How to Target a New Browser Window with a Hover Button 
adapted from FrontPage Tips 0323 - June 25, 2003
http://www.at-frontpage.com/2000/tips_hoverbuttontarget.htm 

The Hover buttons in FrontPage are technically Java Applets, so having a URL target a new
browser window must be done within the applet code. When you create a hover button in
FrontPage and add a URL hyperlink, FrontPage creates the <applet> tags for you and inserts
the necessary <parameter> tag within the <applet> tag for the URL. If you want your URL to
target a new browser window, you will have to add a parameter tag to the HTML manually,
here's how: 

- Select the hover button in normal view by clicking once on the hover button 
- Click the HTML tab to view the HTML code (the applet code for the selected hover button will
be highlighted in blue for you in the HTML view) 
- Under the 
<param name="url" valuetype="ref" value="http://www.yoururl.com"> 

http://tinyurl.com/5emv8
http://tinyurl.com/6lk7r
http://www.spearit.com
http://www.detto.com/intellimover
http://ca.miramar.com
http://www.at-frontpage.com/2000/tips_hoverbuttontarget.htm
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tag add the target parameter code/tag: 

<param name="target" value="_blank"> 
When you save the page and view it in a browser, your hyperlinked hover button will now open
the target hyperlink in a new browser window. 

WORTHY WEBSITES AND SOFTWARE

Web Wise Kids are a non-profit organization dedicated to ensuring child internet safety by
giving tips and advice to parents and children on how to protect themselves from online
predators. They are distributing a free program called “Missing” teaches students about internet
predators and the online dangers of kidnaping, sex abuse, and child pornography. 
http://www.webwisekids.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Picsearch is a search engine for pictures and images and has many features which make it
unique. It has a relevancy unrivaled on the web due to it's patent-pending indexing algorithms.
Also, Picsearch has a family friendliness that allows children to surf in safety as all offensive
material is filtered out by our advanced filtering systems. The site is also very user friendly as
it's designed to be both simple, fast and accurate. Due to all of these features, Picsearch is
perfect for fun, school, business and family! Picsearch is of course free to use and can be
utilized from either www.picsearch.com or from licensing partners' sites. Easy way to find only
animated graphics!
http://www.picsearch.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Center for the Study of Technology in Counseling and Career Development
The Center for the Study of Technology in Counseling and Career Development (the Tech
Center) was established to assist practitioners, researchers, software developers, and policy
makers in improving the design and use of computer applications in counseling and career
development. The Center also assists practitioners, researchers, and policy makers in improving
the cost-effectiveness of career services. Our Web site expands this mission to include serving
individuals and students interested in career development and computer technology. 
http://www.career.fsu.edu/techcenter/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Office 2000 Tutorials from FGCU
http://www.fgcu.edu/support/office2000/ 

http://www.webwisekids.com/
http://www.picsearch.com/
http://www.career.fsu.edu/techcenter/
http://www.fgcu.edu/support/office2000/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Student Technology Competencies for School Counseling Programs
This article briefly reviews the growth of technology and the development of standards related
to technology in counseling, Pre-K-12 education, educator preparation programs, and the field
of school counseling. The development of pre-admission and program outcome technology
skills at Indiana State University is discussed along with the specific competencies. Finally,
informal observations of associated successes and challenges are shared. 
http://jtc.colstate.edu/vol2_2/hines/hines.htm 

JUST FOR FUN

Computer Hall of Fame
Cool reading ... Each year, the Hall of Fame Committee selects new members to the Hall of
Fame from a final slate selected by the membership of the Computer Museum of America.
Museum members vote from a list of nominees submitted by themselves, industry leaders and
the general public. 
http://www.computerhalloffame.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

"How Gullible Are We?", involved presenting a report about "the dangers of dihyrogen
monoxide" to fifty ninth-grade students and asking them what (if anything) should be done
about the chemical. Forty-three students favored banning it, six were undecided, and only one
correctly recognized that 'dihydrogen monoxide' is actually H2O — plain old water.
http://www.dhmo.org/ 
http://www.snopes.com/toxins/dhmo.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Smileys from Google Images
http://tinyurl.com/5fdc4 

____________________________________________

http://jtc.colstate.edu/vol2_2/hines/hines.htm
http://www.computerhalloffame.org/
http://www.dhmo.org/
http://www.snopes.com/toxins/dhmo.htm
http://www.aath.org/readlist_1.html
http://tinyurl.com/5fdc4
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Inkjet Cartridges
and Printer Ink
SchoolCounselor.com
has partnered with
Inksell.com to offer
you excellent prices on
Inkjet Cartridges and
Printer Ink. Click here
to search for your
make and model. 

SchoolCounselor.com: #29 - January 10, 2005

A bus station is where a bus stops. A train station is where a train
stops. On my desk I have a work station…  
-- Unknown

Bugs are Sons of Glitches!  
-- Unknown 

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: A counselor writes, “I am proud about how I have been able to
do more work in the area of accountability in my work. I’ve used data to detect student
needs/achievement gaps, developed appropriate and comprehensive interventions, and
collected follow-up (post) data. I have also taken on a more long-term project regarding school
safety. I do monthly reports to our principal and superintendent using PowerPoint. The
slideshow includes various graphs created from data I have stored in an Excel spreadsheet. It
takes a great deal of time to create new charts from the updated data, copy them, and then
paste them into each PowerPoint slide every month. Is there a better way to do this?”

A: First I want to say great job on using data both for developing your counseling action plan
and accountability! Indeed, there is a relatively easy way to automate the process you describe.
The key is to insert the charts that you produce in Excel into PowerPoint, NOT as a straight
copy and paste, but as an object link. It’s surprisingly simple:

1. After you create the chart in Excel, copy it into memory as you normal do (e.g., Edit, Copy or
CTRL-C).
2. Go over to PowerPoint. Now instead of pasting it, go to Edit and choose Paste Special.
3. Now the most important ... click the button that says Past link (instead of just Paste which is
actually the default). 
4. Click okay.

Now, every time you open that PowerPoint file, you will be asked if you want to update all your
links, click Yes. All of your charts should automatically be updated. Note, however, that this
only works if the data file is in the same location as it was when the link was established so
don’t move the file after you set up the link. Also, know that this same procedure works
between other Microsoft Office™ applications such as Excel and Word. It might also be helpful
for you to know that after you link the files, you can open the Excel data by clicking on the
chart in PowerPoint!

http://service.bfast.com/bfast/click?bfmid=37923589&siteid=41504850&bfpage=main
http://service.bfast.com/bfast/click?bfmid=37923589&siteid=41504850&bfpage=main
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By the way, have you thought about setting up the PowerPoint as a self-running, narrated file?
In other words, your administrators can click on the file and just sit back and watch/listen.
There is a nice tutorial for doing this located at http://www.iddl.vt.edu/instructors/powerpoint.
If you mess up. You can press the Escape key and start narrating again from that slide. That is,
when you click on the Narrate menu and PowerPoint detects that you are not at the beginning
of the show, it will ask you if you want to start over or begin from the current slide, pick the
current slide. After you finish narrating, go to File and then Save As. Save the file as a
PowerPoint Show (pps). 

____________________________________________

Q: My printer prints pages in the reverse order. I am tired of telling it to begin with page 1
every time. Is there a way to set this up automatically?  

A: Yes indeed. Go to [START] in the left bottom corner, then [Control Panel], then [Printers and
Faxes]. Then, right click over your printer icon and select [Properties]. This opens the menu for
that printer. Tab through each category of menu items to find the selection for "ordered
printing" or "reverse printing" as it is usually called.

____________________________________________

TIPS AND TRICKS

Disable Indexing Service (source:
http://mywebpages.comcast.net/SupportCD/OptimizeXP.html) 
The Indexing Service in Windows XP indexes your files presumably to shorten the time needed
to search your hard drive if you are looking for a specific file or part of a phrase inside a file.
However, the constant indexing of files actually slows down system performance. Indexing
searching performance benefits would only be noticeable on a file server not a home PC.
Instructions - To disable the Indexing Service go into "My Computer", right-click on all your
hard drive partitions one at a time, left-click "Properties". Uncheck "Allow Indexing Service to
index this disk for fast file searching". Select "Apply changes to subfolders and files". If any files
can not be updated select "Ignore All".

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HIDDEN TREASURES - UNCOVER FIVE NEW WAYS TO USE GOOGLE
Google does lots of little tricks. You probably know already that you can enter ticker symbols to
get links to stock quotes, street addresses to get links to maps and numeric expressions to use
Google as a calculator. Here are a few new features that you might not have tried yet.

http://www.iddl.vt.edu/instructors/powerpoint
http://mywebpages.comcast.net/SupportCD/OptimizeXP.html)
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* Area Codes
With the proliferation of U.S. area codes, it's not easy to figure out who's calling from where
these days. Now you can enter a 3-digit U.S. area code into any Google search box for a link to
a map of that area code's location. 

Example:  http://www.google.com/search?q=650 

* Universal Product Codes (UPC)
Is your checkout scanner on the fritz? Find out more about a product by entering its UPC code
into the Google search box. The UPC code is the number on the bottom of the zebra striped bar
code displayed on most product packages. 

Example:  http://www.google.com/search?q=073333531084 

* Flight tracking
Attention, travelers (and those picking you up): find the status of a U.S. flight without delay.
Just type a flight number into the Google search box (for example, USAir 50) to see a direct link
to that flight's status information. 

Example: http://www.google.com/search?q=usair+50 

* Vehicle ID (VIN) numbers
Want to learn a little more about that car you're about to buy? Check the Vehicle Identification
Number (VIN), then type it into Google for a link to a page with more information about the
year, make and model of a specific car. 
 
* Package tracker 
Eager to find out what happened to that fruitcake you ordered last December? Enter a tracking
number for any package from UPS, Federal Express, or the U.S. Postal Service in any Google
search box and you'll see a direct link to information about the delivery status of that package.

Learn more at http://www.google.com/help/features.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google FAQ

Some very diligent and focused individuals have created a FAQ based on questions that
frequently appear in the google.public.support.general newsgroup. Very impressive!
http://www.geocities.com/googlepubsupgenfaq/ 

WORTHY WEBSITES AND SOFTWARE

http://www.google.com/search?q=650
http://www.google.com/search?q=073333531084
http://www.google.com/search?q=usair+50
http://www.google.com/help/features.html
http://www.geocities.com/googlepubsupgenfaq/


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 59 of 167

avast! 4 Home Edition is a full-featured (free) antivirus package designed exclusively for
home users, non-commercial users. 
http://www.avast.com/eng/avast_4_home.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free 2005 Calendar Templates from Microsoft
http://tinyurl.com/4l33v 
Also, tons more templates at http://office.microsoft.com/en-us/templates/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Yahooligans!
Parents will sometimes try to find safe locations for their children to reside at on the Web, but
this can be a challenge. On the upside, Yahoo! has pooled its resources together to build a
kid-friendly portal called Yahooligans!.
http://yahooligans.yahoo.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Answers.com
A “super-encyclopedia” that gives you quick facts—not hundreds of search engine links.
http://www.answers.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Object Graph
A really cool dictionary that is tough to describe ... the interface provides potential words and 
phrases depending on what you type into the query box. There are two dictionaries being used
here; a regular dictionary (default) and FOLDOC (Free On-Line Dictionary of Computing.) 
http://www.objectgraph.com/dictionary/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

JUST FOR FUN

Lake Superior State University
2005 List of Banished Words
http://www.lssu.edu/banished/current.php 
(posters of previous lists available too at http://tinyurl.com/4udmc)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.avast.com/eng/avast_4_home.html
http://tinyurl.com/4l33v
http://yahooligans.yahoo.com/
http://www.answers.com/
http://www.objectgraph.com/dictionary/
http://www.lssu.edu/banished/current.php
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Great selection of computer wallpapers.
http://wallpaper.net.au/index.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://wallpaper.net.au/index.php
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SchoolCounselor.com: #30 - January 30, 2005

Students today depend upon paper too much. They
don't know how to write on slate without getting chalk
dust all over themselves. They can't clean a slate
properly. What will they do when they run out of
paper? Principal's Association, 1815 

"There are two major products to come out of
Berkeley: LSD and UNIX. This is probably not a
coincidence." -- John Dodge, PC Week

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: Sometimes I need to send an email to a group of people. Their individual email addresses
are listed on a web page, Word document, spreadsheet, or something similar. Instead of
picking them out one at a time, is there a way to somehow take the email addresses out of a
document, web page, spreadsheet, etc., automatically?

A: Your question is an exciting one for me as it underscores the importance of technological
literacy among counselors -- so that we can do our work more effectively and efficiently. Yes,
you can automatically extract email addresses from a document, and it’s not that difficult
thanks to some very clever people out there. The trick is having a piece of software or
computer code that recognizes and “parses” addresses. I’ve been using a free one called Email
Extractor Lite that can parse either email or web site addresses (available at
http://www.surf7.net/download/extractor.shtml; I put a copy of it for easy access at
http://coe.fgcu.edu/faculty/sabella/extractor.htm). Here’s how it works:

1. Copy all text from any webpages, documents, files, etc... (CTRL-A or Edit, then Select All)
2. Paste it into Input Window.
3. Click "Extract" button.
4. Copy the result from Output Window to somewhere and save it. Click "Reset" button to start
all over again.

Email Extractor Lite also removes duplicates and allows you to sort the addresses
alphabetically.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: How do I add text to a chart that I produced in Microsoft Excel™

http://www.surf7.net/download/extractor.shtml
http://coe.fgcu.edu/faculty/sabella/extractor.htm
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A: There is a quick way to do this:

1. Click anywhere within the chart except a chart title or data label.
2. In the formula bar, type the text you want to appear in the text box, and press [Enter]. A
text box containing the text you entered will appear in the middle of the chart.
3. Move the text box to the desired position in the chart.
4. Double-click the text box to open the Format Text Box dialog box.
5. Add the desired formatting, and click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I use Microsoft Outlook for email, calendar, tasks, and notes. I can’t find an easy way to
send someone contact information for someone in my contact list. I end up having to copy and
paste each field (name, address, state, zip, phone, email, etc.) into an email which takes
forever. There must be an easier way.

A: Sure. There are two ways to do this. The first way is easiest if you are sure that your
recipient is also using Outlook. If you have contacts stored in Outlook that you'd like to send to
other people, just go to your Contacts folder, right-click on the contact you want to send, and
then click Forward. A new e-mail message will be created with that contact included as an
attachment. Just enter the e-mail address of the people you want to forward it to and click
Send. When the recipients receive the contact, all they have to do is to drag the attachment
onto either the Contacts icon in the Outlook Shortcuts bar or onto the Contacts folder in the
folder list; it will be added automatically to their contacts list. 

If the recipient does not use Microsoft™ Outlook, then open a new e-mail, click Insert on the
menu, then Item, navigate over to Contacts, choose the contact you want to forward, make
sure Insert as Text Only is turned on, click Okay. The contact info will be pasted into your email
as text. A big time saver. 

On a similar note, I have discovered quite a gem of a program that is relatively inexpensive and
has saved me tons of time with entering both calendar and contact information. It’s called
anagram (http://getanagram.com). anagram™ is a tiny and unobtrusive program for your PC
that stays out of your way while you work, but is available at a single keypress when needed.
The program instantly and intelligently translates the meaningful text from any application into
Outlook® Contact, Calendar, Task and Note items (that’s right, you just highlight the text and
anagram figures out what it is and then puts it in the right place). 

So, when it’s time for me to enter an event, contact, tasks, or note, I just highlight the text
describing an upcoming meeting, change of address, or something to do found in an e-mail,
website, or other application. Then I hit a user-defined shortcut key to capture the selected
text. Anagram places each item in the proper field. Then I just click Save and Close to add to
your Outlook® immediately. Another nice thing about this program is that it puts a new menu

http://getanagram.com
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item in Outlook that quickly solves the problem of copying contact or calendar info to send to
someone. 

TIPS AND TRICKS

Create a custom chart type in Excel
You’ve just created a chart just the way you want it with certain textures and other attributes.
It took a few minutes and you don’t wish to have to customize future charts in the same way.
Wouldn’t it be great if you could automatically just replicate the current chart type for new
charts? There is a way ... If you need to create a number of charts based on the existing
format, creating a user-defined chart type is more efficient.

Follow these steps:

   1. Select the existing chart whose format you want to use.
   2. Go to Chart, Chart Type.
   3. On the Custom Types tab, select User-defined.
   4. Click the Add button, and enter a name for your new chart type.

The next time you use the Chart Wizard to create a chart, you'll be able to select your new
custom chart type from the list of user-defined chart types on the Custom Types tab. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft™ Excel
To change selected cells to the percent format without decimal places, highlight the cells and
press CTRL+SHIFT+%. So, for instance, if you did a calculation such as percent change and
the result was .2134, selecting the cell and pressing CTRL+SHIFT+% will change it to the
appropriate 21%. You can do this for multiple highlighted cells. Remember, if you need to
highlight an entire column, click on the column letter (in grey above row 1). Similarly, you can
change a cell or row/column of cells to monetary format by using CTRL+SHIFT+$.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word: Quickly return to the location of the last edit
When you need to review the last edit made to a very large document, you can scroll, read,
and scroll some more through the entire document to find it. However, Microsoft™ Word
automatically remembers the last three places where you've entered or modified text. So, to
return to the location of your last edit, press [Shift][F5]. Word moves the cursor to that
location. 
____________________________________________

WORTHY WEBSITES AND SOFTWARE
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Microsoft Office Education Templates
Categories include Back to School, For Teachers
(Lesson Materials | Classroom Management | Awards
| More... ), For Parents (Letters to School | Planning
for College ), For Students (Study Aids | Papers,
Reports, and Presentations | Schedules and Planners
| More... ), and For Administrators.
http://tinyurl.com/43h8p 

Also, ton more for Macintosh (although they work
for Windows) at http://tinyurl.com/4hoqu 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Bookmarklets for Zapping Annoyances
These bookmarklets help you deal with annoying
web pages.
http://www.squarefree.com/bookmarklets/zap.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Find and enjoy the pictures on your computer
in seconds.
A free software download from Google. Picasa2 is software that helps you instantly find, edit
and share all the pictures on your PC. Every time you open Picasa, it automatically locates all
your pictures (even ones you forgot you had) and sorts them into visual albums organized by
date with folder names you know. You can drag and drop to arrange your albums and make
labels to create new groups. Picasa makes sure your pictures are always organized. 
http://www.picasa.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Actress Kate Mulgrew joins with WAMC to bring women's achievements in science and
technology to the airwaves.

Did you know that the technology that operates your cell phone was designed by a silver
screen goddess in the 1940's?  Or, that the first computer programmer was actually the
daughter of a racy 18th Century English poet?  Want to learn what today's women pioneers in
science and technology are doing to encourage the next generation? WAMC Northeast Public
Radio's nationally-syndicated radio programs, 51% (about women and issues affecting them)
and The Best of Our Knowledge (about education and educational policy) bring you the true
stories of pioneering female scientists from ancient Greece to current times in the radio series

http://tinyurl.com/43h8p
http://tinyurl.com/4hoqu
http://www.squarefree.com/bookmarklets/zap.html
http://www.picasa.com/
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HER-STORY: Women Pioneers in Science, Technology, Engineering and Mathematics-THEN and
NOW.  Funded by the National Science Foundation, the full series is now available for listening
on-line at www.womeninscience.org 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

JUST FOR FUN

Exactly how old are you – age calculator
http://www.agsnet.com/calc/AgeCalculator.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Shopzilla
With more than 25 million products from over 45,000 stores on our site, if it's on the Web, it's
on Shopzilla. From air conditioners to zebra tights, whatever you're shopping for, we've got you
covered.
http://www.shopzilla.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Bloggernity
This site is a searchable subject index of 'blogs from Art and Photography Blogs to Writers
Blogs (and there's at least one category here that's not safe for work, so be warned.)
http://www.bloggernity.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

woot
woot.com is an online store and community run by the employees of a 10 year old consumer
electronics distributor that focuses on close-outs and generally buying stuff cheap. These guys
sell only 1 item per day until it is sold out or until 11:59pm central time when it is replaced.
However, each item we sell is in stock and ready to ship that day. 
http://www.woot.com/ 

http://www.womeninscience.org
http://www.agsnet.com/calc/AgeCalculator.html
http://www.shopzilla.com/
http://www.bloggernity.com/
http://www.woot.com/
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Confronting Sexual
Harassment: Learning
Activities for Teens.
by Russell A. Sabella and
Robert D. Myrick
Help your students from
ages 12 to 18 to develop
positive personal
relationships and confront
the troublesome area of
sexual harassment. The
eight group sessions, 27
supplementary activities, and
reproducible activity sheets
can be used with individuals,
small groups, and
classrooms.

SchoolCounselor.com: #31 - February 15, 2005

I don't know what apathy is and I don't care! – Anonymous

If at first it doesn't work, REBOOT! – Anonymous

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: Can I print more than one document at a time?

Printing a number of MS Word™ documents can easily
become frustrating. Instead of opening each file and printing
individually, use the folder list to print them all at once.

Follow these steps:

1. Open the folder that contains the Word documents you
want to print.
2. Press [Ctrl], and select the files you want to print. (If the
files are adjacent, select the first file in the list, press [Shift],
and select the last file in the list.)
3. Right-click the selection, and select Print from the shortcut
menu.
4. Select the desired print options, and click OK. (The
selected options will apply to all of the documents.)

Word will print the files in the order they appear in the
folder. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: Is there a quick way to automatically have Microsoft Word™ type out frequent such as the
name of my school or my name and address?

A: Most word processors today can do this with ease. There are several ways to go about it –
first I’ll show you a quick solution that uses a neat Microsoft Word™ feature called AutoText.
Follow these directions:

1. Click on Tools and then AutoCorrect Option.
2. Click the AutoText tab.

http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=CSH&Category_Code=
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=CSH&Category_Code=
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=CSH&Category_Code=
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3. Enter a phrase that you type out frequently such as the name of your school or organization
(e.g., Florida Gulf Coast University or American School Counselor Association). 
4. Click on Add.

You can do this for as many phrases as you like. After you close the window and begin to type
these phrases in your document, MS Word will detect the phrase and, in a dialogue window,
ask you to press Enter to complete it (or TAB in earlier versions of MS Word™). What you also
might consider is putting these on the Toolbar menu for easy access (Click on View, Toolbars,
and then choose AutoText). Now you will see a dropdown menu of all kinds of phrase
shortcuts. The phrases that you added will be in the “Normal” category. For a graphical tutorial
that will help you to use AutoText, visit http://www.evisa.com/e/sbooks/lib10/s27/slide01.htm.
It really is a big-time saver!

To automatically insert more than just a phrase, you might want to create a macro. A macro is 
an action or a set of actions you can use to automate tasks. In other words, it’s a tiny program
inside the word processor that can record what you do and play it back by using a keyboard
combination. So, for instance, if you never want to type your name and address on a letter or
envelope again, record yourself doing it for the last time using a macro. Then in the future, all
you have to do is play the macro. To record a macro:

1.  On the Tools menu, point to Macro, and then click Record New Macro. 
2.  In the Macro name box, type a name for the macro. 
3.  In the Store macro in box, click the template or document in which you want to store the
macro. 

4.  In the Description box, type a description for the macro. 

5. If you don't want to assign the macro to a toolbar, a menu, or shortcut keys, click OK to
begin recording the macro. To assign the macro to a toolbar or menu, click Toolbars, and then
click the Commands tab. In the Commands box, click the macro you are recording, and drag it
to the toolbar or menu you want to assign it to. Click Close to begin recording the macro.  To
assign the macro to shortcut keys (my favorite), click Keyboard. In the Commands box, click
the macro you are recording. In the Press new shortcut key box, type the key sequence, and
then click Assign. Click Close to begin recording the macro.

6. Perform the actions you want to include in your macro. When you record a macro, you can
use the mouse to click commands and options, but not to select text. You must use the
keyboard to record these actions. For example, you can use F8 to select text and press END to
move the cursor to the end of the line. 

7. To stop recording your macro, click Stop Recording. 

http://www.evisa.com/e/sbooks/lib10/s27/slide01.htm
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I use macros to automate all kinds of tasks, maybe one or two will give you some ideas:

- close my letters with a closing and including my digitized signature (for big mail outs)
- make text centered and large 
- call up my fax template so I can quickly type up a fax cover
- call up my memorandum template
- call up my resume which I refer to frequently
- take text in memory (after highlighting it and copying it) and put it in a header while also
including page numbers as a footer
- type out my address and/or email address
- Highlight a block of text using the highlighter
- capitalize the first letter of each word in a sentence (for titles)
- take a list of words or phrases, alphabetize, and separate by alphabet headers (such as a
phone directory)
- reverse letters in a text box (that is, the letters are white and the background becomes black)
so they really stand out

____________________________________________

TIPS AND TRICKS

PowerPoint: Save Your Fonts with Your Presentation
Ever notice that when your PowerPoint is viewed on someone else’s computer, the fonts are all
different? To prevent this from happening, click on File, then Save As, the Tools button
(normally located on the upper right of your screen), and Save Options. Finally, check the
Embed TrueType Fonts option. If I remember correctly, older versions of PowerPoint (circa
2000) have this option right below the file name area.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Using Ctrl-Drag to Copy
You can quickly make a copy of any object by holding down the CTRL key while you drag on
the object.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Easily Changing from Caps to Lower Case (or Vice Versa)
I’ve mentioned this one once before although its worth mentioning once more time ... If you
have text that is in the wrong case, select the text, and then click Shift+F3 until it changes to
the case style that you like. Clicking Shift+F3 toggles the text case between ALL CAPS, lower
case, and Initial Capital styles. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Nudging Objects (any of the Microsoft applications)
You can use the arrow keys to move objects very small distances. This is a big win for those
laptop users who no longer have mice. Select the object, then use your arrow keys. Each press
of the key will move the object on "grid unit" (1/12th of an inch, don't ask why); if you hold
down the ALT key while nudging, or if you have the grid turned off, you can move the objects
one pixel at a time.
____________________________________________

WORTHY WEBSITES AND SOFTWARE

Web Wise Kids are a non-profit organization dedicated to ensuring child Internet safety by
giving tips and advice to parents and children on how to protect themselves from online
predators.
http://www.webwisekids.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Update to Adobe Acrobat Reader 7.0 (FREE)
Acrobat 7.0 is startlingly faster than earlier versions of the PDF-creation app, and includes more
than enough new conveniences to justify an upgrade. And if you create an intelligent PDF
document in Acrobat Pro 7, recipients can annotate it even if they have only the free Adobe
Reader 7.0, not full-blown Acrobat.
http://www.adobe.com/products/acrobat/readstep2.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Watch out Mapquest!
Google Inc. on Tuesday updated its local search service with a focus on maps and providing
more relevant results. In the update, Google has integrated maps onto local result pages,
pinpointing businesses from the listings on the maps and allowing users to zoom and pan
directions without reloading the Web page, the Mountain View, Calif., company announced.. 
http://maps.google.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Concept to Classroom
A series of free online workshops with explanation, exploration, demonstration, and
implementation.
http://www.thirteen.org/edonline/concept2class/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.webwisekids.org/
http://www.adobe.com/products/acrobat/readstep2.html
http://maps.google.com/
http://www.thirteen.org/edonline/concept2class/


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 70 of 167

Free Music from Amazon.com
The Internet has become the “equalizer” for struggling artists ... check them out here.
http://tinyurl.com/3o963 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Get Syndicated (RSS feeds) 
The term "RSS" means various things, but one popular definition is "Really Simple Syndication."
RSS is quickly becoming a popular way to track key--and free!-- content from newsy sites, such
as newspaper headlines and your favorite blogs without filling up your e-mail box or having to
check different Web sites. Thousands if not millions of RSS feeds are now available. Think
about setting one up to promote and educate about school counseling in your community. 
From the Librarian’s Index to the Internet, here is a great tutorial on setting one up.
http://wa.lii.org/search/file/liirss 

___________________________________

JUST FOR FUN

BEATCALC: Beat the Calculator!
This one gave me a headache although still fun.
http://mathforum.org/k12/mathtips/beatcalc.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Crazy things to do with a famous brand of Cola.
http://members.tripod.com/~Barefoot_Lass/cola.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What does your phone number spell?
http://www.phonespell.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Quick game of hangman?
http://gsn.k12.oh.us/zanetrace/web_games/ha
ngman.swf 

http://tinyurl.com/3o963
http://wa.lii.org/search/file/liirss
http://mathforum.org/k12/mathtips/beatcalc.html
http://members.tripod.com/~Barefoot_Lass/cola.html
http://www.phonespell.org/
http://gsn.k12.oh.us/zanetrace/web_games/hangman.swf
http://gsn.k12.oh.us/zanetrace/web_games/hangman.swf
http://gsn.k12.oh.us/zanetrace/web_games/hangman.swf
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SchoolCounselor.com: #31 - February 23, 2005

If computers get too powerful, we can organize them into a committee
-- that will do them in.
____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: I have a ton of stuff on my computer that I use throughout the
course of the year in various situations. I have forms, letters, presentations, spreadsheets,
materials that I use in guidance, and more. My “inventory” of materials is growing fast and I
am finding that I forget that I even have some things that I need and I end up re-creating
them, which of course is a big time waster. Any high-tech solutions here?

A: Yes. In fact, your problem is one that is experienced by all of us when it comes to the World
Wide Web: How to quickly locate relevant and useful resources among a myriad of files or
pages? On the web, the solution has been increasingly more powerful search engines such as
Google, Yahoo, MSN, Ask Jeeves, AltaVista, and others. Fortunately, many of the more popular
search engine companies are now providing their tools for us so that we may search our
computers or desktops just as we would search the web.

I have been using the Google Desktop Search (GDS) now for several months and I am very
happy with it. This new tool saves me more time (and stress) than I even imagined. I can find
any document, letter, presentation, e-mail (yes, even e-mails) that has come across my
computer or “desk” since I installed it.  One of the really neat and unanticipated time-savers is
finding e-mail addresses. Faster than going on the web or even in my own address book, if a
person has written an e-mail to me, I can (within a couple or three seconds) conduct a desktop
search and locate it. And, Google Desktop Search even allows me to click on that address to
start an e-mail to him or her. Because I correspond with a large number of students and others,
this has been an incredible discovery. 

What I have also discovered is that the GDS also indexes cached versions so that, even if you
accidentally delete a file, you may still possibly gain access to its contents (albeit, in a raw
format). 

There is a catch however ... Google Desktop Search only looks at (i.e., indexes):

- e-mail from Outlook 2000+ and Outlook Express 5+ 
- files in TXT, HTML, DOC, XLS, and PPT formats (Office 2000+) 
- chats from AOL 7+ and AOL Instant Messenger 5+ 
- web pages viewed in Internet Explorer 5+ 
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I am aware that Google is expanding to other types of files in the next phase of development
which is exciting. Other pleasant features of the GDS is that it: 

-  should not slow down your computer's performance, because it only builds its index when
you aren't using your computer;
-  does not make your computer's content accessible to Google or anyone else on a network
(unless others on the network somehow had permission to access your files); 
-  many of the same search conditions you use in searching the web also works when searching
your desktop. For instance, if you are looking for a PowerPoint file in particular, use the
filetype:ppt restriction next to your keywords to only include in the results this type of file.

You can download the tool at http://desktop.google.com. Also see the GDS help page for the
answers to Frequently Asked Questions (http://desktop.google.com/gettingstarted.html).

Security Issue: Remember that if you use a desktop search tool, anyone at your computer can
search your computer for sometimes sensitive or even confidential information that you write in
a document or e-mail for instance. Thus, you need to temper the power and advantages of this
tool with security measures. You may want to password protect your computer when you are
not nearby. You can do this in a couple of different ways:

A. Password-protect your computer during standby or hibernation:

1.   Open Power Options in Control Panel. 
2.   Click the Advanced tab, then click Prompt for password when computer resumes from
sleep. The password for which you will be prompted when the computer resumes is the
password for the currently logged-on user account. 

To set your computer to hibernate or Standby, click on Start, Shut Down, then Hibernate or
Standby ... or on newer computers, press the Sleep button). Usually, to “wake up,” you simply
click the Power button.

B. Another, perhaps more palatable method relies on your screen saver. 

1.   Right-click on desktop.  
2.   Click Properties.  
3.   Click Screen Saver.  
4.   Click Password-protected.  
5.   Click Change.  
6.   Enter password.  
7.   Click OK.  

Other desktop searches are available (all currently free) and have other features that may be
more useful for you in the way that you need them: 

http://desktop.google.com
http://desktop.google.com/gettingstarted.html
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-  Yahoo! Desktop Search is at http://desktop.yahoo.com 
-  MSN Desktop Search is at http://toolbar.msn.com/ 
-   Ask Jeeves Desktop Search is at http://sp.ask.com/docs/desktop/ 
-  Copernic Desktop Search is at http://www.copernic.com/en/products/desktop-search/ 

For a comprehensive comparison chart of these and others, visit
http://www.goebelgroup.com/desktopmatrix.htm 

____________________________________________

Q: Every now and then I send an e-mail that I regret. Is there any way to get it back or unsend
it?

A: Maybe you can. If you use Microsoft Exchange Server as your e-mail server, and the
recipient uses Outlook, you can recall the message before the person has a chance to read it:

1.  Open your Sent Items folder. 
2.  Double-click the message you want recalled. 
3.  On the Actions menu, click Recall This Message. 
4.  To recall the message, click Delete unread copies of this message. To replace the message
with another one, click Delete unread copies and replace with a new message, click OK, and
then type a new message. 
5.  To be notified about the success of the recall or replacement for each recipient, select the
Tell me if recall succeeds or fails for each recipient check box. 
6.  Click OK. 

____________________________________________

TIPS AND TRICKS

Conduct a free security check on your computer.
https://grc.com/x/ne.dll?bh0bkyd2 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™
Quick sum a range of cells by highlighting them and pressing Alt+= (equal sign).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Frontpage 2000 and Java.
This tutorial is intended to demonstrate the process of adding JavaScripts (e.g., from The
JavaScript Source; http://javascript.internet.com) into FrontPage 2000 (Microsoft’s web

http://desktop.yahoo.com
http://toolbar.msn.com/
http://sp.ask.com/docs/desktop/
http://www.copernic.com/en/products/desktop-search/
http://www.goebelgroup.com/desktopmatrix.htm
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authoring software). Descriptions and a graphical screenshot of each step is included below. If
you click the thumbnail image the larger screenshot will open in a new window. 
http://javascript.internet.com/tutorials/frontpage2000.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Newsletter template for MS Word™
This is a 2-column, 2-page newsletter template.
http://tinyurl.com/4dmsw 

Here is a (3-col., 4-pp.): http://tinyurl.com/3sqbv 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Explorer
Instead of clicking the Back button, you can press the BACKSPACE key to move back a page.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word: How to put a border around your page.

1.   Open a Word document.
2.   Click on Format and Borders and Shading.
3.   Select the Page Border tab.
4.   Choose either Box, Shadow, or 3D.
5.   Select a style and click OK (or right below, you can choose artwork too).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Undo or Redo ...
In almost any application ... Oops – I just did something wrong (e.g., moved, copied or deleted
something). You can undo what you just did by pressing Ctrl and Z (up to 2 or more times
depending on the application) or Edit, Undo. If you undo too many times, you can redo by
pressing CTRL and Y or Edit, Redo.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Access an AOL E-mail Account with Outlook
If you use Outlook to check your school e-mail, keep your schedule, maintain your to-do list, jot
down notes and to manage your e-mail accounts, wouldn't it be nice if you could also use it to
access your AOL e-mail accounts? Here ya go ...
http://email.about.com/od/outlooktips/qt/et122204.htm 

http://javascript.internet.com/tutorials/frontpage2000.html
http://tinyurl.com/4dmsw
http://tinyurl.com/3sqbv
http://email.about.com/od/outlooktips/qt/et122204.htm


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 75 of 167

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Incredimail
Have you ever found that the common task of sending and receiving e-mails is dull, redundant
and tedious? Ever wanted to send e-mails that look livelier than standard e-mails? Would you
like to add some thrill and experience to your e-mail, a message that goes beyond text?
Well, look no further, IncrediMail will easily give you all that and much more and it's 100%
FREE! Welcome to IncrediMail. E-mail has finally evolved!
http://www.incredimail.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HTTrack is a free (GPL, libre/free software) and easy-to-use offline browser utility. 
It allows you to download a World Wide Web site from the Internet to a local directory, building
recursively all directories, getting HTML, images, and other files from the server to your
computer. HTTrack arranges the original site's relative link-structure. Simply open a page of the
"mirrored" website in your browser, and you can browse the site from link to link, as if you
were viewing it online. HTTrack can also update an existing mirrored site, and resume
interrupted downloads. HTTrack is fully configurable, and has an integrated help system.
http://www.httrack.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

RegClean (Free).
This utility cleans your Registry of unnecessary entries that were created when you installed or
uninstalled programs on your computer. This release of the utility fixes a few problems and
creates an "undo.reg" file so that you can undo changes you inadvertently make to the
Registry. Note: Although this program still works, it is no longer supported by Microsoft. 
http://tinyurl.com/1hf7 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Eyeball Chat (free)
Just started using this to videochat and share files with friends. I really like it.
http://www.eyeballchat.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Animated Graphics for your e-mail, website, PowerPoint, etc ...
http://www.bellsnwhistles.com/ 

http://www.incredimail.com
http://www.httrack.com/
http://tinyurl.com/1hf7
http://www.eyeballchat.com/
http://www.bellsnwhistles.com/
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____________________________________________

JUST FOR FUN

Game of 9-ball?
http://gsn.k12.oh.us/zanetrace/web_games/9ball.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

TV-B-Gone
If you agree that some television noise is like second hand smoke, harmful to you in some way.
Then you need to know about this new gadget, a new universal remote that turns off almost
any television. The device, which looks like an automobile remote, has just one button. When
activated, it spends over a minute flashing out 209 different codes to turn off televisions, the
most popular brands first. 
https://www.tvbgone.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Become a speech writer for President Bush
http://gsn.k12.oh.us/zanetrace/web_games/President_Bush_Speech_maker.swf 

____________________________________________

http://gsn.k12.oh.us/zanetrace/web_games/9ball.swf
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SchoolCounselor.com: #33 - March 10, 2005

FREQUENTLY ASKED QUESTIONS

Q: Is there a quick, cheap, and easy way to conduct
surveys online? I’m interested in surveying our staff about
their perceptions and needs regarding my school
counseling program.

A: First, let me say, “Good idea!” As my colleague Dr. Tyler and I wrote in our book (Using
Technology to Improve Counseling Practice; see http://tinyurl.com/5gux6), online surveys come
with many advantages. For one, data is stored and collated immediately after the respondent
clicks on the Submit button. With one or two clicks of the mouse, the counselor can perform
analyses or create graphs of the data at any time during collection, getting a snapshot of the
results as they come in. Second, the time for the entire process is significantly diminished,
especially if the same survey is periodically conducted over time. Third, an online survey can be
conducted with only a few people in one locale or the entire planet over the World Wide Web.
Barriers of space, place, and time become greatly lessened. Also, online surveys can include an
array of multimedia elements including sound, animation, and photos, thus making them more
interesting to the respondents and perhaps increasing response rates. Finally, copies of the
results of an online survey can be sent to more than one person or place which facilitates
collaboration among the counselor and others such as interested researchers who can help with
the analysis.

There are certainly ways to do online surveys although the part about quick, easy, and cheap
... well, those are all relative. The good news is that it really is a great deal easier to do this
today than every before. Here are a few ideas to think about and tips to help you get started:

1. You might first contact your central office. School districts sometimes purchase a license to
use online data collection software which you may already be entitled to use.

2. Contact a local community college or university counselor educator whom typically has
access to this type of tool as part of his/her job. The professor may even be interested in
collaborating on your survey project as a community service opportunity.

3. If your school is using Microsoft Outlook with the Corporate Workgroup/Other or Exchange
Server option (ask your IT folks), you can send survey-type messages with voting buttons to a
group of recipients. By clicking a button, each respondent can express a preference and
generate a response message to vote. Outlook logs Vote messages to the original message's
tracking page. See an article at http://support.microsoft.com/?kbid=197420 that describes the
conditions and requirements for proper operation of the Voting feature. This feature works best
if you have only one question per email.

http://tinyurl.com/5gux6
http://support.microsoft.com/?kbid=197420
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4. You can put a survey up on a website yourself with a little know-how. For instance, visit
http://ir.utb.edu/Tools.htm to learn how to create a survey with Microsoft Frontpage (also see
http://spider.georgetowncollege.edu/t3/Tutorials/forms.htm). Similarly, you can create your
own survey using Microsoft Access (see
http://www.functionx.com/access/applications/survey.htm for a tutorial)

5. If all else fails, you may need to pay a fee and go with on online survey service such as one
of the following:  http://www.zoomerang.com, http://websurveyor.com,
http://www.surveymonkey.com, http://www.quia.com, http://www.freeonlinesurveys.com, or
http://www.supersurvey.com/ to name a few. 

NOTE: If you are okay with a sample of respondents, you can conduct free online surveys for
no more than, say, 50 people (e.g., see http://www.ezquestionnaire.com or
http://www.freeonlinesurveys.com/).

____________________________________________

TIPS AND TRICKS

Create a table of contents in Microsoft Word with custom styles
http://tinyurl.com/6o5bl 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Micrsoft PowerPoint: Viewing the Grid
Press SHIFT+F9 to show or hide the grid in PowerPoint. The grid will help you with aligning
your graphics and other content. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Flag an Email for Follow-up (Microsoft Outlook)
As you make your way through your inbox, you encounter an email that requires follow-up.
Flag the email with a Microsoft Outlook Flag. The next time you're reading an email that
requires follow-up:

1. Right click over the message. 
2. Select Follow Up
3. Select a reason from the drop-down Flag to: list (e.g., call, read, forward)
4. Select a Reminder date. (Optional, but I strongly encourage it.) 
5. Click OK. 

http://ir.utb.edu/Tools.htm
http://spider.georgetowncollege.edu/t3/Tutorials/forms.htm
http://www.functionx.com/access/applications/survey.htm
http://websurveyor.com
http://www.surveymonkey.com
http://www.quia.com
http://www.freeonlinesurveys.com
http://www.supersurvey.com/
http://www.ezquestionnaire.com
http://www.freeonlinesurveys.com/
http://tinyurl.com/6o5bl
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Outlook will place a red flag next to the email heading for easy identification. Outlook will also
provide a pop-up reminder on the day the email follow-up is due. To remove the flag, right click
on the message again and select Clear Flag.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Faxing in Windows XP
If you're running Windows XP, you can finally donate that old fax machine to a local charity and
use the desk space for something more valuable—like a box of doughnuts. An easy-to-use fax
service is built into Windows XP so you can send and receive faxes from your computer.
http://tinyurl.com/24csp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Optimize your Internet access settings ... The TCP Optimizer is a free Windows program
designed to help optimize your Internet connection. Just download and run, no installation
required. The program makes it easy to find the best MaxMTU value, test latency and tweak all
the important broadband related registry parameters. The Optimizer can be helpful with tuning
any Internet connection type, from dialup to Gigabit+ :) If you need help with the program,
read several broadband tweaking articles, the Optimizer FAQ, and/or visit our Forums. As an
alternative, you can try one of our generic Registry patches instead. 
http://www.speedguide.net/downloads.php 

It might be fun for you to do a pre- and post test of your speed. Before and after optimizing,
go to http://www.bandwidthplace.com/speedtest to see what the difference is. I went from 2.5
to 4.1 Mbps after running this program.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Outlook: Find a Contact While Reading an Email.
You can look up information about a contact from an e-mail message. The contact must be in
your original contact list. 

1. Right click on the person’s name in the To, Cc, or Bcc boxes of the email message.
2. Click Look up Contact on the shortcut menu. 

Similarly, you can add someone to your address book very quickly by choosing Add to Contacts
in step #2. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/24csp
http://www.speedguide.net/downloads.php
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Microsoft Word: Insert a manual page break
When you reach the bottom of a page, Word inserts a page break and starts a new page.
There may be times when you would like to force a page break before you reach the bottom of
the page. Simply insert a manual page break. 

1. Position your cursor at your preferred break point. 
2. Press Ctrl+Enter. 

By the way, this works in Corel WordPerfect too.
____________________________________________

WORTHY WEBSITES AND SOFTWARE

Links to Internet Safety for children information and curriculum.
http://www.schoolcounselor.com/safetynetlinks.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

bugmenot.com
Hmmm, I do have mixed feelings about this one because it is clearly deceptive although I’ll at
least make you aware of it: You're browsing the web and you click a link to an article on a site
(let's say nytimes.com) but instead of getting the article you get a screen asking you to login or
register. Infuriated at the idea of pointlessly registering for yet another site you turn to your
good buddy bugmenot.com. 
http://bugmenot.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

A Parent's Primer to Computer Slang
Understand how your kids communicate online to help protect them.
http://tinyurl.com/5zqcx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Awesome Library Technology Section
http://www.awesomelibrary.org/Classroom/Technology/Technology.html

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Marilyn Western's Technology Tips for Classroom Teachers
Tons of tutorials.
http://www.edzone.net/%7Emwestern/tutorials.html 

http://www.schoolcounselor.com/safetynetlinks.asp
http://bugmenot.com/
http://tinyurl.com/5zqcx
http://www.awesomelibrary.org/Classroom/Technology/Technology.html
http://www.edzone.net/%7Emwestern/tutorials.html
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Calendar Wallpaper from Ulead
http://www.ulead.com/download/wallpaper/download.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Educating the Next Generation (Free Book from Educause)
The Net Generation has grown up with information technology. The aptitudes, attitudes,
expectations, and learning styles of Net Gen students reflect the environment in which they
were raised—one that is decidedly different from that which existed when faculty and
administrators were growing up. This collection explores the Net Gen and the implications for
institutions in areas such as teaching, service, learning space design, faculty development, and
curriculum. Contributions by educators and students are included. Professional printing options
are available.
http://www.educause.edu/books/educatingthenetgen/5989 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Find help in Google and/or Google Groups: When I have a problem with my computer, I
usually learn how to solve it (and help others solve the same problem) by going online. Enter
some or all of the text from the Windows error message into Google's main search box. If that
doesn't help you find a fix, click the Groups tab on the Google search results page to see
archived discussions that may relate to your problem.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Explorer: Getting More Screen Real Estate.
Whenever you need to see more of a folder or Internet Explorer browser window, simply press
F11 to view the window in full-screen mode. Then press F11 again to revert to normal view. If
you're using Windows 2000, Me, or XP, you can add a button to toggle between modes by
right-clicking the Standard toolbar and choosing Customize. Click Full Screen under 'Available
toolbar buttons', and then choose Add and Close.

___________________________________________

JUST FOR FUN

Google has created a new "movie:" operator that enables you to find movie-related information
faster and more easily, whether you're looking for titles or actors, director or genre, famous
lines or obscure plot details. Can't remember the name of that film where Tom Hanks made
friends with a volleyball? Search for [movie: Tom Hanks talking to a volleyball] and Google will
tell you: it was Cast Away. Want rental recommendations? Try searching for [movie: awesome

http://www.ulead.com/download/wallpaper/download.htm
http://www.educause.edu/books/educatingthenetgen/5989
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car chase]. Click on the following link for movie listings that include the phrase “school
counselor” or “guidance counselor.”
http://tinyurl.com/4r6ux 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

How well do you know Microsoft PowerPoint™®?
Are you a master of shows, eager to flaunt your presentation prowess? Or do you have an itchy
feeling there's more you could know? Assess your level with the PowerPoint Whiz Quiz, ten
questions that test what you know. Even a smarty can learn something. 
http://tinyurl.com/4zqqp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Xball
Simple game although can be addictive. 
http://gsn.k12.oh.us/zanetrace/web_games/xball.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Humanclock.com shows a photograph of the current time, with the photo changing every
minute of the day (all 1,440 occurring minutes on Earth!) Thus you end up with a rotating
picture clock sorta deal ... gotta see it.
http://www.humanclock.com 

____________________________________________

http://tinyurl.com/4r6ux
http://tinyurl.com/4zqqp
http://gsn.k12.oh.us/zanetrace/web_games/xball.swf
http://www.humanclock.com
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SchoolCounselor.com: #34 - March 27, 2005

The only reason for time is so that everything doesn't happen at once.
-- Albert Einstein

The telephone wire, as we know it, has become too slow and too small
to handle Internet traffic. It took 75 years for telephones to be used by
50 million customers, but it took only four years for the Internet to
reach that many users. - Lori Valigra

Computers are magnificent tools for the realization of our dreams, but
no machine can replace the human spark of spirit, compassion, love,
and understanding. - Louis Gerstner, CEO, IBM 

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: My printer prints pages in the reverse order. I am tired of telling it to begin with page 1
every time. Is there a way to set this up automatically?  

A: Yes indeed. Go to [START] in the left bottom corner, then [Settings], then [Printers] as
illustrated in the figure on the right. Then, right click over your printer icon and select
[Properties]. This opens the menu for that printer. Tab through each category of menu items to
find the selection for "ordered printing" or "reverse printing" as it is usually called.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I know that I should be conducting regular backups of all the files on my computer but I’m
not sure about the best way to do it, can you make a recommendation?

A: Backing up your data is a very smart idea because you never know when your computer will
suffer a catastrophic failure, you accidentally delete a file or folder, or if a file you need
becomes corrupted and unusable. I have a recurring event in my calendar that reminds me to
do a monthly backup of all my data, including all the emails I sent for that month. 

The most important consideration in backing up files is (a) to what kind of medium will you
backup your data; and (b) what file format? But first, I strongly recommend that you keep all of
your files in a central location on your hard drive. For instance, anything I create (documents,
multimedia files, photos, etc) goes under one of two folders, My Documents and My
Documents2. I used to be able to keep it all under one folder although, because I backup my
files on CD-ROM, I couldn’t fit it all on one CD so now I keep two folders and burn each one on
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a CD every month. You will save a great deal of time backing up only one or two folders rather
than having to search for files all over your computer every time. 

So, now it’s time to create a backup ... Here are a few suggestions for doing this as easily as
possible, you can pick the one that is most right for you:

1.  If you are using Windows XP, you probably already have available on your computer the
Backup utility that comes with the operating system (go to Start, then Accessories, System, and
Backup). If you don’t see it, you will need to go back the Windows CD’s and install it. This
program does a nice job and can even be set on a regular backup schedule. However, know
that the Windows XP Backup utility doesn’t just copy your files, but puts them into an archive –
one file that holds all your data. If something happened and you needed to retrieve one or
more files from your backup, you would have to conduct what is called a file restore (which is
why I don’t like using these kinds of backup utilities). 

2.  You could simply do an entire backup of your files on a CD-ROM every so often, perhaps
once per month. CD’s are now quite cheap, about 10-15 cents each, and only take a few
minutes to burn given today’s high speed CD burners. The main advantage is that your backup
is immediately useable. That is, your files are on the CD exactly as they are on your computer
and so you could quickly get a single file if you needed it without having to conduct a file
restore. By the way, I have started using DVD’s to conduct backups as the price of these have
now drastically dropped to about 50 cents or so a piece. To burn a CD or DVD, you need the
CD or DVD burner on your computer (or perhaps you have an external burner). Then, you need
some good software which usually comes with the computer or the external burner that you
may have added on. If for some reason you don’t have CD/DVD burning software, I
recommend a free program called CDBurnerXP Pro at http://www.cdburnerxp.se. 

3. You could also copy all your files to your school’s network which I bet is also backup up on a
periodic basis. Know however, that others may have access to your network folder and could
potentially read sensitive files.

4. Another consideration is to backup your files to a second hard drive or flash drive. For
instance, conduct a web search with the words External USB Drive and you’ll notice a variety of
options. Flash drives are tiny storage devices that you can carry on your key chain or around
your neck. These come in a variety of sizes and can easily hold as much as one CD (about 650-
700mb) or more.  

5. Don’t forget to backup the stuff in your email program. For instance, if you use Outlook 2000
or later version, you can download a free Add-in called Personal Folders Backup which creates
backup copies of your .PST files at regular intervals, in Outlook 2000 and later versions, making
it easy to keep all of your Outlook folders safely backed up (see http://tinyurl.com/4xwnh). Or,
use the Archive feature in Outlook to archive all the emails in your Sent folder (see
http://tinyurl.com/3n3vg).

http://www.cdburnerxp.se
http://tinyurl.com/4xwnh
http://tinyurl.com/3n3vg
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Note: Mac users, visit http://maczealots.com/articles/backup/ for a nice article on how to
conduct backups on your computer. 

____________________________________________

TIPS AND TRICKS

Microsoft Word (from Lockergnome; http://tinyurl.com/4auz9). 
Textboxes are a great way of bringing attention to specific text within a document. You may
want to insert the textboxes as you compose your document. You can easily do so by clicking
the Textbox option from the Insert menu. You can then type in the specific text.

What if you decide you want to insert a textbox after your document is composed? There is no
need for you to retype the specific text in a textbox. Instead, highlight the existing text that
you want to appear within a textbox. From the Insert menu, click the Textbox option. Word will
automatically place the selected text into a textbox. You can then move it and resize it as
necessary using the handles.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel 2000 
The one keyboard shortcut you should know is:
CTRL+SHIFT+* (asterisk)
This key combination selects the current range around the active cell, the area defined as the
largest rectangle of data surrounded by white space.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint
Jazz up your PowerPoints by including Shockwave files – a very popular file format for
presenting more complex animated content such as movies, games, buttons, or more. It is a
difficult process to include these requiring 5 or 6 steps – until now. Swiff Point Player is a Free
Microsoft PowerPoint Add In that enables Web Designers and Flash Users to easily insert and
play their Flash movies in their Microsoft PowerPoint presentations. 
http://www.globfx.com/products/swfpoint/ 

Don’t forget, you can find specific shockwave files by using the Google.com and entering your
keywords and the command filetype:swf. For instance, visit
http://www.angriesout.com/bounceback/bbkid3.swf to view a shockwave file that is actually a
multimedia book entitled “Become a Bounce Back Kid When Bad Things Happen” by Lynne
Namka.

http://maczealots.com/articles/backup/
http://tinyurl.com/4auz9
http://www.globfx.com/products/swfpoint/
http://www.angriesout.com/bounceback/bbkid3.swf
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To download this SWF file, put the following into the Google.com search bar “become a bounce
back kid filetype:swf” (without quotes). You will recognize the file in the results by looking for
the file name, in this case http://www.angriesout.com/bounceback/bbkid3.swf. For me, it came
up first in the results. To download the file, right click over the link and select Save Target As.
Then you can insert it into your PowerPoint using your new Swiff Point Player add-on. By the
way, there are more of these located on the main page at http://www.angriesout.com/. Try
other counseling related keywords with the search condition filetype:swf in Google.com. (NOTE:
if you like this Google search tip, you’ll love more of the same on the World Wide Web Boot
Camp for School Counselors CD, details at http://www.schoolcounselor.com/cd). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Use Single-Click Everywhere
With single–click in Windows XP, navigating the files and folders on your hard disk is as easy as
navigating the Web. You simply click an icon to open a program or document.

To start using single–click:

1. In the Tools menu in Windows Explorer, click Folder Options. 
2.  In the Click items as follows section, click Single–click to open an item (point to select). 
 
Note To access Windows Explorer, click Start, point to All Programs, and then click Windows
Explorer

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Don’t Get Caught by Phishing Scams
Phishing is a high-tech scam that uses spam or pop-up messages to deceive you into disclosing
your credit card numbers, bank account information, Social Security number, passwords, or
other sensitive information. According to the 2004 annual report from security firm
MessageLabs, the number of phishing attacks rose exponentially during 2004 — phishing
messages in January 2004 numbered 337,050, but in November they totaled 4.5 million. Read
more online.
http://cit.information.unl.edu/info0305.htm#phish 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Insert a manual page break.
When you reach the bottom of a page, Word inserts a page break and starts a new page.
There may be times when you would like to force a page break before you reach the bottom of
the page. Instead of pressing Enter multiple times until you reach the beginning of the next
page, simply insert a manual page break: 

http://www.schoolcounselor.com/cd
http://cit.information.unl.edu/info0305.htm#phish
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Position your cursor at your preferred break point. 
Press Ctrl+Enter. 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

ATNotes v9.41 (free)
Note-taking is healthy habit to develop; even more important is organizing all those tidbits of
information, so that you can find them later. ATnotes is a freeware program which creates
Post-it like notes on the Windows desktop. You can set single or repeated alarms for each note
with visual and audio alarm signal. They can be placed anywhere on your desktop, as well as
resized. You can even send notes to other computers in a local network.
http://tinyurl.com/69b7q 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Meyer's PowerPoint Backgrounds 
Add some spark to your presentation with these colorful PowerPoint templates. The following
address points directly to the file. 
http://tinyurl.com/4ct2c 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Screamer Radio is an Internet radio player tied to an online list of hundreds of ready-to-play
radio stations. You can also record whatever you are listening to with the click of a button.
Based on the BASS Audio Library and designed not to be in your way, Screamer Radio will not
slow down your computer and can be easily hidden in the system tray.
http://tinyurl.com/5rcde 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Thanks to Paul Zuiker, a SchoolCounselor.com Newsletter reader for alerting me to these next
two useful pieces of software:

EclipseCrossword is the fast, easy, free way to create crossword puzzles in minute (FREE).
It's never been simpler—just give EclipseCrossword a list of words and clues, and it does the
rest. In seconds, you'll have a crossword puzzle with just the words you want. Half a million
people can't be wrong. (Well, okay, they could, but that's just silly.) 
http://www.greeneclipsesoftware.com/eclipsecrossword/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/69b7q
http://tinyurl.com/4ct2c
http://tinyurl.com/5rcde
http://www.greeneclipsesoftware.com/eclipsecrossword/
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XnView is a free software program to view and convert graphic files. Support of more than
400 graphics formats ! 
http://www.xnview.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Wordperfect Tips and Tricks
If you’re like me and are one of the few people left in the world that still uses WordPerfect™
instead of Microsoft Word™, here is a great website for you.
http://www.wpwriter.com/Tips___Tricks/tips___tricks_.html 

____________________________________________

JUST FOR FUN

The English-to-12-Year-Old-AOLer Translator
This translator will take what you write in it and turn it into the manner a 12-year-old AOLer
would write it. Type in what you want translated and then click the button.
http://ssshotaru.homestead.com/files/aolertranslator.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Remember the game Donkey Kong?
http://tinyurl.com/4wvem 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Discover hundreds of little-known uses for well-known products, by just clicking on
a product!
http://www.wackyuses.com/uses.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Board Room (a 38 second Windows Video File)
http://www.discoverfun.com/freeinfo/videos/gfx2/boardroom.wmv 

____________________________________________

http://www.xnview.com/
http://www.wpwriter.com/Tips___Tricks/tips___tricks_.html
http://ssshotaru.homestead.com/files/aolertranslator.html
http://tinyurl.com/4wvem
http://www.wackyuses.com/uses.html
http://www.discoverfun.com/freeinfo/videos/gfx2/boardroom.wmv
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ADVERTISE

Want to advertise in
this newsletter?

SchoolCounselor.com: #35 - April 9, 2005

The great paradox of the 21st century is that, in this age of
powerful technology, the biggest problems we face
internationally are problems of the human soul. Ralph Peters

There is a powerful tension in our relationship to technology. We
are excited by egalitarianism and anonymity, but we constantly
fight for our identity. David Owens

____________________________________________

FREQUENTLY ASKED QUESTIONS

Preventing Repetitive Stress Injuries (RSI)

It drives me a bit nutty when I see my colleagues and others sitting in front of the computer
reaching for a mouse across their desk for many hours at a time. I worry about the effects this
has on their health ... 

... From http://eeshop.unl.edu/rsi.html 

As more and more work, education and recreation involves computers, everyone needs
to be aware of the hazard of Repetitive Strain Injury to the hands and arms resulting from the
use of computer keyboards and mice. This can be a serious and very painful condition that is
far easier to prevent than to cure once contracted, and can occur even in young physically fit
individuals. It is not uncommon for people to have to leave computer-dependent careers as a
result, or even to be disabled and unable to perform tasks such as driving or dressing
themselves. 

Repetitive Strain Injuries occur from repeated physical movements doing damage to
tendons, nerves, muscles, and other soft body tissues. Occupations ranging from meat packers
to musicians have characteristic RSIs that can result from the typical tasks they perform. The
rise of computer use and flat, light-touch keyboards that permit high speed typing have
resulted in an epidemic of injuries of the hands, arms, and shoulders. Use of pointing devices
like mice and trackballs are as much a cause, if not more so. The thousands of repeated
keystrokes and long periods of clutching and dragging with mice slowly accumulates damage to
the body: another name for the condition is Cumulative Trauma Disorder. This can happen
even more quickly as a result of typing technique and body positions that place unnecessary
stress on the tendons and nerves in the hand, wrist, arms, and even the shoulders and neck.
Lack of adequate rest and breaks and using excessive force almost guarantee trouble. 

http://www.schoolcounselor.com/advertising.htm
http://www.schoolcounselor.com/advertising.htm
http://eeshop.unl.edu/rsi.html
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Symptoms

* Tightness, discomfort, stiffness, soreness or burning in the hands, wrists, fingers, forearms,
or elbows 

* Tingling, coldness, or numbness in the hands 

* Clumsiness or loss of strength and coordination in the hands 

* Pain that wakes you up at night 

* Feeling a need to massage your hands, wrists, and arms 

* Pain in the upper back, shoulders, or neck associated with using the computer. 

Here are some sites that can help you with correct typing technique and posture, the right
equipment setup, and good work habits that will help you reduce the risk of RSI. 

http://eeshop.unl.edu/rsi.html 
http://www.rsi.deas.harvard.edu/preventing.html 
http://www.rsihelp.com/children.shtml  
http://tinyurl.com/5vpv3 
http://tinyurl.com/46pfd 
http://tinyurl.com/4hnzy 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Absolute Positioning of a Picture

Q: Sometimes when I insert a picture in my document, it moves around on its own. How can I
keep the picture in the same spot that I inserted it in (or at least stay with the corresponding
text as I edit the document)?

A: Good question ... Here ya go ...

1.  Insert your picture as you normally do. 
2.  Click on the picture one time to select it. 
3.  Choose Picture from the Format menu. Word displays the Format Picture dialog box. (Make
sure the Layout tab is selected).
4.  Select one of the Wrapping options except In Line With Text. 
5.  Click the Advanced button. Word displays the Advanced Layout dialog box. Make sure the
Picture Position tab is selected. 

http://eeshop.unl.edu/rsi.html
http://www.rsi.deas.harvard.edu/preventing.html
http://www.rsihelp.com/children.shtml
http://tinyurl.com/5vpv3
http://tinyurl.com/46pfd
http://tinyurl.com/4hnzy
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6.  In the Horizontal area of the dialog box choose Absolute and set the picture to be any
number of inches to the right of Page. In the Vertical area of the dialog box choose Absolute
and set the picture to be the number of inches you want  below Page. 
7.  Make sure the Move Object with Text check box is cleared. 
8.  Close both of the open dialog boxes. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: Wendy, a counselor and SchoolCounselor.com reader asks, “When I create a document in
Microsoft Word™ such as an evaluation form and I make lines in my document for people to
write on, why does Word turn my line into a thick line when I go to the next line? This drives
me nuts and I don't know how to fix it other than making a period at the end of my line.”

A: Thanks Wendy. You’ll have to forgive Bill Gates, he’s just trying to help. This is another
automatic feature that tries to automate frequent tasks and save you time. In this case, when
you insert a few blank lines and press enter, the program thinks you want a thick line that goes
across your document. This is an AutoCorrect option. To turn it off:

1. Go to Tools
2. Choose AutoCorrect Options
3. Go to the Tab that says AutoFormat as You Type
4. Uncheck Border Lines 

____________________________________________

TIPS AND TRICKS

PowerPoint™: Hyperlinking
In PowerPoint, a hyperlink can be created that will “jump” you from one slide to another, from
a slide to a web page, from a slide to a file, or other types of combinations. The hyperlink itself
can be text or an object such as a picture, graph, shape, or WordArt. Learn more by visiting:
http://eit.tamu.edu/EITDOCS/TnT/Volume2/hyperlinksppt.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Undo
In most programs, pressing Control-Z will undo what you just did (same as Edit, Undo).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Toolbars
You can add/change toolbars to the task bar at the bottom of your desktop. Right-click on an
empty spot on the task bar (same bar with the Start button), scroll up to “toolbars”, click on a

http://eit.tamu.edu/EITDOCS/TnT/Volume2/hyperlinksppt.pdf
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toolbar option to select it. For instance, I find it
helpful to include the address bar as a quick way to
get to a website without first having to open my web
browser.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Email Attachments
After you create a document (or other file for that
matter) that needs to be emailed to someone as an
attachment, save yourself some time. Instead of
going to your email program, setting up a new email,
then finding and attaching the file to the email, do
the following: 

1.  In Microsoft Word™ 2002, for instance, click on
the e-mail button (directly under View or find it under
File, Send To...). The e-mail header box will open. 

2.  Type the recipient's e-mail address. The e-mail
address will appear in the Tool box.

3.  Click in the Subject text box and type a subject. If you are using a previously saved
document, Word 2002 will automatically insert the document name as the subject of the e-mail. 

4.  Type a message in your email and send.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Zoom in and Out of a file
Instead of clicking on View and then Zoom, in most programs, you can hold the CTRL key down
while using your mouse wheel to zoom in and out (of course your mouse has to have a wheel
on it).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Bulleted Lists
When creating a bulleted list, use keyboard shortcuts to designate bullet level.

1.  Press the Tab key to Demote.
2.  Press Shift and Tab key to Promote.

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Microsoft PowerPoint™: Create your own Background
1. Go to the Format menu to Background
2. Choose a color from the pull-down menu.
3. Select Preview to see how the slide appears now.
4. To insert your own photo or image as a background, click the drop down menu on the
bottom left, select the Photo tab, and import.
5. Apply to All does just that (applies to all the slides). Apply only applies to the slide you have
selected.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Select Columns of Text 
Have you ever just wanted to select a column of text and it grabs all the text? Just press ALT
(PC) or Option (Mac) while you drag your mouse over text.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Page Borders
You can spark up your Word documents with borders:

1. Go to the Format menu to Borders and Shading...
2. Click on the tab for Page Borders.
3. Select the pull-down menu for Art and choose a style.
4. Increase the size above to make a thicker border.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Full Screen Mode
Word includes a full-screen mode that minimizes the extraneous information (tools, menus,
etc.) displayed on the screen. To enter full-screen mode, press Alt+V, then U. (These are the
keystrokes to activate the proper menu choices.) In older versions of Word (those before Word
97), you could press F10 to switch to full-screen mode; that shortcut is no longer available.

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Top ten Cyber security tips For teens, their teachers and families (PDF file)
http://tinyurl.com/5aqht 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/5aqht
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Parent’s Guide to the Information Superhighway (also in Spanish).
It's designed to welcome you, and give you a simple step—by—step introduction to parenting
in a world of computers and new forms of media. This Guide will provide some tools and rules
for you to use with your children at home, at school, and in the community. 
http://www.childrenspartnership.org/bbar/pbpg.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mailto Generator.
Use this easy code generator form to quickly create mailto links for your page.  You can make
mailto links that include To, Cc, Bcc, Subject, and Body material.  Multiple email addresses are
allowed in the address fields, and a convenient popup window lets you instantly test the code in
your default email client.  Simply fill in the fields, and then copy-and-paste the code into your
html page.
http://jscode.com/generators/mailto_generator.shtml 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Explorer: Alphabetize your Favorites Links
Your favorite URLs can be organized alphabetically within Internet Explorer. To do this, simply
click the Favorites menu within IE, right click any URL listed, and click the Sort by name option.
The URLs will then be listed alphabetically instead.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

List of the keyboard shortcuts for Word 2000
http://tinyurl.com/2zcb6 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Compare the cost of living in hundreds of U.S. cities.
http://www.homefair.com/homefair/calc/salcalc.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

SMS Everywhere
Send text messages (SMS) to virtually any cell phone.
http://www.smseverywhere.com/ 

____________________________________________

JUST FOR FUN

http://www.childrenspartnership.org/bbar/pbpg.html
http://jscode.com/generators/mailto_generator.shtml
http://tinyurl.com/2zcb6
http://www.homefair.com/homefair/calc/salcalc.html
http://www.smseverywhere.com/
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Name that Video Game .. Fun
http://tinyurl.com/7xu78 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Gridgame .. Can’t explain this one, weird.
http://www.columbia.edu/~chc18/gridgame.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What do you get when you cross a penguin with the game of baseball? Well ... here
ya go.
http://n.ethz.ch/student/mkos/pinguin.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Fly a helicopter
http://www.hurtwood.demon.co.uk/Fun/copter.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Fun Hangman type game using fish (don’t get eaten by the big fish)
http://www.piscestt.com/pisces/funsection/hangman/hangman.swf 
____________________________________________

http://tinyurl.com/7xu78
http://www.columbia.edu/~chc18/gridgame.swf
http://n.ethz.ch/student/mkos/pinguin.swf
http://www.hurtwood.demon.co.uk/Fun/copter.swf
http://www.piscestt.com/pisces/funsection/hangman/hangman.swf
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... What are School
Counselors Doing w ith
Technology? The results
of a quick e-mail survey
sent out to readers of the
SchoolCounselor.com
Newsletter are now
available. Download a
document with over 50
responses replete with
creative and innovative
uses of technology in
school counseling!
http://tinyurl.com/dgfjd 

SchoolCounselor.com: #36 - April 26, 2005

School counselors that decide to "opt out" of information
technology will be working with students who perceive them to
live in a world that not longer exists. Russell A. Sabella, PhD

Computing is not about computers any more. It is about living. 
Nicholas Negroponte

______________________________________

FREQUENTLY ASKED QUESTIONS

Q: I have numerous fonts that I use which come in handy for
newsletters and other documents. Is there a quick way to print
a sample of each that I can refer to instead of scrolling
through them each time (which seems to take forever).

A: I’ll give you a couple of methods. First, you can use a
Microsoft Word™ macro to do this (it sounds worse than it is). ListFonts is a free document that
gives you the directions for creating a macro that, in turn document containing samples of
every font installed on your PC. The list is neatly formatted and sorted alphabetically. Just
follow a few steps to generate the macro and print the result. You can rerun the macro
whenever you add or remove fonts. Download the macro by visiting http://tinyurl.com/4u8rq.
After you download the file which is in an archive format (zip file), open it, and then open the
file inside (ListFonts.rtf). This will give you the directions for setting up the macro. 

Another way to do this is to download software that is designed help you view and print the
fonts available to you on your system, here are a few:

FontPage - Free Font Viewer and Font Examiner
http://bluefive.pair.com/fontpage.htm 

Free and Easy Font Viewer 1.2 (this one is simple to use although does not allow you to
print a report.
http://tinyurl.com/5hyfu 

This one seems like it would really do the trick –>> PI-Font lets you print a concise report of
fonts installed on your PC along with a sample alphabet in upper and lower case to give you an
indication of what it looks like. 
http://www.snapfiles.com/get/pifont.html 

http://www.schoolcounselor.com/counseling-tech-survey.htm
http://www.schoolcounselor.com/counseling-tech-survey.htm
http://www.schoolcounselor.com/counseling-tech-survey.htm
http://tinyurl.com/dgfjd
http://tinyurl.com/4u8rq
http://bluefive.pair.com/fontpage.htm
http://tinyurl.com/5hyfu
http://www.snapfiles.com/get/pifont.html
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By the way, it’s a good idea to delete any fonts that you don’t regularly use – the more fonts
you have installed, the slower your system. To delete fonts, click Start, Control Panel, Fonts.
You can view and delete fonts from here.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I’ve figured out how to include an AutoShape in my PowerPoint slides although I can’t seem
to put the text part in.

A: Autoshapes are quite useful when you are developing flowcharts, callouts (the little bubbles
above people’s photos that show what they are saying or thinking), or just to jazz up your
PowerPoint, Word document, spreadsheet, website, or just about anything else. Some
autoshapes such as callouts prompt you to add text, others don’t. To add text to any
autoshape:

1.  Add your AutoShape as you normally would (click Insert, Picture, then Autoshape; or click
on the AutoShape button on the toolbar).
2.  Right-click the new AutoShape which will display a Context menu. 
3. Choose Add Text from the Context menu. An insertion point appears within the body of the
AutoShape. 
4. Type your text. 
5. Click somewhere outside the boundaries of the AutoShape to get out. 

Note a couple of things. First, your text will not automatically wrap so you will need to use hard
returns. Second, if you later resize your AutoShape, then the text within it is reformatted to fit
the new dimensions of the shape. Finally, you may edit your AutoShape by right-clicking over it
and choosing Format AutoShape.

____________________________________________

TIPS AND TRICKS

Microsoft Word™: Change the default font for your Word documents 
If you like all of your documents to be in a specific font, you may find it annoying to have to
change the font each time you open a Word document. Instead, you ought to select and set a
default font for your documents. All documents based on the Normal template will have the
new default font after following these steps:

1. Open a new document. 
2. Go to Format | Font. 
3. Select the settings you want for your default font. 
4. Click the Default button. 
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5. When the pop-up appears asking you to confirm that you want to apply the new font to the
6. Normal template, click Yes. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Adding Holidays to your Outlook Calendar
By default, Outlook does not display holidays on the calendar. Most people prefer having
holidays listed in their calendar for reminders, planning work schedules, deciding upon holidays,
and so on. If you want holidays listed, you can add country specific holidays to your calendar.

1. From the Outlook tools menu, click Options. 
2. On the Preferences tab, click Calendar Options as shown in the figure. 
3. Click Add Holidays. 
4. Place a check beside the appropriate country/countries. 
5. Click OK. 
6. Click OK to close the Calendar Options dialog box. 
7. Click OK to close the Options dialog box.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Office FrontPage 2003
A wealth of tips, tricks, and resources for developing your FrontPage™ website.
http://tinyurl.com/3ry3q 

The same for Frontpage™ 2002
http://tinyurl.com/8r59f 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Disable error reporting in Windows XP™
When an error is generated in Windows XP, a dialog box will appear asking whether or not you
want to send an error report. If you have already sent in a report for a recurring problem or if
you find this to be an annoyance, you can disable error reporting altogether. To accomplish
this, you have to open the System Configuration Utility.

1. Click Start and select Run. 
2. Type in msconfig and click OK. The System Configuration Dialog box appears. 
3. Click the Services tab. 
4. Clear the check box beside the Error Reporting Service. 
5. Click OK. 
6. Click Restart.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://tinyurl.com/3ry3q
http://tinyurl.com/8r59f
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Create your own PDF documents
Portable Document Format (PDF) is the de facto
standard for the secure and reliable distribution and
exchange of electronic documents and forms around
the world.  CutePDF Writer (formerly CutePDF Printer)
is the free version of commercial PDF creation
software (expensive). CutePDF Writer installs itself as
a "printer subsystem". This enables virtually any
Windows applications (must be able to print) to
create professional quality PDF documents - with just
a push of a button. The site promises no watermarks
or popups.
http://www.cutepdf.com/Products/CutePDF/writer.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows XP™: Screen Capture
Sometimes, you need to get a snapshot of your
computer screen to insert into a Slide Show, report,
or perhaps send to someone via e-mail. Screen
captures don’t require any special software, as they are really just part of the Windows
operating system. The PrtSc button on the keyboard captures everything on the screen, while
pressing Alt-PrtSc captures just the contents of the active window. When you press the button
it may not seem like anything happened, but it did. After you captured the screen, it’s saved in
the Windows Clipboard until you paste it into something like a word processing document or a
PowerPoint slide. Choose Edit, Paste or Ctrl-V to paste the image. You can now resize or crop
it. 

If you’re pasting into Word or PowerPoint, make sure the Picture toolbar is open by going to
View, Toolbars and making sure Picture has a checkmark next to it. Then you can resize or crop
the captured image by using the appropriate buttons on the Picture toolbar. Directly pasting
into an application may not be the best way to insert the image, however. It may result in a
larger file size, and it does not give you an opportunity to edit the image itself. To modify the
file size or the image itself before inserting it, open a program such as IrfanView
(http://www.irfanview.com/; free) and paste the screen capture into the IrfanView window.
Modify it as appropriate and save the modified image. Then you can launch PowerPoint or
another application and insert the images one at a time. 
____________________________________________

WORTHY WEBSITES AND SOFTWARE

My Digital Movies is the first in a series of FREE programs built to help you get your digital
and non-digital media organized. My Digital Movies focuses on organizing your movies

http://www.cutepdf.com/Products/CutePDF/writer.asp
http://www.irfanview.com/
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regardless if it is old 8-mil, vhs, dvd, divx etc... Cataloging your movies is done in a snap with
MDM, simply by typing the title and pressing save or even better using the ONLINE WIZARD to
download and add the information automatically!
http://download.lockergnome.com/download/104130 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

"Light an Educational Fire"
Inspirational Movie about kids and education
http://www.surfnetkids.com/movie/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Operation Enduring Love
Is someone in your family in the military? Well, if that person is stationed in Iraq, you can keep
in touch via video. HomeMovie.Com's Operation Enduring Love will post videos for service
members to view. Best of all, it’s free. Simply mail in your home movie. HomeMovie will post it
on the Web – in a password-protected area, of course. Your loved one will be notified when it’s
ready to view. The video will stay up a year, and you’ll get your tape back.
http://www.operationenduringlove.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Parent Leader Blog (Web Log)
KSA Plus Communications' Parent Leadership Group maintains a blog called Parent Leader
Online. Parent Leader offers news, opinion, and resources for and about parent leaders who are
becoming advocates for better schools and for educators who want to work with such parents.
http://www.parentleaders.blogspot.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

OfficeArt AutoShapes for Office 97 (free)
This file adds 19 adjustable shapes to your Microsoft Excel, Word, PowerPoint, and Draw
toolbar. Use AutoShapes as logos, illustrations, or diagrams. After you insert your AutoShape,
right click over it to see if there is a “Edit Text” option in which case you can add/edit text.
http://tinyurl.com/5yc85 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HP Activity center
Fuel your creative side with hundreds of FREE print projects offered by HP.
http://tinyurl.com/bfr74 

http://download.lockergnome.com/download/104130
http://www.surfnetkids.com/movie/
http://www.operationenduringlove.com/
http://www.parentleaders.blogspot.com
http://tinyurl.com/5yc85
http://tinyurl.com/bfr74
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Paint.NET is a free program that started out as a student project at Washington State
University. The students’ original purpose was to supercharge Windows’ Microsoft Paint. This
program looks and feels similar to premium programs like Paint Shop Pro or Photoshop. It uses
layers and offers lots of special effects. You can make photos look like old paintings, add
motion blur for excitement, or just remove red-eye.
http://www.eecs.wsu.edu/paint.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: A PowerPoint world without bullets is possible, and beautiful
as well 
When you are called upon to make a presentation, it is possible to find a happy medium
between boring bullet points and graphic art. Truth is, you can use Microsoft PowerPoint to
create meaningful, even deep presentations. Adding a visual component to communication is
quite effective. Just figure out how to think about your message from a graphical perspective.
http://tinyurl.com/akcg6 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Interesting free music
http://www.futurecrew.com/skaven/tracker_music.shtml 

____________________________________________

JUST FOR FUN

Property Room
Today’s law enforcement agencies have property rooms full of stolen or forfeited goods. The
rightful owners are not easily identified, and once property is no longer needed as evidence, it
must be disposed of properly. Enter Property Bureau. Founded and managed by former police
officers, Property Bureau harnesses the power of the Internet to quickly move items out of
police property rooms, reduce personnel costs and generate revenue well beyond traditional
police auction methods. And there is no cost to the participating police or sheriffs department. 
http://tinyurl.com/4rla9 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free Handwriting Fonts for Teachers
http://desktoppub.about.com/od/fonts/p/schoolfree.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.eecs.wsu.edu/paint.net/
http://tinyurl.com/akcg6
http://www.futurecrew.com/skaven/tracker_music.shtml
http://tinyurl.com/4rla9
http://desktoppub.about.com/od/fonts/p/schoolfree.htm
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Google Sightseeing. Why bother seeing the world for real?
Neat satellite photos of famous and/or interesting places around the world.
http://www.shreddies.org/gmaps/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

A Day Without Technology
Imagine a day without email or Web surfing, without laptops for students to conduct research
and write papers or prepare presentations. During the next month, teachers in schools and
districts throughout the country will voluntarily power down their computers as part of the first
Technology Blackout Day, sponsored by the State Educational Technology Directors Association
(SETDA). The purpose of the day, sponsors say, is to encourage students and teachers alike to
consider the impact technology has had on their lives and on our nation. SETDA has developed
lesson plans, information sheets, and other resources discussing the role of technology in
schools and society. 
http://technologyblackoutday.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

College University
(discovered from http://www.jakeludington.com/index.html) 
You don't need to be a college grad to appreciate the sophomoric humor of this long running
cartoon. For nine glorious episodes, the adventures of Mike and Parks bumbling their way
through college are explored with a combination of optimism and cynicism that's often witty
and frequently absurd. From their initial trip to CU through their recent encounter with rock
band O.A.R., Mike and Parks live in a world filled with pop culture references that could only
work in a Flash cartoon. The series achieved enough popularity to be considered for a movie
plot and is currently under consideration for a pilot project. If you've ever wondered what it
might be like to attend a university where co-ed means humans and monkeys learning
side-by-side in proximity to the city dump, this is a cartoon series right up your alley.
http://tinyurl.com/7r8ac 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mother's Day Coupon Book and Printables
Moms ... Point your children to this site. Here's a printable coupon book they can make for you.
http://homeschooling.about.com/b/a/163465.htm 
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I think there is a world market for maybe five computers. 
- IBM Chairman Thomas Watson, 1943

Never let a computer know you're in a hurry. 
- Anonymous 
____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: Rosemary, a SchoolCounselor.com newsletter reader, asks, “I use
PowerPoint a lot.  However I do not like the font that is pre-selected
by Microsoft.  How can I select the font I want and have it for all
slides?

A: To change your font in the entire slide:

1.   Open your PowerPoint presentation.    
2.   Click anywhere in any slide.  
3.   Go to the Format menu and select Replace Fonts.  
4.   Select the font you want to use from the drop-down menu below the word "With."  
5.   Click Replace. All of the fonts on all of the slides in your presentation will change to the font
you selected. 

Q: Relatedly, how do I move slides from one presentation into another and keep the font and
format that is on the original slide?

A: Good question, I wish I knew the answer to this one a long time ago, would have saved me
a great deal of time over the years. Here you go: 

1. Stay in the original file, the one into which you want to insert slides (actually, wer’re not
going to insert, we’re going to import).
2. Click Insert and select Slides from File
3. Click on Browse and find the PowerPoint file which has the slides you want to import. 
4. Pick the individual slides you want to import (hold the CTRL key down if you choose more
than one). If you want to import all the slides, all you have to do is click on the Import All
button at this point. 
5. Make sure that the Keep Source Formatting box is NOT checked.
6. Click Insert.

__________________________________________

TIPS AND TRICKS

http://www.magicaljellybean.com/keyfinder.shtml
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Microsoft Word™ Thesaurus
Highlight a word, right click over it, choose Synonyms, and pick the word you want to use to
replace your highlighted word.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Background Choices
Choose your background based on a room's lighting: While conventional wisdom is to design
with a dark background when you plan to project your slideshow onto a screen, in reality, the
best background has to do with the presentation location. Although light text on a dark
background looks best in a dark or slightly darkened room, in a light room the dark background
may look so faded that light text may not show up as well. For this kind of situation, it doesn't
hurt to try dark text on a lighter background.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Black out or white out a screen.
If you stop to discuss a point and don't want people staring at the screen, black it out. Press
the B key. In a light room, you can also white it out – press W. Press B or W again (or the
Escape key) to continue your presentation.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Find a person’s email address .. 
Although the results are not always accurate, it’s worth a try. Here are several online e-mail
address directories.

-- http://www.addresses.com/ 
-- http://www.infospace.com/home/white-pages/email-search 
-- http://www.whowhere.lycos.com 
-- http://www.switchboard.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word Brochure Templates
Create your own professional quality brochures and flyers.
http://www.hp.com/sbso/productivity/office/brochure.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tips for Usinng Microsoft Word™ 

http://www.addresses.com/
http://www.infospace.com/home/white-pages/email-search
http://www.whowhere.lycos.com
http://www.switchboard.com
http://www.hp.com/sbso/productivity/office/brochure.html
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No matter how long you’ve been using Microsoft Word, there are probably some new
techniques you can learn to help you work faster and smarter. Check these tips to see if there
is something that will make your life easier. This is an 8-page PDF docment with screenshots,
very nice. 
http://tinyurl.com/9swxb 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Respond effectively to E-mail Messages.
Excellent tips for responsibly processing your email.
http://tinyurl.com/c8vef 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Scheme preys on people who mistype 'Google.com'
Important to read this.
http://tinyurl.com/8aduj 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free Software Suite 
The Open CD site offers for free a wonderful collection of just about every application software
product you need to run a PC. Many of these substitute admirably for expensive commercial
products. There is Abi Word as an alternative for MS Word, OpenOffice for MS Office XP,
ThunderBird for Outlook, The Gimp for Adobe Photoshop, 7-zip for WinZIP are many more. 
http://theopencd.sunsite.dk/programs/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free Sticky Notes Utility 
ATnotes is a neat implementation that features configurable alarms, resizable windows, variable
fonts and a host of other useful features. 
http://atnotes.fr.st/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
Phishing Stinks
A must read! Just when you thought you’d taken all necessary precautions, the bad guys are
one step ahead. Did you know that phishers can hijack your browser, even if you type the
correct URL in the address bar? Read more at:
http://tinyurl.com/bpqd5 

http://tinyurl.com/9swxb
http://tinyurl.com/c8vef
http://tinyurl.com/8aduj
http://theopencd.sunsite.dk/programs/
http://atnotes.fr.st/
http://tinyurl.com/bpqd5
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

FraudEliminator Toolbar is an Internet Explorer toolbar that blocks fraud and
phishing Web sites, using a constantly updated blacklist and artificial intelligence to detect
and stop fraud. The FraudEliminator toolbar also displays data for every Web site you access,
including what country it is hosted in, so you can see if a site claiming to be in New York is
actually hosted in China. Other features include the capability to report fraudulent sites, a
pop-up blocker, true URL display, and an integrated search field. The Pro version of
FraudEliminator ($19.99) features more frequent fraud updates, has no Buy messages, and
helps support ongoing development work on the product.
Free Version: http://www.fraudeliminator.com/ 
Pro Version: http://tinyurl.com/7m6b2 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Photo Story 3
Bring your digital photos to life with Photo Story 3 for Windows (Free)
http://tinyurl.com/4f869 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Template Basics in Microsoft Word.
http://www.addbalance.com/usersguide/templates.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tech Encyclopedia on globetechnology.com
Supplied by the Computer Language Company Inc., it has more than 18,000 definitions and
explanations written in plain English on topics ranging from PCs, Macs, UNIX, networking,
client/server, graphics, multimedia, Internet, World Wide Web, objects, major products and
vendors, acronyms, buzzwords ... and much, much more.
http://www.globetechnology.com/site/tech_encyclopedia.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

A9.com
Recently hatched, this search engine created by an Amazon.com spin-off, conducts general
Web searches but also a separate book search just in case you're wondering what Amazon has
in store on the subject. Book results are kept under a separate tab, and include links to
full-page views, part of Amazon's nifty Search Inside the Book offering, though you have to be
a registered user of Amazon to access them.
http://a9.com/ 

http://www.fraudeliminator.com/
http://tinyurl.com/7m6b2
http://tinyurl.com/4f869
http://www.addbalance.com/usersguide/templates.htm
http://www.globetechnology.com/site/tech_encyclopedia.html
http://a9.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Answers.com
If you're looking for an actual answer to a question on the Web—not just a list of links to sites
where you might find the answer—give GuruNet's Answers.com a spin. It provides answers on
over a million topics, drawn from a database of over 100 reference sources.
http://www.answers.com/ 

Here is what Answers.com reports about the phrase “school counseling”
http://tinyurl.com/b2w3x 

____________________________________________

JUST FOR FUN

Longevity Game
Have you ever wondered how long you’ll live? It’s impossible for anyone to know for sure. But
you can get an idea based on your lifestyle.
http://www.nmfn.com/tnetwork/longevity_game_popup.html  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Guess-the-Google
You’re presented with a grid of pictures gathered from Google’s Image Search. The trick is,
they’re all results from the same search term. The goal of the game is to guess the search
term.
http://grant.robinson.name/projects/guess-the-google/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Flyguy
A delightful bit of interactive flash. Wait a moment for the page to load then use your arrow
keys to send the nice line-drawn guy with curly black hair gliding among the clouds. Stay close
to Earth and you'll encounter various other flying objects and individuals, or head straight up
into outer space. Eventually you'll find yourself on a tropical island with a girl and a monkey
dancing the hula. It's not a bad place to be.
http://www.trevorvanmeter.com/flyguy/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.answers.com/
http://tinyurl.com/b2w3x
http://www.nmfn.com/tnetwork/longevity_game_popup.html
http://grant.robinson.name/projects/guess-the-google/
http://www.trevorvanmeter.com/flyguy/
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Newseum.org/newsmania
Try this trivia quiz from the interactive museum of news. There are three levels: intern, reporter
and editor, and if you don't answer fast enough, host Rita will scold you.
http://www.newseum.org/newsmania/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FFFBI.com
The home of "The Fin, Fur and Feather Bureau of Investigation" seeks to teach kids
problem-solving and critical-thinking skills while introducing them to other places and cultures.
To participate, you must choose a mission, follow instructions and answer questions to help foil
evil plots. Cute and clever.
http://www.fffbi.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Bubble Trouble
Fun game (use your left and right arrow keys to move and your space bar to shoot the bubble).
http://tinyurl.com/9ncjh 

http://www.newseum.org/newsmania/
http://www.fffbi.com/
http://tinyurl.com/9ncjh
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SPECIAL POSTERS FOR 
SCHOOL COUNSELORS

SchoolCounselor.com: #38 - May 16, 2005

Those parts of the system that you can hit with a
hammer (not advised) are called hardware; those
program instructions that you can only curse at are called
software.  ~Author Unknown

I haven't lost my mind; I have a tape back-up
somewhere.  ~Author Unknown

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: I need to send a large file (about 20 Mb, I think) to
someone and I need to get it there in a hurry. My email
system keeps sending it back and reports that it is too
large. I could burn it on CD and send it via regular mail
although that will take too long. What else can I do?

A: Most e-mail systems, especially in schools and
organizations where there are many users, have limits to
the size of attachments that are either sent and/or received. Some systems have quit allowing
their users to receive any attachments at all given the threat of computer viruses. There are
various solutions or work-arounds to this problem, I’ll tell you about four of them:

First, you can sign up for an alternate e-mail account that has a more generous attachment size
limit. For instance, a free Yahoo! email account allows for a 10Mb file attachment. Of course,
your school or organization network must allow you to log in to this account (i.e., not have it
blocked). 

Second, instead of sending the file via email, put it up on the web and have your recipient
download it after you email him/her the download address. To do this, you need to have access
to a folder on your school’s web server. Suppose the name of your folder was “downloads,” the
name of your file is career-unit.ppt, and your school’s domain name is
www.yourschool.k12.fl.us. The link to this file would then be
http://www.yourschool.k12.fl.us/downloads/career-unit.ppt. Make sure to remove all spaces in
the file name because browsers will convert spaces to percentage signs (%) which is why you
sometimes see website addresses such as www.example.com/the%file%in%question.doc. Any
file you put in that folder is accessible over the web for anyone, so go in and delete it once you
know that your friend or colleague has downloaded it.

http://www.schoolcounselor.com/posters.htm
http://www.schoolcounselor.com/posters.htm
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A third way to send a file to another computer is through instant messaging (IM). There are
many IM programs out there and some are not compatible with others. Visit
http://www.viewz.com/features/imguide.shtml for a guide to instant messaging. I recommend
a free IM program called Trillian Basic (http://www.ceruleanstudios.com/) which supports many
other formats including AIM, ICQ, MSN, Yahoo Messenger, and IRC.

Fourth, (and probably easiest), just use a free file transfer service such as YouSendIt
(http://www.yousendit.com/). This web based service lets you send files up to a whopping
1GB; your recipients get an easy download link by e-mail. YouSendIt can send securely and
scans files for viruses. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: When I type a website address in Microsoft Word™, the program automatically turns them
into a hyperlink. How do I turn off the automatic URLs? 

A: Follow these steps:

1. Choose AutoCorrect (or AutoCorrect Options) from the Tools menu. 
2. Click on the AutoFormat As You Type tab. 
3. Under Replace As You Type, clear the Internet and network paths with hyperlink check box. 

If you didn't turn off AutoCorrect before you started typing and now you have a document full
of hyperlinks that you don't want, you can turn them off, either one at a time, or all at once. To
turn a link off, right-click on the link, select Hyperlink from the pop-up menu, and then select
Remove Hyperlink. To remove all links from the document, choose Select All from the Edit
menu or press [Ctrl]+[A], and then press [Ctrl]+[6] (the number 6, not F6) to remove all
hyperlinks. 
 
____________________________________________

TIPS AND TRICKS

emailStripper
emailStripper is a free program for cleaning the ">" and other formatting characters out of your
emails. It will restore "forwarded" or "replied" emails back to their original state so they're
easier to read.
http://www.papercut.biz/emailStripper.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.viewz.com/features/imguide.shtml
http://www.ceruleanstudios.com/
http://www.yousendit.com/
http://www.papercut.biz/emailStripper.htm


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 111 of 167

Spit-and-Polish Your PowerPoint Pitch
Six Last-Minute Tips for a Perfect Presentation. An excerpt: Testing, one, two, three. Often,
when testing a slide show, you'll want to run your test from the current slide forward. To do
this, click the Slide Show View button in the bottom left corner of the screen -- it plays the
presentation beginning with the current slide. Better still, hold the Ctrl key when you click the
Slide Show View button, and the show plays in a small window on the screen, letting you move
between PowerPoint and the show to make small changes if required. The hold-the-Ctrl-key
trick also works when you click View Show on the Slide Show menu, displaying the entire
presentation in a small window. 
http://www.winplanet.com/article/1844-.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Outlook™: Print Blank Calendars
You can use Outlook to print a blank calendar. Blank calendars may be useful to take notes on
or to consult when you meet to discuss a project with your team.

1. On the File menu, point to New, and then click Folder. 
2. Type a name for the folder. 
3. In the Folder contains list, click Calendar Items. 
4. In the Select where to place the folder list, click Calendar, and then click OK. 
5. On the Go menu, click Folder List. 
6. In the Folder List, click the new folder you just created. 
7. On the File menu, point to Page setup, and then click the print style you want. 
8. Select the print style options you want, and then click Print. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Outlook™: Jump to a Date

To jump to a particular date in your Outlook calendar, select Go | Go to Date from the Outlook
menu, or press Ctrl+G to open the Go To Date dialog. Select the date you want from the
calendar, or instead of choosing a date, type text describing the date. For instance, type “Last
day of the month,” or “fourth of July,” or even “New Year’s Eve” to jump there.

To return to Today, select Go, then Today from the Outlook menu, or click the “Today” icon on
the toolbar. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Shrink to Fit
If you’ve ever written a document found that two or three lines have spilled over to a new
page, this feature is for you.  After you have finished your document and you are ready to

http://www.winplanet.com/article/1844-.htm
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print, go into Print Preview. You can get there by clicking on "File" in the menu bar, then down
to "Print Preview", or click on the "Print Preview" button, the one with the magnifying glass
over the sheet of paper. Once you are in Print Preview mode, you will see the sad and lonely
lines. Let’s rejoin them with the rest of the group. There is a little button called the "Shrink to
Fit" button. It looks like three pieces of paper, two darker ones and one white one, with a
curved arrow from the two to the one. This is the shrink to fit button and it is your friend. Click
it and the two pages will become one! 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Internet Explorer™
Printing (or not printing) the Web page Background in Internet Explorer
http://tinyurl.com/7dyha 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Inserting Special Characters.
Many Word users don't realize how easy it is to insert special characters such as dingbats and
accented letters. There are at least four ways to do it: through the Symbol dialog, using
shortcut keys, automatically with AutoCorrect, or by direct keypad entry. Visit this website for
detailed instructions.
http://word.mvps.org/FAQs/General/InsertSpecChars.htm 
____________________________________________

WORTHY WEBSITES AND SOFTWARE

FraudEliminator Toolbar is an Internet Explorer toolbar that blocks fraud and phishing Web
sites, using a constantly updated blacklist and artificial intelligence to detect and stop fraud.
The FraudEliminator toolbar also displays data for every Web site you access, including what
country it is hosted in, so you can see if a site claiming to be in New York is actually hosted in
China. Other features include the capability to report fraudulent sites, a pop-up blocker, true
URL display, and an integrated search field. The Pro version of FraudEliminator ($19.99)
features more frequent fraud updates, has no Buy messages, and helps support ongoing
development work on the product.
Free Version: http://www.fraudeliminator.com/ 
Pro Version: http://tinyurl.com/7m6b2 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Avant Browser
Have you ever tried surfing with a tabbed web browser? Try Avant Browser, an upgrade to
Internet Explorer. Avant Browser is a fast, stable, user-friendly, versatile multi-window browser.
Now, Avant Browser is available in 39 languages. Avant Browser is freeware. That's right. 100%

http://tinyurl.com/7dyha
http://word.mvps.org/FAQs/General/InsertSpecChars.htm
http://www.fraudeliminator.com/
http://tinyurl.com/7m6b2
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Free! No cost to you ever. No limitations. No Adware. No Spyware. You can donate if you want,
but it's certainly not required.
http://www.avantbrowser.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Cursor XP
Cursor XP is free a utility that allows you to jazz up the cursors you use to mouse around with
Windows. CursorXP integrates tightly into Windows, providing you with additional tabs on your
Mouse control panel that let you access additional features. You can improve the look of your
cursor by choosing graphical, animated options. You can add special effects that come to life
when you click or take other actions. And then, and only then, you can say you've done it all.
http://www.stardock.com/products/cursorxp/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mail2Web
Without even making you register, Mail2Web lets you check almost any e-mail account from
virtually anywhere. Enter your address and password and voilà, there's your mail. If you
register, you can store your e-mail server names and get a personal Mail2Web home page.
http://www.mail2web.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

JAlbum 
This gallery software makes web albums of your digital images. JAlbum aims to be the easiest
to use and most powerful tool in this category - and free! JAlbum runs on Windows, Mac OS X,
Linux and others and speaks 22 languages. Today JAlbum is mentioned over 1,600,000 times
on the Internet (Google/Altavista) and this site has over 6,000 visitors per day and a live
community. I hope you find it your tool of choice for sharing images. 
http://jalbum.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Animated Graphics galore.
These are smaller which work very well to enhance emails.
http://www.millan.net/anims/giffar.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Professional Development Tracker Template
http://tinyurl.com/8mm7l 

http://www.avantbrowser.com/
http://www.stardock.com/products/cursorxp/
http://www.mail2web.com/
http://jalbum.net/
http://www.millan.net/anims/giffar.html
http://tinyurl.com/8mm7l
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

More Useful Excel templates
http://www.vertex42.com/ExcelTemplates/ 

____________________________________________

JUST FOR FUN

BananaSlug
Google returns exactly what you want, almost every time. But that can be boring, can't it?
BananaSlug takes a standard search and makes it weird by adding one random word chosen
from a variety of categories. A search on the word computer plus a random word from the
Themes from Shakespeare category yielded articles on the science of repentance—and then
downloadable April Fool's pranks. How neat is that?
http://www.bananaslug.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Bunch of online games, some are classic.
http://www.jimbogames.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Are you ready to take the JEOPARDY! Challenge?
http://zone.msn.com/en/jeopardy/default.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What’s on sale this week?
Sales, specials, and deals in your area.
http://www.shoplocal.com/ 

____________________________________________

http://www.vertex42.com/ExcelTemplates/
http://www.bananaslug.com/
http://www.jimbogames.com/
http://zone.msn.com/en/jeopardy/default.htm
http://www.shoplocal.com/
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SchoolCounselor.com: #39 - May 30, 2005

The question of whether computers can think is just like the question of
whether submarines can swim.  - Edsger W. Dijkstra

Give a person a fish and you feed them for a day; teach that person to
use the Internet and they won't bother you for weeks.  - Author
Unknown

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: What is phishing?

A: Excellent and very important question. According to the Webopedia: (fish'ing) (n.) The act
of sending an e-mail to a user falsely claiming to be an established legitimate enterprise in an
attempt to scam the user into surrendering private information that will be used for identity
theft. The e-mail directs the user to visit a Web site where they are asked to update personal
information, such as passwords and credit card, social security, and bank account numbers,
that the legitimate organization already has. The Web site, however, is bogus and set up only
to steal the user’s information. For example, 2003 saw the proliferation of a phishing scam in
which users received e-mails supposedly from eBay claiming that the user’s account was about
to be suspended unless he clicked on the provided link and updated the credit card information
that the genuine eBay already had. Because it is relatively simple to make a Web site look like a
legitimate organizations site by mimicking the HTML code, the scam counted on people being
tricked into thinking they were actually being contacted by eBay and were subsequently going
to eBay’s site to update their account information. By spamming large groups of people, the
“phisher” counted on the e-mail being read by a percentage of people who actually had listed
credit card numbers with eBay legitimately.  Phishing, also referred to as brand spoofing or
carding, is a variation on “fishing,” the idea being that bait is thrown out with the hopes that
while most will ignore the bait, some will be tempted into biting. 

A few websites to check out for more details about preventing phishing:

• Anti-phisihing Brochure from MSN.
• How Not to Get Hooked by a ‘Phishing’ Scam from the Federal Trade Commission.
• An archive of real phishing scams from the Anti-Phishing Work Group.
• More examples and helpful literature about phishing from FraudWatch International. 
• Help prevent identity theft from phishing scams from Microsoft. 

http://www.webopedia.com/TERM/p/phishing.html
http://tinyurl.com/8438y
http://www.ftc.gov/bcp/conline/pubs/alerts/phishingalrt.htm
http://www.antiphishing.org/phishing_archive.html
http://www.fraudwatchinternational.com/internet/phishing.shtml
http://www.microsoft.com/athome/security/email/phishing.mspx
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Let me emphasize ... Never open an e-mail link that asks for your personal information. If you
must, open a browser and type in the address yourself helping to ensure that you go to the
legitimate website instead of the spoof version. Companies do not ask for you to update or
confirm sensitive information over e-mail, period. 

____________________________________________

TIPS AND TRICKS

Microsoft Powerpoint™: Keyboard Shortcuts
Keyboard shortcuts are a great way of performing little tasks more easily. Instead of having to
reach for your mouse, you can press two or three keystrokes. Here are a few of the most
common commands in PowerPoint and their respective keyboard shortcuts. 

Ctrl-M: New slide 
Ctrl-D: Duplicate the current slide 
Ctrl-Shift-C: Copy Autoshape style 
Ctrl-Shift-V: Paste Autoshape style 
Ctrl-Shift G: Group objects 
Ctrl-Shift H: Ungroup objects 
Shift-F9: Toggle the grid on and off 
Alt-F9: Toggle the guides on and off 
F5: Start presentation 
Right arrow: Next slide or build 
Left arrow: Previous slide or build 
Home: First slide 
End: Last slide

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Paste Special  (Nugget from Lockergnome)

Text within a specific document or text that you find on a Web page usually has its own
typeface, color, and font size. When you copy text with different formatting into your own
document, Word will automatically copy the text with its original typeface, color, and font size.
However, you may want the new text to match the formatting in document that you are
pasting it into to. This is where the Paste Special function comes into play. Once you copy the
text from the original document or from the Web, open the destination document. From the
Edit menu, click Paste Special. The Paste Special dialog box will immediately appear. From the
list of options, select Unformatted Text and click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.schoolcounselor.com
http://channels.lockergnome.com/windows/archives/20050517_paste_special_in_word_2002.phtml
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Microsoft Word™: Save and Close Multiple Word Documents Simultaneously
(Nugget from TechRepublic)

When you have numerous Microsoft Word documents open at one time, it isn't necessary to
save and close each document individually before exiting Word. You can save all of the Word
documents at once by pressing [Shift] and then going to File, then Save All. Word will save all
of the changes you made to the open documents at once. The Save As dialog box will display
for any files that have not already been named. You can close multiple documents in one fell
swoop by pressing [Shift] and then going to File, then Close All. If any of your documents
contain unsaved changes, Word will ask you whether you want to save your changes before
closing the particular file.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Print on Multiple Pages
Find out how you can use Microsoft Word's Zoom feature to print as many as 16 pages on one
sheet of paper. This handy tip will help you conserve paper and possibly even save on postage
costs. Zoom automatically reduces the scale to fit four pages on each sheet. Zoom reduces the
size of your printout without changing the document's format or page layout settings.

1. Go to File, then Print. 
2. In the Zoom section (look toward the bottom right), select 4 Pages from the Pages Per Sheet
drop-down list. 
3. Make any other print selections, and click OK. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Inserting a Footnote or Endnote

1. Place the cursor where you want the note reference mark, then choose Footnote (or
Reference, then Footnote) from the Insert menu
2. Select the Footnote or Endnote radio button.
3. Optional: Click the Options button to change the placement, number format, starting
number, and section footnote settings. 
4. Click OK. An editing screen appears at the bottom of the page (Normal View) or the cursor
moves to the bottom of the page (Print Layout view). Enter your note text, then click in the
document to return to the note reference mark.

To delete a note, you work with the note reference mark, not the text in the note pane. Select
the reference mark of the note you want to delete, then press the [Delete] key.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://techrepublic.com.com/5100-10877_11-5710127.html?tag=nl.e056
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Microsoft Outlook™: Add a signature to all of your sent e-mails
This is a wonderful sample tutorial created by a program called Demo Builder. Other samples
here. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Autofit Columns
There are two ways to make your column width automatically fit your largest cell contents. The
first way is to click on any cell in the column, choose Format, Column, and Autofit.  An easier
way to do this is to simply double click the line between the column letters at the top of the
sheet. So, for instance, if I wanted to autofit the width of column C, I would double click on the
grey line between column C and D at the top of the sheet. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Photo Album
Great tutorial for PowerPoint's excellent Photo Album feature.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

How to find your kid’s online blog
Your children (or students) may be opening themselves up online. More children than ever are
using online journals (blogs) to share their lives. Those blogs could tip you off to major
influences in your child's life.

____________________________________________

WORTHY WEBSITES AND SOFTWARE

SchoolCounselor.com: Updated links regarding online safety/security for children.
http://www.schoolcounselor.com/safetynetlinks.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Wireless Amber Alert 
The Amber Alert system used by police to let the public know when a child is missing is being
expanded to mobile phones.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Sober Worm Spawns German Spam
I usually don’t include news tidbits although this one will probably explain a great deal. I know
my spam filter is working overtime these days. 

http://www.demo-builder.com/samples/oesignature.html
http://www.demo-builder.com/samples.html
http://www.demo-builder.com/samples.html
http://www.worldstart.com/tips/tips.php/704
http://pubs.logicalexpressions.com/Pub0009/LPMArticle.asp?ID=191
http://www.komando.com/tips_show.asp?showID=8797
http://www.schoolcounselor.com/safetynetlinks.asp
https://www.wirelessamberalerts.org/index.jsp
http://www.pcworld.com/news/article/0,aid,120846,tk,cx051705a,00.asp
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Excellent websites for learning Microsoft
Excel™

< Florida Gulf Coast University
< University of South Dakota
< BayCon Group
< Internet4Classrooms
< FunctionX
< Iowa State University
< Western Carolina Univeristy
< Microsoft In & Out of the Classroom (this

is a downloadable book). 
< Mr. Excel

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Charts
A gallery of charts and instructions for how to create them. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Classrooms that Excel Resources
Classrooms that Excel will introduce Microsoft Excel spreadsheet procedures that may be
integrated into instruction across the curriculum.  Participants will develop lessons and activities
that engage students - collect data, organizing data, compute results, summarize, chart, and
present analysis.  Basic Excel procedures are easy to learn and offers a variety of opportunities
for teachers to implement real world problem solving and applications. Lots of resources too!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Office™: Learning through Quizzes
Test your knowledge of various Microsoft Office™ applications. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Sweepi
Sweepi allows you to clean common computer junk files and Internet tracks that can build up
over time. The program comes with an interface that allows you to select the areas to be
cleaned, as well as a wizard that can guide you through the cleaning process, and also offers a
quick-clean feature. In addition to the cleaning features, Sweepi also includes a startup
manager (called BootManager) that enables you to view and optionally remove or disable

http://www.fgcu.edu/support/office2000/excel/
http://www.usd.edu/trio/tut/excel/
http://www.baycongroup.com/el0.htm
http://www.internet4classrooms.com/on-line_excel.htm
http://www.functionx.com/excel/
http://www.extension.iastate.edu/Pages/Excel/homepage.html
http://www.wcu.edu/ccenter_inf/CatOnline/MSEX/
http://www.microsoft.com/education/?ID=Excel97Tutorial
http://www.mrexcel.com/
http://www.pdbook.com/index.php/charts/
http://www.sabine.k12.la.us/class/default.htm
http://www.sabine.k12.la.us/class/excel_resources.htm
http://office.microsoft.com/en-us/FX010380471033.aspx
http://www.snapfilespro.com/gnomeapp.php?id=109181
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programs that start automatically whenever you boot your computer. Furthermore, the program
includes secure file deletion and a tool to find broken shortcuts.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft CD Slide Show Generator for XP
With this PowerToy you can view images burned to a CD as a slide show. The Generator works
downlevel on Windows 9x machines as well.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Parents express concern over teen blogging
By G. Jeffrey MacDonald, The Christian Science Monitor

____________________________________________

JUST FOR FUN

Word Search Puzzle Generator
The site is called Word Search Puzzle Generator, and is one of the WorldVillage family of games
sites. At this site, you can design your own word search puzzles. It is a very simple process.
You supply a list of words, choose a puzzle size, enter your words, make mouse click, and
presto, it's done. You can make them as large or as small as you want. Any subject is available,
and you could even use different languages. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

World Wind
World Wind lets you zoom from satellite altitude into any place on Earth. Leveraging Landsat
satellite imagery and Shuttle Radar Topography Mission data, World Wind lets you experience
Earth terrain in visually rich 3D, just as if you were really there. 
Virtually visit any place in the world. Look across the Andes, into the Grand Canyon, over the
Alps, or along the African Sahara.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Anagram Server
Did you know that parliament is an anagram of partial men? Or, Clint Eastwood an anagram of
Old West Action? Someone once said, "All the life's wisdom can be found in anagrams.
Anagrams never lie." Here is your chance to discover the wisdom of anagrams. Enter the word
or phrase in the form below and press button. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://download.microsoft.com/download/whistler/Install/2/WXP/EN-US/SlideshowPowertoySetup.exe
http://www.usatoday.com/tech/news/internetprivacy/2005-05-25-teen-blogging_x.htm
http://www.worldvillage.com/wv/gamezone/puzzlegen/
http://worldwind.arc.nasa.gov/
http://www.wordsmith.org/anagram/index.html
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Elevator Moods
A bit weird although quite amusing ... a series of short films set in elevators.

http://www.elevatormoods.com/
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SchoolCounselor.com: #40 - June 10, 2005 

Bill Gates is a very rich man today .. and do you want to
know why? The answer is one word: versions. - Dave Barry

The Internet is so big, so powerful and pointless that for
some people it is a complete substitute for life. - Andrew
Brown

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: What's are the differences among DVD+R, DVD-R, DVD-RW, DVD+RW, and DVD-RAM?
A: Found a great website that does a wonderful job explaining this.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I like to print booklets that parents can take home on different topics. Right now, I print my
document, shrink it with the copy machine, cut each page in half, rearrange the order so that it
comes out correctly when I fold the final product in half, and then copy. Is there a way to
simply print it out in booklet form so that I can then just copy, fold and staple?

A: Yes, this is a great time saver:

Microsoft Word™™ 2002: Printing in Booklet Form
(from the Microsoft website)
Word 2002 has a great new feature that allows a document to be printed as a booklet: The
pages will print so that two pages appear on each sheet of paper, in the right order for folding
together. In other words, pages 4 and 1 will print next to each other on the same page so that
when students fold the pages, the correct pages appear in the correct sequence. Just print,
fold, and start reading! 

1. Start with a blank document in Word 2002. 
2. Before you dive in and start typing, properly set up the pages for printing a booklet. To do
this, select Page Setup from the File menu. 
3. On the Margins tab, select Book fold in the Multiple pages drop-down list. Microsoft Word™
will automatically set the page orientation to be sideways (that is, Landscape). 
4. Set the Top and Bottom margins to be the way you want them. Also set the Inside and
Outside margins (the spacing between the text and the left or right edge of the page). 
5. Assign a small value (for example, 0.25") to the Gutter margin, which is the space between
the two facing pages when you fold your booklet. 

http://www.askdavetaylor.com/whats_the_difference_between_dvdr_dvdr_dvdrw_dvdrw_and_dvdram.html
http://www.microsoft.com/Education/CreateBooklet.aspx
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6. Notice that the numbers in the Sheets per booklet drop-down list are in increments of 4.
(Each sheet of paper has left and right facing pages on one side, and left and right facing
pages on the other side.) Either select the correct number of pages in your booklet or just
select All, and then click OK. 
7. Type your text on each page of the booklet. Format the text as needed by selecting the font,
size, style, and so on. 
8. When you are ready to print your booklet, select Print from the File menu. 
9. If your printer does not print on both sides of the page automatically, select Manual duplex.
After the first page prints, you will be prompted to place the same page back into the printer so
that the second page will print on the back of the first. Just be sure to place the page in your
printer so that it prints on the back and facing in the right direction. (After you do one test
page, you'll know how to insert the page from then on.) 
10. Place your pages together; then bind them using whatever method you had in mind (for
example, staples, ribbon, or glue). Fold your pages down the middle, and then sit back and
enjoy reading your new book! 

Here’s how you do it in WordPerfect ...

WordPerfect 10™ - Printing in Booklet form 
After you have your document all typed up and ready to print, you will need to divide your
pages (2 columns and 1 row). To do this:

1. Click File 
2. Click Page Setup 
3. Click on the Layout tab at the top of the window 
4. In the Divide Pages area type a value in any of those boxes. Columns will divide the page
from top to bottom and rows will divide the page from side to side.  A standard booklet is 2
columns and one row). 

After you have divided the pages you will need to manually set WordPerfect to print doubled
sided because by default it will only print single sided. To do this:

1. Click on File 
2. Click Print. 
3. Click on the Layout tab. 
4. Under the two-sided printing area click Book (side to side). 
4. You will also need to put a check mark next to print as booklet.
5. Finally, print your document. 

One last thing ... if you don’t feel like manually duplexing (getting your printer to print on one
side then feeding it to print on the other, you can have your copier do the work. When you
copy your booklet, choose 1 to 2 sided copying and select the “Calendar” option (instead of the
“Book” option. 
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____________________________________________

Updated at SchoolCounselor.com:

*  PDF document providing a complete guide to training and resource.
*  Lesson plans continues to be updated.
*  Amazon.com links to resources about one of my favorite topic (Solution Focused Brief
Counseling and Consultation).
*  New poll about your perceived level of tech literacy.

____________________________________________

TIPS AND TRICKS

Microsoft Word™: Customize Bullets
(Nugget from Lockergnome)
You can easily create a bulleted list in your document by clicking the Bullets button on the
toolbar. Word will automatically insert the bullets into your document. By default, the bullets
are a predefined character (small, round, black dots). However, you can customize Word to use
any character you want for your bulleted lists. Here is what you need to do:

1.  Within Word, click Bullets and Numbering from the Format menu. 
2.  Click the Bullets tab. 
3.  From the available styles, select one you want to use. 
4.  Click the Customize button if you do not like the available styles. 
5.  Use the Font, Character, and Picture buttons to customize the bullets. 
6.  Click OK when you have selected the symbol you want to use. The Customize Bulleted List
dialog box appears. 
7.  Click Ok to close the dialog box.

If you have already clicked on the Bullets icon and inserted bullets in your document, you can
double click on any bullet which will bring up the same menus.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Power of the CTRL button
Tip 1: Hold down [Ctrl] and click within a sentence to quickly select the entire sentence.
Tip 2: Hold down [Ctrl] and drag selected text or an object to quickly create a copy of the text
or object.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.schoolcounselor.com
http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.schoolcounselor.com/macomb/all-sites.asp
http://www.amazon.com/exec/obidos/external-search?tag=schoolcounselorc&keyword=%22brief%20counseling%22+%22solution%20focused%22&mode=blended
http://www.schoolcounselor.com/dupoll
http://channels.lockergnome.com/windows/archives/20050530_customizing_the_bullet_type_in_word.phtml
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Microsoft Word™: Captions
(provided by Lockergnome)
You can use captions in Word documents to label
figures, tables, slides, and so on. A caption is a
label for an item that consists of two parts: the
label you select (such as Figure or Table) and a
number inserted by Word. For example, a caption
may appear as Figure 1.  Captions can be inserted
automatically when you add items to your
document or you can insert them manually.

To have Word insert caption automatically:

1. Click the Insert menu, point to Reference, and
click Caption. 
2. Click the AutoCaption button. 
3. Under the Add caption when inserting list, place
a check beside those items you want Word to
insert captions for. 
4. Use the drop down arrow beside Use Label to
select the type of label you want to use. 
5. Click OK.

If you already have items in your document, you can manually add captions. Select the item in
the document and from the Insert menu, point to Reference, and click Caption. In the Label
list, select the item you want Word to insert a caption for.

When you use the Caption feature in Word, a label and number can be assigned to each figure
in your document. By default, word assigns each figure a number starting with 1, 2, 3, and so
on. However, if you don’t want to use this number format for figures, you can change it. You
can change the number format for a caption using the following steps:

1. Within Word, select the caption you want to change. 
2. Click Insert, point to Reference, and click Caption. 
3. From the Caption dialog box, click the Numbering button. 
4. Using the drop down arrow beside Format, select the number format you want to use. For
example, you may want to use letters instead of numbers. 
5. Click OK. 
6. Click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://channels.lockergnome.com/windows/archives/20050602_using_captions_in_word_20022003.phtml
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Microsoft Excel™: Removing Hyperlinks
(from Allen Wyatt’s Excel Tips)
Got a worksheet containing several hyperlinks you want to delete? There’s no need to resort to
a macro (or even using the mouse) if you follow the simple series of steps in this tip. (This tip
works with Microsoft Excel 97, Excel 2000, Excel 2002, and Excel 2003.)

Other issues of ExcelTips have featured macros that remove all the hyperlinks in a worksheet.
If you have too few hyperlinks to justify the use of a macro (or you just don't like to deal with
macros), you may be interested in an easy way to delete hyperlinks without using macros:

1. Use the arrow keys to select the cell containing the first hyperlink. 
2. Press Ctrl+K. Excel displays the Edit Hyperlink dialog box. 
3. Click Remove Link. The dialog box disappears and the hyperlink is removed. 
4. Use the arrow keys to select the cell with the next hyperlink. 
5. Press F4. The hyperlink disappears. 
6. Repeat steps 4 and 5 to remove any other hyperlinks you want removed. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Hard Break with Text
You can break a long text entry on a spreadsheet into separate lines by positioning the cursor
in the cell entry where you want the new line to start and pressing Alt+Enter. Excel
automatically wraps the text in the cell, according to the cell's column width and the position of
the line break. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Quick Sum
Quick sum a range of cells by highlighting them and pressing Alt+= (ALT key and equal sign).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Make files Not Go to the Recycle Bin
When pressing or choosing delete to remove a program you can hold your shift key and it will
not send it to the recycle bin.

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Cmaps can be used to assess student knowledge, encourage thinking and problem solving
instead of rote learning, organize information for writing projects and help teachers write new
curricula.

http://exceltips.vitalnews.com/Pages/T1051_Removing_Hyperlinks_without_a_Macro_Take_Two.html
http://cmap.ihmc.us/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Rates of Computer and Internet Use by Children ...
NCES has just released the report, 'Rates of Computer and Internet Use by Children in Nursery
School and Students in Kindergarten Through Twelfth Grade: 2003.' This Issue Brief describes
the percentage of students in grades 12 or below who used computers or the Internet in 2003.
The Brief highlights the fact that computer and Internet use is commonplace and begins early.
Even before kindergarten, a majority of children in nursery school use computers and, and 23
percent use the Internet. Click here to go to the download page.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Online Text Analysis Tool
Get detailed statistics of your text, perfect for translators (quoting), for webmasters (ranking)
or for normal users, to know the subject of a text. Now with new features as the analysis of
words groups, finding out the keyword density, analyze the prominence of word or expressions.
Webmasters can analyze the links on their pages. 
http://textalyser.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

CBS News Video
A custom playlist lets you pick the CBSNews.com videos you want to watch and plays them one
right after the other in the order you've chosen.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

How to Backup your E-mail
Due to the different procedures used to backup emails on different e-mail programs, this
tutorial is written Outlook Express, Outlook 2000, and Netscape Messenger Mail. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

KARTOO
KartOO is a metasearch engine with a visual display. KartOO launches your query to a set of
search engines, compiles the results and shows them in a series of interactive maps. In these
maps, websites are represented by larger or smaller sized pages, depending on relevance.
When you move the pointer over these pages, the related keywords are illuminated and a brief
description of the site appears on the left side of the screen. You can refine your search by
clicking entries in a subject tree. One nice feature of Kartoo is the option to select a specific set
of search engines for your query. The animated genie is a teensy bit annoying, but this search
tool is worth a try. 
____________________________________________

http://nces.ed.gov/pubsearch/pubsinfo.asp?pubid=2005111
http://nces.ed.gov/pubsearch/pubsinfo.asp?pubid=2005111
http://textalyser.net/
http://textalyser.net/
http://www.cbsnews.com/sections/i_video/main500251.shtml
http://www.cybertechhelp.com/html/tutorials/tutorial.php/id/7
http://www.kartoo.com/
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JUST FOR FUN

Artificial intelligence, visualized
Thinking Machine 4 explores the invisible, elusive nature of thought. Play chess against a
transparent intelligence, its evolving thought process visible on the board before you. 
http://turbulence.org/spotlight/thinking/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Cuckoo Clock
It really works. Set this link up as your home page to easily keep it on all the time. Press F11 to
maximize it in Internet Explorer or Firefox.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Standard and Countdown Timer
Use this for classroom activities, classroom testing, and more.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Play a Game of Chess?
http://www.treasurevalleylife.com/games/chess.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

How about Chinese Checkers?
http://www.truantduck.com/cc/cc.swf 

____________________________________________

http://turbulence.org/spotlight/thinking/
http://pieria.forthnet.gr/~aiginio/cuckoo-clock.swf
http://www.echalk.co.uk/General/Timer/Timer.swf
http://www.treasurevalleylife.com/games/chess.swf
http://www.truantduck.com/cc/cc.swf


SchoolCounselor.com E-Newsletter Issues 20-45
©2005, Russell A. Sabella, Ph.D.

Page 129 of 167

SchoolCounselor.com: #41 - June 22, 2005

When I took office, only high energy physicists had ever
heard of what is called the Worldwide Web.... Now even
my cat has its own page. Bill Clinton, announcement of
Next Generation Internet initiative, 1996

Experience teaches only the teachable. Aldous Huxley 

FREQUENTLY ASKED QUESTIONS

Q: How do I convert Word files into another format in a batch (instead of one at a time)?

A: (From TechRepublic) As you probably know, you can use File >> Save As to convert
documents from Word to another format, such as .html or .rtf files. But if you have several
documents to convert, you can convert them all at once with the Batch Conversion Wizard.

For example, suppose you have six Word documents that you want customers to be able to
access over the Web. To convert all six files to an HTML format, follow these steps:

1. Save all six documents to a single folder. 
2. Open Word and go to File, New. 
3. In Word XP's New Document task pane, click General Templates under New From Template,
and select the Other Documents tab. (In Word 2000, go to File >> New, and select the Other
Document tab from the New dialog box.) 
4. Double-click Batch Conversion Wizard. 
5. Click Next. 
6. Choose Convert From Word To Another Format, leave HTML Document as the default, and
click Next. 
7. Specify the Source folder that contains the files you want to convert and the destination
folder where you want Word to place the converted files, and click Next. 
8. Select the files you want to convert, and click Next. 
9. Click Finish to begin the batch conversion. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: I notice that when using Google image search, I’m getting X-rated results. Is there a way to
filter this?

Many Googlers prefer not to have adult sites included in their search results, especially if
the terms they are using increase the likelihood of this happening (e.g., terms with the word

http://techrepublic.com.com/5100-10877_11-5693714.html
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sexual in them such as sexual harassment). Google's SafeSearch screens for sites that contain
pornography and explicit sexual content and eliminates them from search results. While no filter
is 100% accurate, Google's filter uses advanced proprietary technology that checks keywords
and phrases, URLs and Open Directory categories.

By default, moderate filtering is set to exclude most explicit images from Google Image
Search results. To apply Google's SafeSearch filtering to both web search and image search
results, select the strict filtering option on the web search preferences page
(http://www.google.com/preferences)  and save your preferences. This will activate stricter
filtering of images, as well as filtering of adult content in regular Google search results. To turn
off filtering completely, select the "do not filter..." option. The filtering option you select on the
Preferences page will remain on until you change and resave your preferences. You can also
adjust your SafeSearch settings on the Advanced Search
(http://www.google.com/advanced_search) or the Advanced Image Search pages
(http://www.google.com/advanced_image_search) on a per search basis.

____________________________

TIPS AND TRICKS

Google.com™
To see weather conditions and a four-day forecast for a particular U.S. location, type "weather,"
followed by the location. Usually a city name will be enough, but you may also want to include
a state or zipcode. For example, to see Palo Alto weather, you could search for "weather palo
alto, ca" or "weather palo alto 94301." Also, To use Google to get live stock quotes and
information, just enter one or more ticker symbols.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Keep Column Headings In View
(from Lockergnome)
Excel spreadsheets can grow to be very large and if you have column headings, it can be hard
to remember what each column is for as more data is entered. As you move farther down the
spreadsheet, you will no longer be able to see your column headings. If you don’t mind
scrolling up every so often to refresh your memory, you can leave things as they are. Other
wise, you can perform the simple steps below so your column headings are constantly visible.

1. Select the entire row directly below your column headings. 
2. From the Window menu, click Freeze Panes.

Your column headings are now frozen and constantly visible. You can undo this by once again
completing the steps above, only this time select Unfreeze panes.

http://www.google.com/preferences
http://www.google.com/advanced_search
http://www.google.com/advanced_image_search
http://www.schoolcounselor.com
http://www.schoolcounselor.com
http://channels.lockergnome.com/windows/archives/20050610_keep_column_headings_in_view_excel_97200020022003.phtml
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Add Line Numbers to your Document
This is especially helpful when you are collaboratively editing a document and need to refer to
different parts which may not have printed out on the same page number. Here’s how you do
it:

1. Open your document. 
2. From the File menu, click Page Setup. 
3. Select the Layout tab. 
4. Click the Line Numbers button. 
5. Click the box beside the Add line numbering option. 
6. Select any additional options you want to use. 
7. Click OK.

You can add line numbers to a specific part of your document by completing these steps:

1. Open your document and select the text you want to add line numbers to. 
2. From the File menu, click Page Setup. 
3. Click the Layout tab. 
4. Click the Line Numbers button. 
5. Click the box beside the Add line numbering option. 
6. Click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Create a Table of Contents
You can create a table of contents using the built-in Heading styles in Microsoft Word™. When
you build a table of contents, Word searches for the headings that you used in the document,
sorts them by heading level, and displays the table of contents in the document. If you are
creating a document for the Web, you can put the table of contents in a Web frame so that you
can easily navigate through the document. When you display a document in print layout view,
the table of contents includes page numbers along with the headings. When you switch to Web
layout view, the headings are displayed as hyperlinks so that you can jump directly to a topic.
To quickly navigate through a document as you view it in Word, consider using the Document
Map.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Create Movie-Style Crawling Credits
Tip courtesy of Peoria Unified School District, Glendale, Arizona.
Make a time line, a list of credits, or other lists come to life in a PowerPoint presentation by
having them crawl or scroll from the bottom of the screen off the top of the slide.

http://www.microsoft.com/Education/HowToTableofContents.aspx
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1. In a Microsoft PowerPoint presentation, create a new slide for credits or any other list that
you want to scroll from bottom to top. 
2. Type your credits or other text. Don't worry about text running off the bottom of the slide.
As a matter of fact, it should run off the bottom if you are going to have enough text to make a
crawl effect work well. 
3. Right-click the text, and choose Custom Animation from the shortcut menu. 
4. Select the text that you want to scroll. In the Custom Animation task pane, click Add Effect
(if you don’t see it right away, click on More Effects and look through all the options). Point to
Entrance, and click Credits. 
5. Click Play at any time to get an idea of how the effect will look on-screen. 
6. Now, move the text block completely off the top of the slide. When you play your
presentation, the text will crawl or scroll from the bottom of the screen and disappear off the
top. 

Tip: If you prefer to have your text disappear somewhere below the top of the slide, draw a
rectangle that extends from the top of the slide down to where you want the text to disappear.
Give the rectangle no outline and a fill that matches the background. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Gridlines
Gridlines in Excel allow you to see the different cells. By default, these lines are light gray in
color. If you want more definition, you may want to use a brighter color to define the different
cells. You can change the color of gridlines in Excel by the completing these steps:

1. Within Excel, click the Tools menu and select Options. 
2. From the View tab, verify that there is a check beside Gridlines. 
3. Use the drop down arrow beside Gridlines color and select the color you want to use. 
4. Click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Inserting Recorded Sounds to Support Text
Sometimes you’d just rather say it ... 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Drop-Cap
A drop cap is an effective way to jazz up documents, especially for student work that is posted
in the classroom, around the building, or on the school Web site or that is published a literary
book. Take a look at some books, magazines, and newspapers in the classroom or around the
house. You'll notice that many publications use the drop cap.

http://www.techlearning.com/showArticle.jhtml?articleID=20900546
http://www.microsoft.com/Education/DropCap.aspx
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Resize a graphic
without losing its aspect ratio and position.
To resize an image or graphic without losing its
aspect ratio and position, simply hold the Shift key
while resizing your image or graphic.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

How do I keep my computer safe on the
internet? 
Virii & Spyware & Worms ... oh my!

____________________________________________

WORTHY WEBSITES AND SOFTWARE

EZANALYZE is a FREE computer program designed
to enhance the capabilities of Microsoft Excel by
adding "point and click" functionality for analyzing
data and creating graphs. It works on both Macs and PC's.
http://ezanalyze.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Radio WillowWeb
Radio WillowWeb is an online radio program for kids and by kids. Each new show is called a
Willowcast. Each Willowcast can be heard on WillowWeb as an mp3 digital audio file.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Microsoft Windows Malicious Software Removal Tool 
The Microsoft Windows Malicious Software Removal Tool checks Windows XP, Windows 2000,
and Windows Server 2003 computers for and helps remove infections by specific, prevalent
malicious software—including Blaster, Sasser, and Mydoom. When the detection and removal
process is complete, the tool displays a report describing the outcome, including which, if any,
malicious software was detected and removed. The tool creates a log file named mrt.log in the
%WINDIR%\debug folder. This tool is not a replacement for an anti-virus product. To help
protect your computer, you should use an anti-virus product.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://ask-leo.com/how_do_i_keep_my_computer_safe_on_the_internet.html
http://ask-leo.com/how_do_i_keep_my_computer_safe_on_the_internet.html
http://ask-leo.com/how_do_i_keep_my_computer_safe_on_the_internet.html
http://ezanalyze.com/
http://www.mpsomaha.org/willow/radio/index.html
http://www.microsoft.com/downloads/details.aspx?FamilyID=ad724ae0-e72d-4f54-9ab3-75b8eb148356&displaylang=en
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Microsoft Frontpage™ 2002: Create a Dynamic School Calendar
This column tells you how to set up an event calendar that a school staff can update and view
from the school Web site.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Become.com
Have you ever felt frustrated when researching products on the web? Have you ever been
unable to determine the product or service that best met your needs?  The Become.com
research service is dedicated to solving these problems. Our mission is to help you make ideal
buying decisions. They find buying guides, articles, forums, reviews, specs and information
from across the web to help you buy the right product.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

StoryPlace
The Children’s Digital Library, this site is an online library of books and activities for preschool
and elementary children. There are online stories (such as Firefighters), online activities (such
as What Should Fran Wear?), and a take home activity (currently a dot-to-dot of Dottie the
Dalmatian). There are several subject areas, each with a different theme, such as Dino’s Rock,
Little Red High Tops, The Golden Ball, and The Three Country Critters. The site is available in
both English and Spanish.
http://www.storyplace.org/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tor: An Anonymous Internet Communication System
Tor is a toolset for a wide range of organizations and people that want to improve their safety
and security on the Internet. Using Tor can help you anonymize web browsing and publishing,
instant messaging, IRC, SSH, and more. Tor also provides a platform on which software
developers can build new applications with built-in anonymity, safety, and privacy features.
http://tor.eff.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Powerbullet Presenter
Powerbullet Presenter is a small, simple and free program for creating presentations in the
Flash™ format. You don't need any experience to create slick animated presentations by typing,
clicking and dragging. Powerbullet Presenter is specifically designed for creating multi-page
presentations that are commonly used in electronic sales brochures and catalogues, splash
screens, slideshows and student projects.  You can also create a self-running show, specifying
delays on each page, or you can link the timing to the sound attached to each page.  Your
presentations can be exported as an HTML page with an embedded SWF (Flash) file or as an

http://office.microsoft.com/en-us/assistance/HA010429311033.aspx
http://www.become.com/
http://www.storyplace.org/
http://www.storyplace.org/
http://tor.eff.org/
http://tor.eff.org/
http://www.powerbullet.com/
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executable file which you can run on any Windows PC. Powerbullet Presenter freeware is a
complete production tool with loads of functionality to get you up and running quickly, creating
professional Flash Presentations in minutes. However, if you need some of the extra features of
Powerbullet Presenter Plus, you can upgrade at any time at a cost of only $19.95. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

SpoofStick
SpoofStick is a simple browser extension that helps users detect spoofed (fake) websites. A
spoofed website is typically made to look like a well known, branded site (like ebay.com or
citibank.com) with a slightly different or confusing URL. The attacker then tries to trick people
into going to the spoofed site by sending out fake e-mail messages or posting links in public
places - hoping that some percentage of users won't notice the incorrect URL and give away
important information. This practice is sometimes known as “phishing".
http://www.corestreet.com/spoofstick/ 
~~~~~~~~~~~~~~~~~~~~~~~~~~~

PandaActiveScan
Check if you are safe from viruses and spyware free with Panda ActiveScan. Scans, disinfects
and eliminates over 90,000 viruses, worms and Trojans from all system devices, hard disks,
compressed files and all your e-mail folders. You don't need to install any programs, just
connect to the Internet and simply click whenever you want to check if your computer is
infected by viruses or spyware. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FTC Father’s Day Web Animation: “Don’t Let the Phishers Catch You” 
The Federal Trade  Commission has released a web animation for Fathers’ Day, featuring a 
father fish teaching his little fishies how not to fall victim to the  phishers ... 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Protection from Harmful Sites: Cloudmark SafetyBar
The Cloudmark anti-fraud toolbar will rate any web page you go to while surfing the Internet to
help you identify its credibility. If you click on a link to a harmful web page that contains
spyware, viruses, worms, identity theft or phishing attacks the Cloudmark anti-fraud toolbar will
detect the URL as being "Unsafe" and will block that page from viewing. Using a web mail
client? No problem! The Cloudmark anti-fraud toolbar will block any "Unsafe" pages from
viewing that your web mail provider's anti-spam solution hasn't caught. You no longer need to
worry about being harmed by dangerous web pages or scammed by phishing attacks! 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.corestreet.com/spoofstick/
http://www.corestreet.com/spoofstick/
http://www.pandasoftware.com/products/activescan/com/activescan_principal.htm
http://www.ftc.gov/bcp/conline/ecards/father/2005/index.html
http://www.cloudmark.com/products/safetybar/ie/
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Teenager builds hi-tech tree house
Alan Mellovitz has been working on his tree house since he was eight. It now has air
conditioning, sound systems, computers, and a host of other gadgets. The downside? There’s
no plumbing.

____________________________________________

JUST FOR FUN

Alexa: Top 100 English Websites
Alexa computes traffic rankings by analyzing the Web usage of millions of Alexa Toolbar users.
The information is sorted, sifted, anonymized, counted, and computed, until, finally, we get the
traffic rankings shown in the Alexa service.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

WayBackMachine
Check out the evolution of the SchoolCounselor.com site. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Theme Park Insider 
This is the award-winning consumers' guide where readers like you help plan your vacation with
ratings and reviews of the world's best theme and amusement parks.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FraudFrond
This website pays homage to the fake trees that disguise our cell phone towers. Have you seen
these things??!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

5 tips for photographing your kids
Our children are the most important people in our lives. And it's important to remember all their
precious moments. But time flies and they grow up so fast. So we do our best to hold onto our
little angels with photos.

____________________________________________

SchoolCounselor.com now carries posters for your office, school, or home that focus on topics
or ideas such as diversity, faith/spirituality, inspiration, landscapes, and children 
http://www.schoolcounselor.com/posters.htm 

http://abclocal.go.com/wls/news/061705_ns_treehouse.html
http://www.alexa.com/site/ds/top_sites?ts_mode=lang&lang=en
http://web.archive.org/web/*/http://www.schoolcounselor.com
http://www.themeparkinsider.com
http://www.themeparkinsider.com
http://www.fraudfrond.com/
http://www.komando.com/tips_show.asp?showID=8905
http://www.schoolcounselor.com/posters.htm
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SchoolCounselor.com: A
Friendly and Practical Guide to
the World Wide Web (2nd
edition) by Russell A. Sabella,
Ph.D. The Internet gives counselors
a vast amount of resources and a
powerful medium for connecting
with others. Following a
counselor-friendly introduction to
computers and the World Wide
Web, readers are introduced to
over 1,200 web sites and given a
practical guide to gaining access,
navigating, searching for relevant
materials, and creating websites.
Related issues of interest to both
novice and experienced users are
discussed.
http://tinyurl.com/5ttd6 

SchoolCounselor.com: #42 - July 5, 2005

I'll try being nicer if you'll try being smarter. -
Anonymous Tech Support

Imagine if every Thursday your shoes exploded if you
tied them the usual way. This happens to us all the
time with computers, and nobody thinks of
complaining. - Jeff Raskin

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: With all the problems I’ve been hearing about
personal data loss lately, do you have some tips for
protecting my identity?

A: Adapted from SchoolCounselor.com 2.0: A Friendly
and Practical Guide to the World Wide Web.  

The U.S. Federal Trade Commission says that identity
theft is its number one source of consumer complaints
- 42 percent of all complaints, in 2001. This translates into a thief stealing someone's identity,
opening accounts in the victim's name and going on a shopping spree every 79 seconds. How
can someone steal your identity? According to the Federal Trade Commission (2003), by
co-opting your name, Social Security number, credit card number, or some other piece of your
personal information for their own use. The thief often uses the victim's personal information to
open accounts, purchase vehicles, apply for loans, credit cards, social benefits, establish
services with utility companies, rent apartments and more all in the victim's name without their
knowledge. In short, identity theft occurs when someone appropriates your personal
information without your knowledge to commit fraud or theft. According to the FTC, the
following are some ways that identity thieves work:

• They open a new credit card account, using your name, date of birth, and Social
Security number. When they use the credit card and don’t pay the bills, the
delinquent account is reported on your credit report. 

• They call your credit card issuer and, pretending to be you, change the mailing
address on your credit card account. Then, your imposter runs up charges on
your account. Because your bills are being sent to the new address, you may not
immediately realize there's a problem. 

• They establish cellular phone service in your name. 

http://tinyurl.com/5ttd6
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=SCC2
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=SCC2
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• They open a bank account in your name and write bad checks on that account. 
• They “phish” for your personal information and use it to gain access to your

accounts (e.g., see http://www.ftc.gov/bcp/conline/ecards/father/2005/) 

One of the most effective methods for minimizing your risk for identity theft is to order a
copy of your credit report from each of the three major credit reporting agencies every year.
Make sure it is accurate and includes only those activities you've authorized. The three major
credit reporting agencies are as follows:

Equifax — www.equifax.com 
To order your report, call: 1-800-685-1111 
or write: P.O. Box 740241, Atlanta, GA 30374-0241 
To report fraud, call: 1-800-525-6285 
and write: P.O. Box 740241, Atlanta, GA 30374-0241

Experian — www.experian.com 
To order your report, call: 1-888-EXPERIAN (397-3742) 
or write: P.O. Box 2104, Allen TX 75013 
To report fraud, call: 1-888-EXPERIAN (397-3742) 
and write: P.O. Box 9532, Allen TX 75013

TransUnion — www.transunion.com 
To order your report, call: 800-916-8800 
or write: P.O. Box 1000, Chester, PA 19022. 
To report fraud, call: 1-800-680-7289 
and write: Fraud Victim Assistance Division, P.O. Box 6790, Fullerton, CA 92834-6790

Note: Check out https://www.annualcreditreport.com/cra/index.jsp too see if you are eligible
for a free credit report. 

To reduce your risk, there are some measures you can take. Visit the FTC site that helps
you take charge. Also, If you believe you have been the victim of identity theft, you may use
the form available online at http://www.consumer.gov/idtheft to send a complaint to the
Federal Trade Commission. Finally, please read “How Not to Get Hooked by a ‘ Phishing’ Scam.”

____________________________________________

TIPS AND TRICKS

Microsoft Word™: Horizontal Lines
Word provides many attractive graphical horizontal lines from which you can choose. Follow
these steps to insert a horizontal line in your document:

http://www.ftc.gov/bcp/conline/ecards/father/2005/
http://www.equifax.com
http://www.experian.com
http://www.transunion.com
https://www.annualcreditreport.com/cra/index.jsp
http://www.ftc.gov/bcp/conline/pubs/credit/idtheft.htm
http://www.consumer.gov/idtheft
http://www.ftc.gov/bcp/conline/pubs/alerts/phishingalrt.htm
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1. Put your cursor in the document where you want to insert the horizontal line. 
2. Go to Format, then Borders And Shading. 
3. On the Borders tab, click the Horizontal Line button. 
4. Scroll through the options and select the desired line. 
5. Click OK. 

To insert a custom line, follow these steps:

1. Go to Format, then Borders And Shading. 
2. Click the Horizontal Line button. 
3. Click the Import button. 
4. Navigate to the file that contains the line you want to add and click the Add button to add
the line to the Horizontal Line Gallery. 
5. Click OK to add the line to the current document. 

Horizontal lines are no different than any other graphic image; they too can be copied, moved,
resized, and colored. To format the line, right-click it and select Format Horizontal line to
change the line's properties such as color, size, and alignment.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Get to the End: Just about any word processor or other Windows™ application.
For a quick trip to the end of the line, tap the key marked END. Tap it to jump the cursor to the
right edge in any editing situation. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Quick Cut and Paste: Any Windows™ Application
Keystrokes make cut + paste fast and easy. To cut and paste, select (highlight) your text first.
Then you can click buttons on the toolbar, or choose Copy, Cut, or Paste from the Edit menu --
but for speed and convenience, all it takes is a keystroke: 

- Ctrl+C to copy
- Ctrl+X to cut -- think of scissor blades
- Ctrl+V to paste -- think of the "V" as an arrow like an editor would use to indicate "insert
here". 

Remember, four simple steps: select the text, choose copy or cut, open or switch to another
program, then paste it there. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Microsoft™ Excel: Faster access to worksheets
When working with large workbooks in which all of the worksheet tabs are not visible, your
users may get frustrated with scrolling to find the sheet they need. Here's a really quick tip to
pass on. Right-click on any of the tab-scrolling buttons (look like arrows to the left of the sheet
tabs) and a shortcut menu will pop up. You can then select the tab you want.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft™ Excel: Quickly insert two popular functions
Alt][=]: Inserts the AutoSum function.
[Ctrl][;]: Inserts the current date.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™ 2002 Add-in: Template Wizard with Data Tracking
The Template Wizard with the Data Tracking add-in will help you create an Excel template that
will accept data from users in a familiar environment and then transfer the data to an Access
database after it's saved. The wizard will walk you through the steps of defining the tables
where the data should be inserted. Your colleagues can enter their data in Excel, and the data
structures set up by the Wizard will place that data into the Access database. The data will be
collected into one repository for easy reporting and analysis. Microsoft Knowledge Base article
214246 explains the process in detail.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Quick line spacing changes
Ctrl+1 = Apply single-space lines to the selected text
Ctrl+2 = Apply double-space lines to the selected text
Ctrl+5 = Apply 1.5-space lines to the selected text

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Insert a hyperlink
Ctrl+K = Insert a hyperlink within the selected text

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Archive of Mr. Excel Message Board
http://www.mrexcel.com/archive/index.html 

http://www.microsoft.com/downloads/details.aspx?FamilyID=E01EA3D8-094D-4ED1-88DA-F4B8B2AD28BD&displaylang=en
http://support.microsoft.com/kb/q214246/
http://support.microsoft.com/kb/q214246/
http://www.mrexcel.com/archive/index.html
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Grouper™
Grouper is a new Windows based application that allows users to share their personal media
within private groups (e.g., counselors in your school or district). Grouper uses P2P technology
connecting you directly to your friends’ or co-workers’ hard drives where you can share large
files in a safe, encrypted environment. Grouper is a simple install and requires no firewall
reconfiguration. Cost is FREE so get your group on! Note: Although the application lets you
freely swap most files, it disables this option for MP3s to keep potential lawsuits at bay. Read
the User Guide here. 
PC running Windows XP and 2000 (Windows 98 and ME are not supported). 
Microsoft .Net 1.1. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Supporting our Troops
Links to websites that for ways you can show your support to our troops in Iraq from Kim
Komando.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

10 Great Game Sites from Movies Kids Love
Your children find movie tie-ins almost everywhere. There are movie-related t-shirts, toys,
backpacks and even breakfast cereals. But do they know that they can find great movie-themed
games online? Children can play exciting games based on their favorite movies. Games are
more fun and interactive than all those T-shirts and cereals. Even better, they're free!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Web Sites for the PowerPoint User

Acadia University's PowerPoint Resource Center
http://aitt.acadiau.ca/resources/ppt/ 

PowerPoint FAQ: Comprehensive and searchable answers to frequently asked questions about
PowerPoint. http://www.rdpslides.com/pptfaq 

PowerPoint at Microsoft: This site has valuable tips, tricks, and free downloads. Downloads
include updates, new templates, and plug-ins such as the famous photo album wizard.
http://www.microsoft.com/office/powerpoint 

PowerPoint Answers: Provides articles, solutions, links and resources for beginning and
experienced PowerPoint users. http://www.powerpointanswers.com 

http://grouper.com
http://grouper.com/support/userguide.aspx
http://www.komando.com/supporttroops.asp
http://www.komando.com/tips_show.asp?showID=8867
http://aitt.acadiau.ca/resources/ppt/
http://www.rdpslides.com/pptfaq
http://www.microsoft.com/office/powerpoint
http://www.powerpointanswers.com
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PowerPoint in the Classroom by ACT360 Media Ltd: Fun and informative tutorials for various
programs including PowerPoint. http://www.actden.com 

PowerPoint Links compiled by Tracy Marks: Links in the following categories ...
Training/Lessons, Tips, sample downloadable presentations, books, enhancements and
templates, classroom uses, and Help.
http://www.geocities.com/~webwinds/classes/powerpt.htm 

Webaim article – “How to Create Accessible PowerPoint Slides on the Web:”
http://www.webaim.org/howto/powerpoint 

Netsquirrel.com
Since 1995, Patrick Crispen has been an invited speaker at numerous technology conferences
around the country.
http://netsquirrel.com/ 

MasterViews International
MasterView International is a free monthly newsletter focusing on designing and managing
effective PowerPoint presentations for international audiences.
http://www.masterviews.com/ 

Cyberbee
CyberBee is a “busy little bumblebee zooming around the Internet scouting out curriculum
treasures.”
http://www.cyberbee.com/how.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tech Teachers Urge More Computer Classes for Children
Even in a nation where most every school has Internet access and computer use often starts by
nursery school, teachers of technology see a warning message flashing. ... read more.
____________________________________________

JUST FOR FUN

Amazon.com Yellow Pages
Amazon.com is jumping into the online Yellow Pages business with a splash today, touting a
photo service that allows shoppers to stroll through cities without ever having to leave their
personal computers. The service, called Block View, is the brainchild of Amazon's search engine
subsidiary, A9.com, based in Palo Alto. Company employees have driven more than 20,000
miles in camera-equipped sport-utility vehicles in recent months, videotaping tens of thousands
of storefronts and converting the images into 20 million photographs. To date, the company
has collected images for 10 major metropolitan areas, including San Jose and other Bay Area

http://www.actden.com
http://www.geocities.com/~webwinds/classes/powerpt.htm
http://www.webaim.org/howto/powerpoint
http://netsquirrel.com/
http://www.masterviews.com/
http://www.cyberbee.com/how.html
http://www.usatoday.com/tech/news/2005-07-05-more--comp-classes_x.htm
http://www.amazon.com/gp/browse.html/102-9429264-4333727?node=3999141
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cities. But A9 officials said they hope to have coverage for the entire United States. short videos
about it are here (.wmv) and here (Quicktime). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

CopyKat Recipes
As you might have guessed, its recipes are similar to ones restaurants use. For example, you’ll
find recipes to make a cheesecake like the Cheesecake Factory’s. That’s sure to astonish any
guest! My kids and I made the equivalent of Aunt Annie’s pretzels the other night.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Girl probes 'PlayStation Thumb
A 13-year-old girl has become the youngest author to be published in South Africa's main
medical journal for her research on "PlayStation thumb". 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Napoleon Dynamite Soundboard
You won’t get it unless you have watched the movie (and liked it).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Top 100 e-book downloads from Project Gutenberg
http://www.gutenberg.org/browse/scores/top 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

UC Berkeley Summer Reading List 
Collection of thematic summer reading lists aimed at college students. Features themes such as
"Great Discoveries, Voyages, and Adventures," "Now That's Funny," and banned books.
Includes selected lists back to 1985. Books are chosen by faculty and staff of the University of
California, Berkeley. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Royalty Free Music (and much more).
http://incompetech.com/m/c/royalty-free/ 

____________________________________________

http://mms://wm.amazon.usa.speedera.net/wm.amazon.usa/upload/a9-yellow-pages-video-press-release-lg.wmv
http://static.a9.com/-/static/videos/yp/A9-yellow-pages-video-press-release-qt.mov
http://www.copykat.com/
http://news.bbc.co.uk/2/hi/technology/4122828.stm
http://www.collegehumor.com/news/2005-01-20.napoleon.php
http://www.gutenberg.org/browse/scores/top
http://www.lib.berkeley.edu/Instruction/readinglists/
http://incompetech.com/m/c/royalty-free/
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SchoolCounselor.com: #43 - July 13, 2005

Computers make it easier to do a lot of things, but
most of the things they make it easier to do don't
need to be done.  - Andy Rooney

____________________________________________

New from SchoolCounselor.com ... What are
School Counselors Doing w ith Technology?  The
results of a quick e-mail survey sent out to
readers of the SchoolCounselor.com
Newsletter are now available. Download a
document with over 50 responses replete with
creative and innovative uses of technology in
school counseling! http://tinyurl.com/dgfjd 
____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: I want to collect data from students,
parents, and teachers although I don't have
the resources to type it all in after I collect it?
Is there a better way?

Adapted from the new book, ”School Counseling Principles: Foundations and Basics” published
by the American School Counselor Association. 

A:  There are several great alternatives such as using online survey tools, handheld computers,
and using optical recognition software for scanning data into spreadsheets.

Online surveys in particular are a viable and relatively easy method for collecting data which is
already in the realm of capability of virtually all schools. Conducing surveys online comes with
many advantages. For one, data is stored and collated immediately after the respondent clicks
on the Submit button. With one or two clicks of the mouse, the counselor can perform analyses
or create graphs of the data at any time during collection, getting a snapshot of the results as
they come in. Second, the time for the entire process is significantly diminished, especially if the
same survey is periodically conducted over time. Third, an online survey can be conducted with
only a few people in one locale or the entire planet over the World Wide Web. Barriers of
space, place, and time become greatly lessened. Also, online surveys can include an array of
multimedia elements including sound, animation, and photos, thus making them more
interesting to the respondents and perhaps increasing response rates. Finally, copies of the
results of an online survey can be sent to more than one person or place which facilitates

http://www.schoolcounselor.com/posters.htm
http://www.schoolcounselor.com/counseling-tech-survey.htm
http://www.schoolcounselor.com/counseling-tech-survey.htm
http://www.schoolcounselor.com/counseling-tech-survey.htm
http://tinyurl.com/dgfjd
http://www.schoolcounselor.org/store_product.asp?prodid=191
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collaboration among the counselor and others such as interested researchers who can help with
the analysis.

Some counselors have discovered that they can create an online survey if they have
learned how to use the forms capabilities of a web authoring program such as Microsoft
FrontPage™ or Macromedia DreamWeaver™. These programs make creating surveys as easy
as word processing. Other counselors find that using online web survey services, some free and
some for a nominal fee, requires minimal skills and provide excellent results. Conducting an
Internet search using the key phrase "online survey" will demonstrate the popularity of this
method. Several companies have provided free online survey development capabilities, usually
limited in power and scope as compared to the purchased versions. However, even the free
versions have proven sufficient for counselors who want to survey a limited number of clients.
Many of these sites also provide the ability to conduct analyses online or download the data for
importing into your own software such as a spreadsheet. Such sites include
www.zoomerang.com, http://www.surveymonkey.com, http://www.quia.com,
http://www.freeonlinesurveys.com, and http://www.counselingsurveys.org/. 

Several possible disadvantages exist for conducting online surveys. Of course, if the
desired respondents do not have access to an Internet enabled computer, they cannot
participate. Because of limited access to computers and the internet, another disadvantage
might be that the sample of participants may not be truly representative of the population
under study. Providing access in a mental health agency or school for instance would minimize
this problem. Another possible threat to validity is the sometimes limited control over who
responds to an online survey. For instance, without proper controls, participants could respond
more than once or perhaps may more easily misrepresent their identity. Password protecting an
online survey could help although may not solve this problem with exact confidence. Some
online services may help with this problem by attempting to identify and track who responds to
a given survey. Finally, respondents may encounter technical problems either with their
computer, with access to the survey, or with a glitch in the survey itself which could hinder
appropriate data collection procedures. In general, however, most people would agree that
conducting surveys online provides powerful advantages which make this option quite
attractive.

Another practical and viable method for collecting data is to use "bubble sheets" or
scantrons. If paper and pencil surveys are desirable and appropriate, technology still makes
available another method for automated data entry. Instead of manually transferring data from
paper to computer, you can have a scanner "read" input from a special sheet of paper often
referred to as a bubble sheet or Scranton (this is technically called optical mark recognition or
OMR). These are the same sheets that you probably became accustomed to while in school as
many multiple choice exams are scored by using bubble sheets. Historically, using these bubble
sheets required a specific piece of hardware, known as an OMR scanner, or by the popular
trade name "Scantron".  For complete functionality, the scantron machine must be connected to

http://www.surveymonkey.com
http://www.quia.com
http://www.freeonlinesurveys.com
http://www.counselingsurveys.org
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a computer that contains software allowing the two machines to communicate, and allowing the
computer to analyze the data received. 

Different scanners will work with different types of bubble sheets. Some scanners can
read a great deal of data in a short amount of time because they simultaneously read both
sides of a given bubble sheet. Other scanning software programs such as Remark OMR
(http://www.principiaproducts.com/office/) can read filled-in bubbles, check boxes and even
bar codes. Of course, the obvious disadvantage of this method of data collection is that the
requisite hardware, software, and blank bubble sheets can be quite expensive. And, survey
respondents may make errors when transferring their answers from surveys or questionnaires
to the bubble sheets. 

However, the industry has recognized these limitations and has arisen to the occasion
by developing new software which allows the counselor to (a) design their own surveys on their
computers including questions and room for responses, and (b) scan the created surveys using
a simple and relatively inexpensive document scanner. For instance, the aforementioned
Remark OMR allows you to design your own forms using any word processor, print them on
your printer, scan and recognize data with your off-the-shelf image scanner and then analyze or
export the data to the application of your choice. Distinct advantages of these software
products are that they are cost efficient, make creating customizable surveys very easy, and
reduce the human error rate by placing survey items right next to the response bubbles. Check
with your school district to see if they can support you in collecting data using optical scanning.

TIP: Work with Your Local College or University

Counselor educators have several needs that lend themselves well to collaborating with
counselors for conducting all types of research concerning your work. First, conducting research
is an important part of many counselor educators' jobs. For many, it is a scholarly endeavor of
particular interest while for others it may be a less desirable condition of employment for which
they are duly evaluated. Second, counselor educators are interested in providing their
pre-service students with valuable and realistic learning experiences. Helping you with the
accountability and decision-making process can often become part of a supervised class
assignment in which students and instructor collaborate with you by providing guidance and
much needed help.

Supporting Websites

Create a graph online. http://nces.ed.gov/nceskids/graphing/ 

Handheld Survey Software: Software for personal digital assistants designed for conducting
surveys. http://www.handheld-systems.net/ 

http://www.principiaproducts.com/office/
http://nces.ed.gov/nceskids/graphing/
http://www.handheld-systems.net/
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OmniPage Pro 14 Office: Quickly turn PDF files and stacks of paper - letters, contracts, tables,
manuals - into easily editable word processing and spreadsheet documents.
http://www.scansoft.com/omnipage/ 

Pocket PC Survey & Handheld Survey System: Software for personal digital assistants designed
for conducting surveys. http://www.pocket-surveys.com/ 

Ultimate Survey Software Enterprise, powered by Microsoft .NET, is a centralized application for
all of your organizations web-based forms and surveys. The days of creating single use forms
and surveys with the assistance of your IT team are over -- Ultimate Survey allows anyone in
your organization to create amazing forms and surveys using only a web browser. The easiest
to use do-it-yourself survey software available today.
http://www.prezzatech.com/UltimateSurvey-surveysoftware.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: What are the differences among the various e-mail formats?

Adapted from Tyler, J.M., & Sabella, R.A. (2004). Using technology to improve counseling
practice: A primer for the 21st Century. Alexandria, VA: American Counseling Association. 

A: In the old days, one could only send e-mail in the form of basic text (ASCII) which is still
desirable for several reasons. First, plain text or ASCII messages are fastest to download. When
the message does not require fancy formatting or other objects such as photos or sound, this is
still the best way to go. Second, there may be recipients whom are using older e-mail clients
which can only handle plain text, anything else comes in as gibberish. Third, plain text e-mail is
easiest to save, store, and copy and paste into other applications. If, however, you would like
to change fonts, color, add tables, or bulleted lists for instance, your best bet is to send the
message in Rich Text Format or RTF. Recipients that process their e-mail using clients that can
handle RTF, and most of them now do, will be able to view the e-mail very close to or even
identical to the format in which you sent it. E-mail sent in RTF format may also include symbols
such as "©" and photos. 

Messages that look and act the same as web pages can now also be sent and received because
modern e-mail clients act very much like web browsers. Such messages are created in the same
way that one creates a web page - usually with a web authoring program or e-mail client that
can generate HTML (Hypertext Markup Language) code. The advantage of HTML messages is
that they offer everything RTF formatted messages do and more including sophisticated
computer scripts, forms, animated graphics, and anything else that might also be included on a
web site. Most e-mail clients include HTML stationary which a counselor can choose to enhance
the message in his/her communication. Stationary can include graphics, animation, and sound
(e.g., see http://www.thundercloud.net). Using HTML based e-mail does have several
disadvantages though which includes that they can (a) take a great deal of time to download;

http://www.scansoft.com/omnipage/
http://www.pocket-surveys.com/
http://www.prezzatech.com/UltimateSurvey-surveysoftware.asp
http://www.counseling.org/Source/Orders/index.cfm?ETask=1&Task=1&SEARCH_TYPE=FIND&FindIn=0&FindSpec=72810
http://www.counseling.org/Source/Orders/index.cfm?ETask=1&Task=1&SEARCH_TYPE=FIND&FindIn=0&FindSpec=72810
http://www.thundercloud.net
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(b) more easily carry malicious code which can infiltrate your computer; and (c) also deposit
cookies on your computer to track the nature of your e-mail activity (see
http://www.cookiecentral.com/faq for frequently asked questions and answers about cookies).
If you accept e-mail messages that are in the HTML format, you can limit the potential of
succumbing to malicious code by viewing it in the preview pane without actually opening it.

____________________________________________

TIPS AND TRICKS

Microsoft Excel™: Moving From One Sheet to Another
– To move one worksheet to the right Press CTRL+PAGE DOWN. 
– To move one worksheet to the left Press CTRL+PAGE UP. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Password Protect Documents

In Microsoft Word™ 2002, you can require other users to type a password to open or modify a
document, or both.

1. With the document open and visible, click on the Tools menu, then Options. 
2  Click the Security tab. 
3. Do one of the following: To require a password to open the document, in the Password to
open box, type a password, and then click OK. In the Reenter password to open box, type the
password again, and then click OK. OR ... To require a password to make changes to the
document, in the Password to modify box, type a password, and then click OK. In the Reenter
password to modify box, type the password again, and then click OK. 
4. To test the password, close and reopen the document. 

Be careful: First, be sure to remember your password lest you will not be able to open it
yourself. Second, advanced users (i.e., many children) can still open it by cracking your
passcode (e.g., see http://www.passwordservice.com/word or
http://www.intertek.org.uk/downloads/) so don’t use this as your only security measure for
very sensitive documents.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Using 3D lighting effects in FrontPage or PowerPoint 2002
from http://tinyurl.com/7opjy 
  

http://www.cookiecentral.com/faq
http://www.passwordservice.com/word
http://www.intertek.org.uk/downloads
http://tinyurl.com/7opjy
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Microsoft FrontPage® and PowerPoint™2002 both provide drawing tools including AutoShapes
and Word Art to create great effects for your web site. You can use 3-D effects including 3-D
lighting to add even more interest to your pages. To find out how to create AutoShapes and
Word Art, see Help.

To add or change a 3-D lighting effect, open an existing page in FrontPage 2002 and do the
following:

1.  In Page view, select the AutoShape or Word Art you want to change. 
2.  On the Drawing toolbar, click the 3-D icon. 
3.  To add a 3-D effect, click the option you want. 
4.  Next, to change the 3-D lighting effect, display the 3-D Settings toolbar by clicking the 3-D
icon again and selecting 3-D Settings…. 
5.  Click the blue lighting icon on the 3-D Settings toolbar, select the light source, and click on
the brightness option you want. 
6.  Note  To add the same 3-D lighting effect to several objects at one time, select or group the
objects before you add the effect. This will create a more realistic effect.
7.  Save the page.   

Note: Don’t forget that once you create a 3-D Word Art or AutoShape, you can copy and paste
that into almost any other application!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Frontpage™: Resizing FrontPage Images Doesn't Reduce Their File Size
From http://www.essex.ac.uk/wag/guides/frontpage/tips-n-tricks.htm 

Many novice FrontPage users assume that resizing an image, by dragging one of its size
handles (little boxes that appear when the image is selected), reduces the image's file size
(usually seen as a number of KB in the "size" column of FrontPage's "Folders view"). In reality,
however, resizing a large image to display as a smaller one on a web page, has no effect on its
file size, or the time it will take to load. 

Large image files can seriously delay the time it takes a page to load. Therefore you should
take time to resample your images after re-sizing them. Once you've resized an image by
dragging one of its size handles, you need to resample it by clicking the "Resample" button on
the "Pictures" toolbar (the icon has four arrows pointing at a little picture). Doing so not only
reduces the file size but generally improves the image's appearance - getting rid of unwanted
blurring or blockiness.

When you come to save your web page, FrontPage will prompt you about "Saving Embedded
Files". It is asking how it should save a copy of your modified image. Simply click "rename" and

http://www.essex.ac.uk/wag/guides/frontpage/tips-n-tricks.htm
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give the image a new, suitable filename (to prevent it overwriting your original image), and
press OK

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Bookmarking your Document 
Adapted From: Word 2002 For Dummies
You might find yourself working on several parts of a document at once. Or perhaps you're
reading what you wrote and need to remember a specific spot to come back to. Whatever the
reason, often it's necessary to, well, put a bookmark in your document. When you mark your
place in a book, you can dog-ear it by folding down a corner of the page — but that's tough to
do on a PC without bending the corner of your monitor (which wouldn't work anyway). Visit this
page to see how it’s done.
http://tinyurl.com/d2hdv 

____________________________________________
 

WORTHY WEBSITES AND SOFTWARE

IHMC CmapTools version 3.8 
The CmapTools program empowers users to construct, navigate, share and criticize knowledge
models represented as concept maps. It allows users to, among many other features, construct
their Cmaps in their personal computer, share them on servers (CmapServers) anywhere on the
Internet, link their Cmaps to other Cmaps on servers, automatically create web pages of their
concept maps on servers, edit their maps synchronously (at the same time) with other users on
the Internet, and search the web for information relevant to a concept map. The CmapTools
client is free for use by anybody, whether its use is commercial or non-commercial. In
particular, schools and universities are encouraged to download it and install it in as many
computers as desired, and students and teachers may make copies of it and install it at home.
(Commercial companies that install their own CmapServer do need to get a separate license for
a CmapTools client that will talk to the commercial version of the CmapServer).
http://cmap.ihmc.us/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Technorati 
Technorati is a real-time search engine that keeps track of what is going on in the
blogosphere--the world of weblogs." Drop a keyword or URL into the search box, browse
popular topics, or create free custom notifications and RSS feeds to track items of interest
(registration required for these features). Includes a linked list of the top ten search terms for
the day.
http://www.technorati.com 

http://tinyurl.com/d2hdv
http://cmap.ihmc.us/
http://www.technorati.com
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Make Charts More Compelling by Adding Pictures
Do you want to impress your audience with more colorful presentations and draw attention to
important data in your charts?
http://tinyurl.com/dhm8g 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

NCRTEC Lesson Planner
This Web site is intended to help teachers write focused lesson plans. The Planner addresses
essential questions that are often overlooked when planning curriculum units. Teachers bring
their own content and are guided through each section by answering specific questions. The
result is a comprehensive lesson plan aligned with standards that addresses assessment,
content, teaching strategies and use of technology. 
http://www.spasd.k12.wi.us/id125.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google.com: Currency Conversions
Yet another tool provided by this famous search engine. To use the built-in currency converter,
simply enter the conversion you'd like done into the Google search box and hit "Enter" or click
the Google Search button.
http://www.google.com/ 

Here are some sample example queries:

3.5 USD in GBP 
currency of Brazil in Malaysian money 
5 British pounds in South Korean money 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

eBay offers mail service to curb phishing    
Chris Hunter     
Thursday, 06 January 2005  

In an effort to help its customers avoid becoming the victims of phishing, eBay is
offering a mail service called 'My Messages.' The inbox associated with My Messages will be
accessible via the My eBay service and will only have messages from eBay, so users will be able
to know that the messages are definitely from eBay and can be trusted. This is not the first
endeavor eBay has undertaken to help consumers protect themselves from phishing attempts.
It also provided users with a toolbar to help detect phishing attempts. The Anti-Phishing
Working Group's secretary general, Peter Cassidy, isn't surprised by eBay's move, considering

http://office.microsoft.com/en-us/assistance/HA010548061033.aspx
http://tinyurl.com/dhm8g
http://www.spasd.k12.wi.us/id125.htm
http://www.google.com/
http://www.spamfo.co.uk/component/option,com_content/task,view/id,228/Itemid,2/
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that it and its PayPal subsidiary are perhaps the most frequent phishing targets. He also feels
that the My Messages service may be a harbinger of things to come, with privatized e-mail
services possibly showing up in other industries (including the much-phished financial industry)
over the next few years.

____________________________________________

JUST FOR FUN

Pack-Square
Make your own marquee message to someone!
http://pack-square.business-php.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Newseum
The world's first interactive museum of news — the Newseum — opened in Arlington, Va., in
1997. Its mission was simple: to help the public and the news media understand one another
better.
http://www.newseum.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Just Say No Image Directory
Go to the left navigation button to see all the categories.
http://www.seoconsultants.com/just-say-no/01.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

101 Ways to Cope with Stress
http://tinyurl.com/528jl 
Courtesy of the Tripler Regional Medical Center, Honolulu, Hawaii

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Earth – Explore, Search and Discover 
Want to know more about a specific location? Dive right in -- Google Earth combines satellite
imagery, maps and the power of Google Search to put the world's geographic information at
your fingertips. Google Earth puts a planet's worth of imagery and other geographic information
right on your desktop. View exotic locales like Maui and Paris as well as points of interest such
as local restaurants, hospitals, schools, and more.
http://earth.google.com/ 

http://pack-square.business-php.com/
http://www.newseum.org/
http://www.seoconsultants.com/just-say-no/01.asp
http://tinyurl.com/528jl
http://earth.google.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Adopt a Military Working Dog
The Department of Defense is now making
Military Working Dogs that are no longer capable
of performing their military duties available for
adoption. If you are interested in adopting one of
the dogs please call Status Control at
1-800-531-1066.
http://dodmwd.lackland.af.mil/adoption_index.ht
m 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Fun Sites for Kids (and those who love being a kid)

Nick
http://www.nick.com 
This site contains dozens of games including Jimmy Neutron's Spaceblast 3D game. You can
also participate in multi-player games with other kids from around the world, create a funky
face and play games related to Nick shows like All That and CatDog.

Nick Jr.
http://www.nickjr.com 
Playing a game with Blue from Blue's Clues and Little Bill sound like fun? You can choose from
several games featuring Nick Jr. characters. Read along with stories featuring Dora the Explorer
or sing with Oswald.

Puzzle Maker
http://www.puzzlemaker.com 
Create and print your very own word puzzles including word searches and crossword puzzles.

Story Place
http://www.storyplace.org 
Visit this site to read stories for kids of all ages. Read the stories online and see them come
alive onscreen. Also includes interactive games and printable crafts and activity sheets.

Webtime Stories
http://www.kn.pacbell.com/wired/webtime/ 
A collection of web sites featuring myths and folktales, classic children's books and books for
young adults. There is also an area for games and crafts, as well as an HTML tutorial.

http://dodmwd.lackland.af.mil/adoption_index.htm
http://dodmwd.lackland.af.mil/adoption_index.htm
http://dodmwd.lackland.af.mil/adoption_index.htm
http://www.nick.com
http://www.nickjr.com
http://www.puzzlemaker.com
http://www.storyplace.org
http://www.kn.pacbell.com/wired/webtime/
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Yak's Corner
http://www.yakscorner.com 
Visit this site created by the Detroit Free Press and learn about animals, see what's making
news, read about interesting people, get new recipes, and more.

http://www.yakscorner.com
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SchoolCounselor.com: #44 - August 2, 2005

"Pencil and paper / n./ : an archaic
information storage and transmission device that
works by depositing smears of graphite on
bleached wood pulp. More recent developments
in paper-based technology include improved
`write-once' update devices which use tiny
rolling heads similar to mouse balls to deposit
colored pigment. All these devices require an
operator skilled at so-called 'handwriting'
technique."

Cardinal rule of computing. – To go forward, you
must backup.

_______________________________________

FREQUENTLY ASKED QUESTIONS

Q: Sonya, a SchoolCounselor.com Newsletter
reader from Georgia writes, “I need to insert a
picture that is saved as a PDF.  How can I insert
it into a Word document? Do I first need to convert it into another format?”

A: Great question. First, if you have not already, you should download and install the latest
version of the Adobe Acrobat Reader (7.0) which I find to be a great improvement over the
previous version. Getting back to your question ... no, you do not necessarily need to convert
the document into another format (Note that Microsoft Word™ is not capable of importing a
PDF file). How to copy images from a PDF file isn't very clear or apparent from the menus and
toolbar. The steps below will show you how to do it (adapted from this website). Once copied,
images can be pasted into other documents (e.g., word processor or presentation programs) or
saved to your hard drive. 

1.   Open a PDF file and go to the area you want to copy.
2.   Zoom in on the area to be copied until it's the desired size. 
3.   In Acrobat Reader version 4: Click and hold down on the Text Select Tool button. A
toolbar flyout will appear with three additional buttons. Choose the Graphic Select Tool from
the flyout (third button).
4.   In Acrobat Reader version 5: Click the Graphics Select Tool on the toolbar or use the
keyboard shortcut G.
5.   In the document area, drag a selection marquee around area you wish to copy.

http://www.adobe.com/products/acrobat/readstep2.html
http://graphicssoft.about.com/cs/general/ht/copyfrompdf.htm
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6.   Right click and choose copy, or go to Edit -> Copy, or press Ctrl-C on your keyboard.
(Command-C on Macintosh).
7.   The selected area is placed onto the clipboard as a bitmap.
8.   Paste the image into another document, or paste it to an image editor and save it to your
hard drive.

In Adobe Acrobat Reader 6.0 and higher, it gets even easier than that:

1. Open the PDF file in Adobe Reader. 
2. Click the Tools menu, select to display the Basic submenu, and then click Select Image. 
3. Locate the graphic that you want to copy. Right-click the graphic, and then click Copy Image
to Clipboard. 
4. Switch to your other program (e.g., MS Word), click the location where you want to paste
the image, and then click Paste on the Edit menu. 

Here are a few websites that will help extend the answer to your question:

– How to copy text and graphics from Adobe Portable Document Format (PDF) files.

– Third-party products that assist in converting PDF files to Word documents. For additional
information, visit the following third-party Web sites: 

– http://www.verypdf.com/pdf2word 
– http://www.clicktoconvert.com/index.html 
– http://www.scansoft.com/pdfconverter 

– Creating PDF documents

– Pdf995 makes it easy and affordable to create professional-quality documents in the
popular PDF file format.
– I have note used this one although it gets good reviews online and it’s free –
CutePDF.
– Here is a free online PDF converter.
– This feature is included in the free (open source) productivity suite, OpenOffice. 

____________________________________________

TIPS AND TRICKS

Microsoft PowerPoint™: Inserting a Hyperlink 
Watch this video that teaches you how to make your presentations more effective by linking to
text, objects, charts, or other things. Note: If you have trouble viewing the video in Quicktime
format, you may need to download the free Apple Quicktime Player to view this content.

http://support.microsoft.com/kb/q212318/
http://www.verypdf.com/pdf2word
http://www.clicktoconvert.com/index.html
http://www.scansoft.com/pdfconverter
http://www.pdf995.com/
http://www.cutepdf.com/Products/CutePDF/writer.asp
http://www.gohtm.com/
http://www.openoffice.org/
http://i.cmpnet.com/techlearning/quickflicks/movies/pp032_057_hyperlinkx.mov
http://www.apple.com/quicktime
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

The ABCs of RSS By Will Richardson 
Just what is RSS and how can it be used in education? Depending on who you talk to, RSS
stands for Rich Site Summary or Real Simple Syndication. Either way, RSS is an important
technology that information specialists and educators would be wise to harness.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Assigning a Macro to a Keyboard Combination
A quick way to run a macro is to associate a shortcut key combination with the macro, and then
use that shortcut to invoke the macro. Assigning shortcuts to macros is easy to do; just follow
the steps in this tip. (This tip works with Microsoft Word™ 97, Word 2000, Word 2002, and
Word 2003.) 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Alternate Row Shading Using Conditional Formatting 
One way to make your data legible is to apply cell shading to every other row in a range.
Excel's Conditional Formatting feature makes this a simple task.

1. Select the range that you want to format 
2. Choose Format, Conditional Formatting 
3. In the Conditional Formatting dialog box, select Formula Is from the drop-down list, and
enter this formula: 

=MOD(ROW(),2)=0

4. Click the Format button, select the Patterns tab, and specify a color for the shaded rows. 
5. Click OK twice to return to your worksheet. 

What’s nice about this technique is that the row shading is dynamic. You'll find that the row
shading persists even if you insert or delete rows within the original range.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft FrontPage: Learn How to Develop Your Own Website
FrontPage 2000 is the simple tool you need to make a Web site for your classroom, your
school, your teacher’s group – or just about anything else under the moon! This page makes it
fun. Also visit http://www.actden.com/fp.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.techlearning.com/story/showArticle.jhtml?articleID=163100414
http://wordtips.vitalnews.com/Pages/T1679_Assigning_a_Macro_to_a_Keyboard_Combination.html
http://techrepublic.com.com/5100-10877_11-5794878.html?tag=nl.e056
http://www.actden.com/fp2000/java/
http://www.actden.com/fp
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Microsoft FrontPage: Insert a Top 10 List Linking to Your Most Popular Pages
Using Microsoft FrontPage® version 2002, you can quickly insert Top 10 Lists that link to the
Top 10 most frequented pages on your site. Create lists by number of visited pages, referring
domains, referring URLs, search strings, visiting users, and more. These lists are automatically
refreshed when the user comes to the page. Use the Top 10 List on Internet or intranet sites.
Click on this page to learn how. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: J-Walk Enhanced Data Form
The J-Walk Enhanced Data Form is an Excel add-in (free) that provides a general-purpose data
entry dialog box. It's a significantly enhanced alternative to Excel's built-in Data Form -- the
dialog box that appears when you select Form from the Data menu.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™:Find/Replace in Multiple Worksheets
Sometimes its necessary to search for text in all worksheets of a particular workbook, however
Excel defaults to searching only the current worksheet. So, how do you get around that? If you
right click on the name of the worksheet (the tabs at the bottom of each workbook - the default
names are "Sheet 1", "Sheet 2", etc) a menu will pop up. Click on "Select Al Sheets". Now,
when you select "Find" or "Replace" from the Edit menu in Excel, all worksheets in your
workbook will be searched. This tip should work with all versions of Excel from Excel 2000
onwards. In Excel 97, this tip will only work for "Replace", not for "Find" or "Find Next".

____________________________________________

WORTHY WEBSITES AND SOFTWARE

TechLearning 
Online magazines, articles, grants database, and much more!
http://www.techlearning.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Phishing scheme really stinks
Just when you thought you’d taken all necessary precautions, the bad guys are one step ahead.
Did you know that phishers can hijack your browser, even if you type the correct URL in the
address bar? 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.microsoftfrontpage.com/content/TipsAndTricks/FP2002/10_InsertTopTenList.htm
http://j-walk.com/ss/dataform/index.htm
http://spreadsheets.about.com/cs/excelbasic/qt/exqtctrlfall.htm
http://www.techlearning.com/
http://www.komando.com/tips_show.asp?showID=8561
http://joe-ks.com/MultiMedia/BeansFart.mp3
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Educational Psychology part of the Social Science Information Gateway
Located within the Institute for Learning and Research Technology at the University of Bristol,
the Social Science Information Gateway (SOSIG) is an online database of high quality Internet
resources that primarily deal with the vast array of social science fields and subfields. Visitors
can perform a simple search, or browse through the subject headings offered on the
homepage. Each one of these discrete sites has been catalogued and annotated, making it
easier to find specific resources quickly. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

'ICE' Cell Phone Plan Would Help Rescuers
“Idea to Designate Next of Kin in Electronic Address Book Is Gaining Popularity.”

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Identity Theft Resource Center (ITRC)
The ITRC is a nonprofit, nationally respected program dedicated exclusively to identity theft. It
provides consumer and victim support and advises governmental agencies, legislators and
companies about this evolving and growing crime. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Express Notes Card File Software for Windows
Express Notes lets you store and organize notes on your computer. Typically this software is
used as a phone or address book, diary or card file but it can be used for just about anything.
Some examples include todo lists, recipes, customer records and more. It is as easy to use and
as flexible as a paper cardfile but by using your PC you can search, order and organize notes
faster.  Express Notes is free and can be downloaded and installed in just minutes.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Ta-da Free online To-Do list tool
The free version is limited to 10 active lists (lists where all the items are checked off are not
counted against your total). Lists themselves can have an unlimited number of items.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Creating Photo Slide Shows
Free programs produce slick summer vacation slide shows.
http://tinyurl.com/csarl

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://sosig.esrc.bris.ac.uk/roads/subject-listing/World-cat/edupsych.html
http://www.washingtonpost.com/wp-dyn/content/article/2005/07/17/AR2005071700879.html
http://www.idtheftcenter.org/index.shtml
http://www.nch.com.au/notes/index.html
http://www.tadalist.com/
http://tinyurl.com/csarl
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Jon's Excel and Charting Pages
http://peltiertech.com/Excel/Charts/ 

____________________________________________

JUST FOR FUN

Guitar Tuner
http://www.gieson.com/Library/projects/utilities/tuner/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Join the Harry Potter Craze
First, order the new book here. Then do some Potter activities here. Finally, find a Harry Potter
Book Party by clicking here. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

July is Baked Bean Month! (Adolescent Humor; MP3)
http://joe-ks.com/MultiMedia/BeansFart.mp3

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Very Cool Wallpaper from Ingleby
To download one of the back grounds just click on the preview and then right click on the
pictures and select "Save Picture As..." If you just want one as a wallpaper right click on the
picture and select "Set As Background."

~~~~~~~~~~~~~~~~~~~~~~~~~~~

3D Text Maker
Make free 3D text right online.
____________________________________________

http://peltiertech.com/Excel/Charts/
http://www.gieson.com/Library/projects/utilities/tuner/
http://www.amazon.com/exec/obidos/ASIN/0439784549/schoolcounselorc/102-4647650-7717760?creative=327641&camp=14573&link_code=as1
http://www.activityvillage.co.uk/harry_potter.htm
http://www.potterparties.com/
http://joe-ks.com/MultiMedia/BeansFart.mp3
http://www.ingleby.com/wallpaper1.htm
http://www.3dtextmaker.com/
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SchoolCounselor.com: #45 - August 10, 2005

If you tried to read every document on the web,
then for each day's effort you would be a year
further behind in your goal.  - Anonymous 

There might be new technology, but
technological progress itself was nothing new -
and over the years it had not destroyed jobs,
but created them.  - Margaret Thatcher 

_______________________________________
_____

FREQUENTLY ASKED QUESTIONS

Q: How do I play a video file using an external player (e.g., Windows Media Player) from a
PowerPoint presentation?   
   
A: Here you go ...

1.  Select Hyperlink from the Insert option in the main menu. 
2.  Select the "Browse for File" to browse and select the video file that you wish your
presentation slide to launch and play and click OK.
3.  The movie will launch using the default media player for the movie type that you have
chosen to insert / link to. For example, Windows Media Player, or Apple's Quicktime Player. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: In my Microsoft Excel™ spreadsheet, how can I color cells to make them stand out?

A: Cell shading can make your worksheets look more professional. They can also draw attention
to specific parts of your worksheet. Here’s how you do it:

1. Highlight the cells that you would like to apply the cell shading to. (Click and drag the mouse
to highlight cells.) If you would like to apply cell shading to only one cell, then just click that
cell. 

2. Right-click the cell or cells that you highlighted, and select "Format Cells..." from the menu
that appears. 

3. Click the "Patterns" tab. 

http://www.schoolcounselor.com
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4. From the list of colors, click the color you would like to use as the cell color background
(shading). 

Note: You can also click the "Pattern" drop-down menu to select a pattern instead of a single
color. 

5. Click OK. 

Tip: You can also apply other kinds of formatting from this screen. Just browse through the
other tabs (e.g., borders). 
 ____________________________________________

TIPS AND TRICKS

Microsoft Word™: Automatic Bullets
You can create a bulleted list by typing a single character. Start your list with an asterisk (*)
followed by a space and the first line of text. Press Enter at the end of the line and Word turns
it into a bulleted entry. (The Automatic Bulleted Lists item must be checked on the "AutoFormat
as you type" tab in the AutoCorrect dialog box.) In addition to the asterisk, try the greater than
symbol (>) or the dash (-). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Clean out Windows XP's Prefetch folder to speed up boot times
by  Greg Shultz - Published: 7/20/05 from Tech Republic
Windows XP's Prefetch folder stores information about each program you launch; then, on
subsequent restarts, XP uses the information in the folder to preload parts of those programs at
boot time. Find out why you need to clean out the Prefetch folder periodically to keep boot
times from dragging. One of Microsoft's big selling points for Windows XP was that it loads
applications much faster than its predecessors. To accomplish this feat, Windows XP uses what
is called the "Prefetch technique," in which the operating system gathers information about
each program that you launch and stores that information in the \Windows\Prefetch folder.
Then on subsequent restarts, Windows XP uses the information in the Prefetch folder to
essentially preload parts of those programs at boot time. Thus, when you launch your
application, it appears to load really fast.

However, the Prefetch folder can accumulate too much information over time. This makes the
operating system so busy loading bits and pieces of lots of applications into memory that it
ends up slowing down the boot process. Fortunately, you can clean out the Prefetch folder at
any time. Follow these four steps:

Access the Run dialog box by pressing [Windows]R. 
Type Prefetch in the Open text box and click OK. 

http://techrepublic.com.com/5100-10877_11-5796430.html?tag=nl.e101
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Press [Ctrl]A to select all the files. 
Press [Delete]. 
As you use your system, Windows XP will rebuild the contents of the Prefetch folder.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Remove a button from the toolbar
Delete buttons you don't use from your Word toolbars by holding the Alt key and dragging the
button off the toolbar. To move a button, press Alt and drag it to a new location on the toolbar. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Adobe PDF Conversion by Simple Form
To convert an Adobe® Portable Document Format (PDF) file to HTML or text, simply type a
URL for an Adobe PDF document into this electronic form and select "Convert". The Adobe PDF
document will be converted and returned to you in your browser application. Depending on the
complexity of the document and the number of requests being made on the server at the time,
the conversion process may take a while.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Icing on the Cake: Online Tools for Classroom Use by Kathy Schrock
http://kathyschrock.net/cooking/ 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

The Interactive Counseling Center (ICC) is a point-to-point video conferencing system
that has been in use for the past four years.  The ICC system is installed in schools servicing
military bases.  The ICC consists of a dedicated CPU, monitor, video camera, and an all-in-one
fax-scanner-copy machine.  Sites use this technology to assist students and parents in the
transition process as students move from school to school as a result of their parents being
PCS’ed.  There are 140 ICC systems now in use across the country and overseas to assist in
transitioning students.  If there are students NOT associated with the military planning a move
between schools with the ICC system they would be welcome to take advantage of the
technology also.  So, how are the ICC systems used?  Read on!

Imagine having access to a new student’s records before they arrive at your school.  To be able
to see the transcript AND the student even when they are on the other side of the country! 
This is the advantage of the ICC system.  Assisting students, and parents, with this technology
eases fears and the process of transitions.  I have been able to help new students transfer to
my school and send others to a new school using the ICC.  Counselors can see student records,

http://www.adobe.com/products/acrobat/access_onlinetools.html
http://kathyschrock.net/cooking/
http://www.interactivecounselingcenter.org/index.html
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talk to AND SEE students and their parents directly, and visit with the sending school counselor
even before the student moves.  The ICC systems allow counselors to scan documents such as
transcripts into the system and “show” the progress of the student and in real time discuss
what classes are most appropriate for the student at the receiving school.  The system allows
questions to be answered immediately.  Programs of study at the sending and receiving school
can be compared for better articulation between school transfers.  Students and parents are
able to put a “face” on the new school and have a familiar person to seek out when they get to
the new place.  Having used phone and e-mail in the past for this purpose does not have the
same “feel” to it as being able to see the new school and at least one person there. 
http://www.interactivecounselingcenter.org/index.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Best Buy's te@ch program provides grants to schools using interactive technology to make
learning fun for students. In the past two years, more than 2,000 schools have received nearly
$6 million to help them expand or enhance technology-rich programs. Beginning this year, the
program has been expanded to include three grant levels: up to 1,200 schools or teachers will
receive Best Buy te@ch gift cards, valued at $2,500, up to 36 schools will receive additional
te@ch awards, valued at $15,000 each, and in February 2006, public-school districts with
$15,000 te@ch award winners will have the opportunity to apply for a National te@ch School
District award, valued at $250,000. For more information, visit
http://communications.bestbuy.com/communityrelations/teach.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Support Free Mammograms
Click every day to give hope to women in need. It's free!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

SpoofStick is a simple (and free) browser extension that helps users detect spoofed (fake)
websites. A spoofed website is typically made to look like a well known, branded site (such as
citibank.com) with a slightly different or confusing URL. The attacker then tries to trick people
into going to the spoofed site by sending out fake e-mail messages or posting links in public
places - hoping that some percentage of users won't notice the incorrect URL and give away
important information. This practice is sometimes known as “phishing". NOTE: SpoofStick for
Internet Explorer currently requires Windows 2000 or Windows XP to run.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Inside Yahoo! Education
An amazing array of educational references, tools, and sample tests, and more.
http://education.yahoo.com/

http://www.interactivecounselingcenter.org/index.html
http://communications.bestbuy.com/communityrelations/teach.asp
http://www.thebreastcancersite.com/cgi-bin/WebObjects/CTDSites
http://www.corestreet.com/spoofstick/
http://education.yahoo.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

ASAP Utilities contains over 300 free useful and powerful utilities to fill the gaps in Excel, and
automate frequently used tasks. Guaranteed to save you many hours of time !
http://www.asap-utilities.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

DYMO's amazing Address Fixer automatically checks any US address against the USPS master
database while you're connected to the internet. Mistakes are automatically corrected, the
ZIP+4 is added, and formatting is adjusted to Post Office standards. This speeds mail delivery
and eliminates returned mail.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Disinfect Your PC
Is your antivirus software on the fritz? Don't despair, just stop by Panda Software's site for a
free system scan. You'll have to download an applet, surrender your e-mail address, and use
Internet Explorer (the scanner requires ActiveX). Panda detects and disinfects most forms of
malware, and will alert you to (but won't fix) spyware infestations.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Website Development using FrontPage
So you want to create a Web site. That's great — a Web site can be a powerful and efficient
way to communicate with others. This course will teach you how to create a Web site using
FrontPage 2003. It will also teach you things you should know before creating one.

Also ...

Microsoft Word™: Mail Merge
Learn how to use mail merge in Microsoft Office Word to produce envelopes and labels for
mass mailings. Then explore how to go beyond the basics to create personalized form letters or
e-mail messages, numbered coupons, and more.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Professional Webinar: Marketing Your Counseling Program with PowerPoint
with Russell A. Sabella, Ph.D. 
Multimedia presentations are not just for presenting anymore. Lean how to use PowerPoint as a
communication and collaboration tool that applies to all parts of the ASCA National Model©.
Learn how you can use this popular tool to showcase your work and resulting data. You can tell
(and show) others in the next room or around the planet about your successes. Add pizzaz to

http://www.asap-utilities.com/
http://global.dymo.com/enUS/CampaignsHome/Address_Fixer.html
http://www.pandasoftware.com/products/activescan/com/activescan_principal.htm
http://office.microsoft.com/training/training.aspx?AssetID=RC011140711033
http://office.microsoft.com/training/training.aspx?AssetID=RC011205671033
http://www.bridges.com/us/training/professionalwebinars/tanm/powerpoint.html
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your newsletters and classroom guidance units. Instead of asking kids to tell you about what's
going on, teach them to show you using photos, music, video, links, and their own voice.
Become a more effective and efficient counselor while having more fun! 

____________________________________________

JUST FOR FUN

Printable Maps from the National Geographic Society
Best part is that the maps are optimized for printing. 
http://www.nationalgeographic.com/xpeditions/atlas/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Lastminute Auction pulls out listings from eBay that are about to expire in an hour or less,
and are priced at a dollar or less.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Ping Pong anyone?
http://gsn.k12.oh.us/zanetrace/web_games/pingpong.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Itunes
You may want to download this and start playing with it because it’s more than just a way to
purchase and listen to music, it’s now supports podcast subscriptions. You will read more about
podcasting in this newsletter in the next few months as I predict it will be an amazing tool that 
school counselors will use to communicate and deliver comprehensive school counseling
programs. I’m listening to a podcast as I’m writing this paragraph which is produced by a 3rd

grade class from Michigan. Before that, heard a brief podcast from a 14 year old teen talking
tech tips. Yesterday, a podcast from Newsweek. Podcasting means that anyone with a
computer, internet connection, and free software can have their own “radio show” that
thousands or millions of others can tune into. 
http://www.apple.com/itunes/ 

More about podcasting:

 -  http://www.ipodder.org 
 -  http://www.podcastingnews.com/ 
 -  http://www.podcastalley.com/ 

   - http://audio.weblogs.com/ 

http://www.nationalgeographic.com/xpeditions/atlas/
http://www.lastminute-auction.com/
http://gsn.k12.oh.us/zanetrace/web_games/pingpong.swf
http://www.apple.com/itunes/
http://www.ipodder.org
http://www.podcastingnews.com/
http://www.podcastalley.com/
http://audio.weblogs.com/
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Check out online photos of other school counselors
http://tinyurl.com/aky7c 

http://tinyurl.com/aky7c
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